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Forest Pack is a plugin for Autodesk 3ds max, and 3ds max design, designed to give a complete solution for 
creation of vast surfaces of trees and plants.

Forest enables you to scatter millions of proxies, high-poly meshes or billboards, and using custom geometry 
shaders, create scenes with virtually unlimited number of objects and polygons.

Download Forest Pack Lite, the free version of the plugin and use it in your personal and commercial projects. 
If you are new to Forest, see the Getting Started guide for videos, tutorials and more help in your first steps using 
the software.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=TvdWWcJGd18

http://www.itoosoft.com/downloads.php
https://www.youtube.com/watch?v=TvdWWcJGd18
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•
•

1 Getting Started

If you are new to Forest Pack and you're worried about where to start, you've come to the right place! Here is a very 
simple guide for getting started with the plugin.

To be current of new versions and latest news about our products, please subscribe to forums. You can also follow 
us on Twitter.

1.1 Installation
How you install Forest Pack depends on the type of license you own. Click on the following links depending on if 
you purchases a Standalone or a Networked (floating) license

Help me install a Standalone License.
Help me install a Network License.

1.2 Forum Access
As a registered user of Forest Pack Pro, you also have access to the private forums on our website (http://
www.itoosoft.com/forum).

To gain access to the Pro forums, you have to create a forum account in the User Panel> Forum Accounts section or 
register a previously created account in this section. Please note that forum accounts can have different login and 
password from your main User Panel account.

http://www.itoosoft.com/forums.php
http://www.twitter.com/itoosoft
http://www.twitter.com/itoosoft
http://www.itoosoft.com/forum
http://www.itoosoft.com/forum
https://secure.itoosoft.com/userpanel/forum_profile
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1.3 
Latest Release

Check out the latest features of Forest Pack 7 in out "What's New?" page.

You can also check all the most recent changes for your current version in the release notes.

1.4 Tutorials and Reference
For a fast introduction to the capabilities of the plugin, you can watch the Basic tutorial. It shows how to use 3D 
high-poly trees in an architectural environment. It can be completed with Forest Lite. Next, we suggest you 
continue with the Modern Barn tutorial. Completing it, you will learn to use most of the software options, from 
areas splines area to advanced materials. It uses the VRay renderer but all the principles will apply to any other 
engine and includes five parts with 90 minutes of video. Finally Autumn Parks will get you quickly acquainted with 
Forest Colour. You'll find many more tips and and tricks videos in our tutorials section. They're regularly updated so 
check regularly!

1.5 The3dGarden plant models
If you have purchased some The3dGarden libraries, the following tutorial will help you to integrate the models in 
the library browser. 

https://www.itoosoft.com/blog/forest-pack-7-see-the-light
http://www.itoosoft.com/forestpack/reference/release_notes.php
http://www.itoosoft.com/forestpack/tutorials/tutorial_basic.php
http://www.itoosoft.com/forestpack/tutorials/tutorial_modernbarn.php
http://www.itoosoft.com/tutorials?software=fp
http://www.itoosoft.com/hqplants.php
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1.6 Lite & Pro
If you are using Forest Pack Lite, remember that it can be used freely for your personal or commercial projects. 
Click here if you want to see the differences with Forest Pack Pro, and the benefits of upgrading to it.

To complete your learning of the plugin, see the full list of tutorials, visit the Gallery or read the Help Reference. You 
can also ask to our technical staff, and share your experience with other users in the forum.

Thank you and enjoy using Forest Pack !

http://www.itoosoft.com/forestpack/tutorials.php
http://www.itoosoft.com/forestpack/gallery.php
http://www.itoosoft.com/forum
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2 Requirements

2.1 Supported versions of 3ds Max and 3ds Max Design
Our plugins support the following 3ds Max 64 bit versions. 

2012 2013 2014 2015 2016 2017 2018 2
0
1
9

2
0
2
0

2
0
2
1

3ds Max 

3ds Max Design

 = 3ds Max Design not available.

2.2 Supported Renderers
Forest Pack supports native instancing in the renderers and versions listed below

Arnold 5.1 and above is supported from 3ds Max 2018 onwards. Please make sure the MaxToA plugin is up 
to date. You can download the most recent version from the Solid Angle website.
Mental Ray is supported in version 2012 - 2017 only.
V-Ray and V-Ray RT supported versions 3.6 or greater for V-Ray 3, V-Ray Next and V-Ray GPU update 1.1 or 
above and V-Ray 5.
Thea Render 1.3 and onwards
Corona Renderer 1 and onwards
Maxwell 3.x and onwards
Octane 1.x and onwards
Arion
Redshift  2.x and onwards
FStorm
Final Render

Mental Ray compatibility in Max 2017 and 2018

From 3ds Max 2017 Mental Ray was an optional installation. Forest Pack for Max 2017 still has many 
dependencies on the Mental Ray libraries and is required by our plug-ins to operate correctly. Please make 
sure that Mental Ray is installed for 3DS Max 2017, even if you don't intend to use it to avoid errors. 

From 3ds Max 2018 Mental Ray is no longer included, and for technical reasons we have had to temporarily 
suspend support.



http://solidangle.com/arnold/download/#3dsmax
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2.3 Feature Compatibility
Due to technical limitations, feature support varies between renderers. The table below illustrates the compatibility 
of RailClone's key features with each render engine.

Sta
nda
rd

V-
Ra
y

V-Ray 
RT

V-Ray 
GPU

Ar
no
ld

Me
ntal 
Ray

Co
ro
na

The
a

Oct
ane

Ma
xw
ell

Fin
al 
Re
nd
er

A
ri
o
n

Reds
hift

FS
tor
m

Native instancing

Create instances 
using Forest  
Tools

Billboard Library compatibility

The 2D Billboard library is only supported by Scanline, Mental Ray and V-Ray.


Built in Library support

Not all libraries have materials available for all the renderers. To see which renderers have partial library 
support, please check the compatibility matrix shown below. To see which renderers are supported by 
each library item, please see the online library browser.



Billboard Library compatibility

To use Forest Color and Forest Edge maps with Arnold, you will need to turn on Legacy 3ds Max Map 
support in Render Settings->System.



Fully compatible features are marked with a  and highlighted in green.

V-Ray GPU

Forest Colour is partially supported by V-Ray GPU. Get colour from map using Random Values or As 
Texture on Surface is not currently supported.



Unsupported features are marked with a   and highlighted in red.

https://www.itoosoft.com/library/forestpack
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Forest Colour
  *

* *
*

*

Forest Material

Edge mode

Material 
Optimiser

Points-cloud 
display

Parametric areas

Distribute using 
maps

Automatic 
clustering

Frustum culling 
and falloff

Randomise and 
control 
transforms

Manual edit mode

Scatter animated 
geometry

Randomise and 
control animated 
geometry

Forest Effects



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Requirements –  22

•
•
•

•
•
•
•

Library Browser

Presets with 
compatible 
materials

PA
RTI
AL

PA
RTI
AL

PA
RTI
AL

PA
RTI
AL

2D Billboards 
Library

* = Similar effects may be possible using the renderers own shaders.

For renderers not mentioned in the above list it is still possible to use Forest Pack using Forest Tools to convert 
scattered objects to standard Max instances.

2.4 License Manager
For network licenses, you will need to install the license manager on a networked PC. The license manager has the 
following OS requirements:

Microsoft® Windows:

Windows 10 (32-bit and 64-bit)
Windows 8/8.1 (32-bit and 64-bit)
Windows 7 (32-bit and 64-bit)

Microsoft Windows Server:

Windows Server 2016 (64-bit)
Windows Server 2012 (64-bit)
Windows Server 2012 R2 (64-bit)
2020

Billboard Library compatibility

The 2D Billboard library is only supported by Scanline, Mental Ray and V-Ray.


https://docs.itoosoft.com/pages/viewpage.action?pageId=10092669
https://docs.itoosoft.com/pages/viewpage.action?pageId=10092669


Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Installation and customisation –  23

3 Installation and customisation
This guide describes the directory structure of Forest Pack and how to customize it. We will use a default Forest Pro 
installation, in Forest Lite some files may be different.

3.1 Directory Structure
We define <forestdir> as the folder where you installed Forest Pack (C:\Program Files\Itoo Software\Forest Pack 
Pro by default) , <maxdir> is your main 3DS directory, and <librarydir> as the location of librarys (C:
\Users\username\AppData\Local\Itoo Software\Forest Pack Pro\ by default). 

<forestdir> Contains the following files in the root directory:

File Description

Forest Pack Pro.  Shortcut to the Forest Pack web page

forest_reference.html Shortcut to the online reference manual

install.log Installation log file

licenseMode.exe License mode setup wizard

licpanel.exe License manager

uninst.exe Uninstaller for Forest Pack

The setup program  also creates the folder structure shown below in <forestdir> :

Folder Path

Distribution Maps <forestdir>\distmaps

Image Formats <forestdir>\imageformats

Billboard Geometry <forestdir>\geometry

The setup program  creates libraries using the folder structure shown below in <librarydir> :

Folder Path

Forest Effects Files (.eff) <librarydir>\effects

Library <librarydir>\lib

Library Maps <librarydir>\maps

Material Libraries <librarydir>\matlib
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The plugins and shaders for VRay and Mental Ray are copied to the 3ds Max directories as follows (Note only one of 
Lite or Pro plugins should be installed for each Max version):

Folder Path

3DS plugin Lite <maxdir>\plugins\ForestPackLite.dlo

3DS plugin Pro <maxdir>\plugins\ForestPackPro.dlo

3DS Legacy plugin (optional install) <maxdir>\plugins\ForestPackPro2.dlo

Maxscripts <maxdir>\scripts\ForestPack\forest_utils.ms
<maxdir>\scripts\ForestPack\optmat.mse
<maxdir>\scripts\startup\forestpack.ms

Toolbar Icons Max 2010- 2012:

<maxdir>\ui\Icons\fptoolbar16a.bmp
<maxdir>\ui\Icons\fptoolbar16i.bmp
<maxdir>\ui\Icons\fptoolbar24a.bmp
<maxdir>\ui\Icons\fptoolbar24i.bmp

Max 2013 - 2017:

<maxdir>\ui_In\Icons\fptoolbar16a.bmp
<maxdir>\ui_In\Icons\fptoolbar16i.bmp
<maxdir>\ui_In\Icons\fptoolbar24a.bmp
<maxdir>\ui_In\Icons\fptoolbar24i.bmp

<maxdir>\ui_In\Iconsdark\fptoolbar16a.bmp
<maxdir>\ui_In\Iconsdark\fptoolbar16i.bmp
<maxdir>\ui_In\Iconsdark\fptoolbar24a.bmp
<maxdir>\ui_In\Iconsdark\fptoolbar24i.bmp

User Interface Files <maxdir>\ForestQT.dll
<maxdir>\QtCore_Itoo_4.dll
<maxdir>\QtGui_Itoo_4.dll
<maxdir>\QtXml_Itoo_4.dll
<maxdir>\QtSolutions_MFCMigrationFramework-Itoo.dll

VRay shaders Several <maxdir>\ForestVRay###.dll, usually one for each V-
Ray major release.
Note: some files may not exist depending of the Max and 
VRay versions
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Folder Path

MR shader library Max 2010 and before: 
<maxdir>\mentalray\shaders_autoload\shaders\FShader3.
dll
Max 2011 and 2012: 
<maxdir>\mentalimages\shaders_autoload\mentalray\sha
ders\FShader3.dll
Max 2013 and newer: 
<maxdir>\NVIDIA\shaders_autoload\mentalray\shaders\FS
hader3.dll

MR shader descriptor Max 2010 and before: 
<maxdir>\mentalray\shaders_autoload\include\FShader3.
mi
Max 2011 and 2012: 
<maxdir>\mentalimages\shaders_autoload\mentalray\incl
ude\FShader3.mi
Max 2013 and newer: 
<maxdir>\NVIDIA\shaders_autoload\mentalray\include\FSh
ader3.mi

The following entries are created in the Windows Registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Forest Pack Pro

MainDir = C:\Program Files (x86)\Itoo Software\Forest 
Pack Pro

<forestdir> is defined here

UseLicServer = 0 0 to use Stand-alone license, 1 for Network license

LicservHost = <host or ip> License server hostname, undefined for automatic 
search

LicservPort = 16720 Protocol port number, by default 16720

TexturePaths (key) Texture paths

LibraryDir (key) Library paths

In Forest Pack 6.1 and above you can disable the iToo Toolbars (both Forest and RailClone) by adding the 
following registry key:

If the plug-in doesn't find the keys in HKEY_LOCAL_MACHINE, it searches the same values on 
HKEY_CURRENT_USER.





Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Installation and customisation –  26

•
•
•

•
•
•
•
•

HKEY_CURRENT_USER\SOFTWARE\Itoo Software\

DisableToolbars = 1 (DWORD) 1 to disable the toolbars, 0 to enable them

All commercial Itoo Software products use also additional keys for the licensing management:

HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Licenses

LicenseDir = C:\ProgramData\Itoo Software\Licenses Forest Pro license is stored here

HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Licenses\Products

Forest Pack = 9 One entry for each Itoo Software product

3.2 Unattended Installation
From Forest Pack 3.9.2 and above, the setup program supports unattended installations using the following 
parameters:

/? - See available parameters
/S - enable silent installation
/MAXVER=[max9-32, max9-64, max2008-32, max2008-64, max2009-32, max2009-64, max2010-32, 
max2010-64, max2011-32, max2011-64, max2012-32, max2012-64, max2013-32, max2013-64, max2014-64, 
max2015-64]
/MAXDIR=<3dmax installation path>
/LICMODE=[rendernode, network, stand-alone]
/LICHOST=[License server host]
/LICPORT=<License server TCP port>
/SHAREDFOLDER=<network path for shared files>

Example of a silent installation for Max 2013

ForestPackPro.exe /S /MAXVER=max2013-64

3.3 Network Rendering

3.4 You can install Forest on your renderfarm computers using the setup 
program, or copying the files manually. In Forest Pro select "Render 
slave node", in Forest Lite use default installing option.

For a manual installation, these are the required files:

 In a Windows 64 bit version, these registry keys are duplicated in HKEY_LOCAL_MACHINE\SOFTWARE\Wow6
432Node


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Type Files

Plugin and shaders As described in the plugin and shaders table

Distribution Maps from "C:\Program Files (x86)\Itoo Software\Forest Pack 
Pro\distmaps\images", copy them to any shared texture folder

Tree textures all textures from "C:\Program Files (x86)\Itoo Software\Forest Pack 
Pro\maps" and your custom textures, when used

If you use Presets or other elements of the Library, they must be visible by the render nodes. Use the Asset Tracker 
to locate the texture maps and XRefs used by the scene.

From version 4.0.2, Forest configures automatically in the render nodes the paths listed in the registry at HKEY_LOC
AL_MACHINE\SOFTWARE\Itoo Software\Forest Pack Pro\TexturePaths. These are the paths included by default 
by the installer:

c:\program files (x86)\itoo software\forest pack pro\\distmaps\images

c:\program files (x86)\itoo software\forest pack pro\maps\HShadows

c:\program files (x86)\itoo software\forest pack pro\maps\Standard

c:\program files (x86)\itoo software\forest pack pro\maps\Classic

c:\program files (x86)\itoo software\forest pack pro\maps\presets

c:\program files (x86)\itoo software\forest pack pro\lib\free models\hqplants free\maps

All these files can be installed on network paths if you configure Max to use them (as shared plugins, Mental Ray 
shaders and textures). For details, see: Autodesk 3ds Max Help -> Customizing the User Interface - > Configure Paths.

3.5 Is it possible to modify the sub-objects of a Forest object from 
MaxScript?

Yes, but only if the Forest object is in "Custom Edit" mode. there is an interface named "trees" for using it provided 
by MaxScript. You can see all the functions included witd "showinterfaces($forest01)". these are the some of them:#

Add a tree in position p (local coordinates), using width, height and geometry ID values

<Forestobject>.trees.create p:<point3> width:<float> height:<float> geomid: <integer>

$forest01.trees.create p:[50,50,0] width:10 heigth:10 geomid:1

Delete the tree at position n in the array

<Forestobject>.trees.delete n:<integer>

$forest01.trees.delete n:0

Modify the properties of the the tree at position n (width, height, geometry ID, random seed)

http://www.itoosoft.com/forestpack/reference/install.php#files
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<Forestobject>.trees.edit n:<integer> width:<float> height:<float> geomid:<integer> seed:<integer>

$forest01.trees.edit n:0 width:10 height:10 geomid:1 seed:123456

Returns the number of trees of the object

<Forestobject>.trees.count()<integer>

$forest01.trees.count()

Move the n-th tree to the position p

<Forestobject>.trees.move n:<integer> p:<point3>

$forest01.trees.move n:0 p:[50,50,0]

Set the rotation of the n-th tree (angle in degrees)

<Forestobject>.trees.rotate n:<integer> angle:<float>

$forest01.trees.rotate n:0 angle:45

3.6 Configuring the plugin using environment variables
From Forest Pack 6 onwards it is now possible to configure the main attributes of the plugin using environment 
variables instead of registry keys. To do this each registry key used in the configuration can be replaced by a 
variable, replacing non alphanumeric characters with underscores (_). For example: for 
"HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Forest Pack Pro\MainDir", you would define the variable 
"ITOO_SOFTWARE_FOREST_PACK_PRO_MAINDIR"

The minimum variables to run Forest Pack are the following:

For Network licenses:

ITOO_SOFTWARE_FOREST_PACK_PRO_MAINDIR=C:\Program Files\Itoo Software\Forest Pack Pro
ITOO_SOFTWARE_LICENSES_LICENSEDIR=C:\ProgramData\Itoo Software\Licenses
ITOO_SOFTWARE_FOREST_PACK_PRO_USELICSERVER=1
ITOO_SOFTWARE_FOREST_PACK_PRO_LICSERVHOST=192.168.1.20
ITOO_SOFTWARE_FOREST_PACK_PRO_LICSERVPORT=16720

For Stand-alone licenses:

ITOO_SOFTWARE_FOREST_PACK_PRO_MAINDIR=C:\Program Files\Itoo Software\Forest Pack Pro
ITOO_SOFTWARE_LICENSES_LICENSEDIR=C:\ProgramData\Itoo Software\Licenses
ITOO_SOFTWARE_FOREST_PACK_PRO_USELICSERVER=0

For Libraries

ITOO_SOFTWARE_FOREST_PACK_PRO_LIBRARYDIR=C:\Users\<user name>\AppData\Local\Itoo 
Software\Forest Pack Pro\lib

For Effects
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• ITOO_SOFTWARE_FOREST_PACK_PRO_EFFECTSDIR=C:\Users\<user name>\AppData\Local\Itoo 
Software\Forest Pack Pro\effects
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If you define variables in a .BAT file, be sure to not include any space either side of the '=' symbol, or 
it will not work (this is a known Windows issue).
Environment variables are used only by the Max plugin. Other tools as the License Manager still 
require configuration registry keys at the moment.
If both registry keys and environment variables are defined, the variables have precedence over 
keys (priority order is Variables->HKLM->HKCU).


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4 Update Manager

4.1 Overview

iToo Software Update Manager is an all in one solution that allows you to download, manage and install macros 
and libraries for Forest Pack and RailClone. This has several advantages: You only need to download the packages 
that you need, so there's no need to waste storage space and bandwidth on assets that you won't use; A 
significantly smaller payload for the core application making updating the software faster and easier; The ability to 
release new material at any time without the need to wait for a new release of the software, including beta material 
and new libraries and macros as soon as they become available.
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Update manager runs when you first install our plugins, when you'll be prompted to download the current 
packages. Every time a new interactive Max session is started Update Manager will check for new content to make 
sure you are completely up to date, although you can change this behaviour to check manually if you prefer.

4.2 Procedures

4.2.1 To launch Update Manager
To launch update manager, either:

Select Update Manager from the Windows Start Menu.

or:

Open 3ds Max.
Select an existing Forest Pack or RailClone object, or create a new one.

From the Modify Panel, open the General rollout and click the Check for Updates button 

Update Manager does not run automatically if Forest Pack or RailClone is being installed using silent mode 
or if Max is launched in non-interactive mode (for example on a render farm). To install packages using 
Silent mode, please see the procedures described below.


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Any packages that are available to download will be listed. If no new or updated packages are available 
Update Manager will display "Congratulations. All packages are up to date."

4.2.2 To download packages
You have the option to download all or only a selection of the available packages. To do this:

Open Update Manager.
By default all new or updated packages are automatically selected. If you wish to change the selection, use 
the checkboxes to the left of each package's name.
Click Install. The selected packages will be downloaded and added to the Forest Pack or RailClone library.

4.2.3 To show installed packages
By default Update Manager only shows packages that are available to be installed. To show packages that are 
already installed:

Open Update Manager.
Go to the View menu and select Installed Packages.
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2.
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1.
2.

4.2.4 To delete installed packages
If you cannot see installed packages, Go to the View menu and select Installed Packages.

Click on the  icon for the package you'd like to remove.
From the Details Dialog, click Uninstall.

4.2.5 To download packages to a shared network location 
It is possible to install content from a shared network location. This can be useful to prevent each computer having 
to download potentially large files separately. It works by contacting the iToo Servers for a list of available 
packages, it then checks to see if they are already available in a shared directory and if they are found, installs them 
from there. If they are not available in the shared directory, they are downloaded and made available to all other 
computers on the network. 

To do this is a 2 step process: First, download the assets to a networked location from any PC. Then configure the 
other PCs on the network to look in this location. To do this:

Step 1: Download packages

Go to the Settings menu and select Preferences.
Go to the Local Network Installation tab.



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Update Manager –  34

3.

4.
5.

1.
2.
3.
4.

5.

1.
2.

•

Specify a network location for the installation packages by clicking on the Select Folder button.

Click OK.
The installation files for any libraries downloaded from now one will be saved to this location

Step 2: Installing shared packages

Open Update Manager on the offline machine
Go to the Settings menu and select Preferences.
Go to the Local Network Installation  tab.
Specify the same network location for the offline installation packages by clicking on the Select 
Folder button.
Files will be installed from this location. 

4.2.6 To use unattended installation
For render farms and large organizations where it is more efficient to update content silently, there are 2 options.

Either:

Use Update Manager on your source PC to download the content you wish to distribute to the other nodes.
Copy library content content manually (or using a batch file) from C:\Users\<user>\AppData\Local\Itoo 
Software\RailClone Pro or C:\Users\<user>\AppData\Local\Itoo Software\Forest Pack Pro to the same 
location on your employee's machines or render nodes

Or:

If the PCs have an Internet connection, you can run Update Manager silently using the command line, for 
example using UpdateManager.exe -product rcp install ALL. This will download and install all the packages. 
For other parameters that allow you to specify different products, packages and more, please see the 
reference at the bottom of this page.
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4.3 nterface

4.3.1 Package List
Displays packages that are available for download, including their names, version and size. Use the checkboxes to 
select packages to install. 
Optionally can also be used to display packages that are already installed on the system by selecting the Installed 
Packages option from the View menu..

4.3.2 Information Button 
Opens a dialog to display more information about a package, including the name, description, file size and release 
date. For packages that are already installed an option to Delete the package is also available
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4.3.3 Install Button
Click to install selected packages

4.3.4 Settings
Options to logout of the Update Manager, open the preferences and close the application

4.3.5 View
Options to refresh the packages list and toggle on and off whether installed packages should also be displayed

4.3.6 Help
Options to open the iToo Software website and open the About dialog to see the installed versions of Update 
Manager, RailClone and Forest Pack.

4.3.7 Preferences

General > Temporary Folder
Allows the user to change the location in which downloaded packages are temporarily saved before they are 
installed.

General > Behavior
When RailClone or Forest Pack is first used in an interactive session, Update Manager will check to see if there are 
any new or updated packages and notify the user.  Turn this option off If you would prefer to check for updates 
manually,

General > Channel
Allows you to choose to download only packages that are stable, or participate in beta testing new or experimental 
content.
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Network > Proxy
If your computer is using a proxy, you can configure the settings here. Includes parameters for Address, Port, and 
optional parameters for Username and Password if they are required.

Offline Installation
This options enables you to download packages to a network location. Forest Pack will search this location for 
selected packages before downloading them from our servers. In that way you avoid downloading the same 
content multiple times in the same office. 

Select Folder is used to choose a save location. 

4.3.8 Command Line Installation
In addition to a user-friendly GUI, Update Manager also features a command line interface for unattended 
installations. Please see below for supported parameters.

Command Function

PRODUCT CODES

rcp RailClone Pro

rcl RailClone Lite

fpp Forest Pack Pro
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Command Function

fpl Forest Pack Lite

MODIFIERS

-product CODE Specify a specific product

-username USERNAME Specify the iToo software username 

-password PASSWORD Specify the iToo software password

-shared-folder PATH Path to shared network folder

-proxy-address ADDRESS Specify the proxy address 

-proxy-port PORT Specify the proxy port

-proxy-password PASSWORD Specify the proxy password

-proxy-username USERNAME Specify the proxy username 

COMMANDS

H or help Shows help information

C or check Check if there are updates available.

L or list updated | installed | all List packages using filters

I or Install package-name | all Install specified package

U or uninstall package-name | all Uninstall specified package

For example:
UpdateManager.exe -username USERNAME -password PASSWORD check  checks if there are updates 
available
UpdateManager.exe -username USERNAME -password PASSWORD -product rcp check checks if there 
are updates for RailClone Pro content
UpdateManager.exe -username USERNAME -password PASSWORD -product rcp install all upgrades 
RailClone Pro packages in silent mode
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5 Lite and Pro
Currently two versions are available: Forest Pack Lite and Forest Pack Pro. Forest Pack Lite is free for any project, 
personal or commercial. However, some features are disabled and only available in Forest Pack Pro.

5.1 Forest Pack Lite
This version is free for personal and commercial use for an unlimited period of time. It is fully functional with 
some limitations listed below. You can get it from the Download page.

5.2 Forest Pack Pro
Forest Pack Pro has advanced features for surfaces, tree placement and importing/exporting tools. Also it includes 
a full library of planar trees and shrubs that you can edit it and add your own trees and textures. Visit our Online 
Store for more information about prices and license options.

5.2.1 Feature list

Rendering Lite Pro

Native shaders for Mental Ray

Native shaders for VRay

Billboards optimization

Random tint by item

Tint by element (as leaves on a tree)  

Scattering Lite Pro

Unlimited types of plants by object  

Up to three types of plants by object  

Unlimited areas by object  

Up to four areas by object  

Scattering over uneven surfaces  

Diversity / Clusters

Custom Edit mode, to edit items individually

Distribution of items along a path

Real-time camera clipping

https://www.itoosoft.com/getfplite
http://www.itoosoft.com/store.php
http://www.itoosoft.com/store.php
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Points-cloud viewport mode

Random transformation of position, rotation and scale

Full Animation support, including multiple random samples

Collision checking

Effects Lite Pro

Effects Browser and built in effects

Load and edit  3rd party effects  

Create, save and share new effects  

Libraries Lite Pro

Library browser

Library editor  

More than 100 library items, including billboards, 3D models and 
Presets

 

Utilities Lite Pro

Real time status window

User presets  

Creation tools  

Forest tools  

Conversion to editable Mesh

Other Benefits Lite Pro

Prioritized technical support  

Early access to beta versions  

Frequently patches and releases  
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6 Forest Plugin
Create
General
Add Geometry
Forest LOD
Areas
Distribution

Image Mode
Path mode
Reference mode
Particle Flow mode

Effects
Effects Interface
Effects Library
Saving and Importing Effects Files
Creating and Editing Effects

Effects Syntax
Operators
Functions
Attributes
Parameters

Effects Examples
Stepped Rotation
Lean out
Tint by Object
Tint by Boundary
Look At object with Falloff
Look at Boundary with Falloff
Repulsion
Bend by Object
XY Local Translate
Cars along spline
Place items on a displaced surface

Surface
Item Editor
Camera
Shadows
Transform
Material
Animation
Display

6.1 Create
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6.1.1 Overview
To create a new Forest Object you have three options. You can either start by clicking on an area such as a surface 
or a spline, place individual objects by using Item Editor mode, or create an empty Forest Object so that you can 
configure all the settings later.

6.1.2 Procedures

To pick a model or preset from the library
Go to the Create tab in the Command Panel and choose iToo Software from the dropdown list. 
Click on the Forest Pack button.
Click Library > Select to open the library browser

Pick a preset and click Import Selected.

To create a Forest Object using a Spline or Surface
Go to the Create tab in the Command Panel and choose iToo Software from the dropdown list. 
Click on the Forest Pack button.
Check Mode > Generate.
Click on a surface or spline in the scene to pick it as the first area. 
Switch to the Modify tab for any subsequent edits. 

To create a Forest Object that scatters the selected items
Select the objects you wish to scatter.
Go to the Create tab in the Command Panel and choose iToo Software from the dropdown list. 
Click on the Forest Pack button.
Check Mode > Generate or Icon Mode
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Enable Source Objects > Populate from Selection.

Click on a surface or spline in the scene to pick it as the first area or create an icon depending on the creation 
mode. 
Switch to the Modify tab for any subsequent edits. 

To place individual objects
Go to the Create tab in the Command Panel and choose iToo Software from the dropdown list. 
Click on the Forest Pack button.
Check Mode > Icon Mode
heck Mode > Icon Mode
Click and drag in the scene to create a Forest Pack icon
Switch to the Modify tab and add objects to the GeometryList. 
Go to the Items Editor rollout and enable Custom Edit mode
Click on the Tree icon to enter the Tree sub object level
Select Add and the click in the scent to add objects 

To create a Forest object with no item placement
Go to the Create tab in the Command Panel and choose iToo Software from the dropdown list. 
Click on the Forest Pack button.
Check Mode > Icon Mode
Click and drag in the scene to create a Forest Pack icon
Switch to the Modify tab for subsequent editing.
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To select all the items in the scene used by a Forest object

Select a Forest object
Right-click and choose Select all Forest Dependencies from the quad menu. 

6.1.3 Interface

Library
From the Create panel you have the option to load models or a preset from the library. Just click on the Select 
button to open the Library Browser. 

There are also options to select individual custom objects, surfaces, and areas
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Default Size
Use the Width and Height parameters to set the default size of new 2D template objects. 

Mode
Generate

Enables you to create a new Forest Pack object by picking a Spline or a Surface from the scene. This will be 
automatically added to the Areas or Geometry list. Subsequent edits should be done from the Modify panel.

Custom Edit

Enables you to place individual objects by clicking in the scene. This mode automatically create a new Forest Object 
in Item Editor mode. Subsequent edits should be done from the Modify panel.

Icon Mode

Enables you to create an empty Forest Pack object click-dragging an icon in the scene. The resultant Forest Pack 
has no areas assigned (but may contain geometry if you used the Library option). Subsequent edits should be done 
from the Modify panel.

6.2 General

6.2.1 Overview
The General rollout contains plugin-wide settings including tools to create parameter-only presets (for presets that 
include geometry and other external objects, see the Forest Library section) . In the event that a render 
reports "Some forest were not built correctly in the last render" this rollout also contains useful information that 
can help you to determine the cause. 
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6.2.2 Procedures

To resize lists
Click and drag on the bar below any list to resize it. 
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To collapse groups

Click on the   button to toggle open/collapsed any groups in the Forest Pack interface.
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To check for a newer version of Forest Pack:

Click the  (Search for updates) button.

To check for a new and updated libraries

Click the   (Search for updates) button.
Update manager will open. Please see the documentation for more information.

To open the help files:

Click the   (Show Forest Pack Help) button.

To create variations of the current Forest object:
Change the Random Seed number. 

To save the current settings as a preset:
Set the Forest object's parameters.
Type a name for the Preset in the Presets List box.

Click   (Save current settings as a preset)

To save the current settings as default:
Set the Forest object's parameters.
Type default in the Presets List box.

Click   (Save current settings as a preset). Every new Forest object will now inherit these settings.

To save a preset to an external file:
Set the Forest object's parameters.

Click   (Export preset to external file).
Type a name for the new preset file and click Save

To load a preset from an external file:

Click   (Import preset from external file).
Select a .fpe file and click Open.

To add the preset to the drop down list for easy access at a later date, click   (Save current settings as a 
preset).

To disable Pop Ups 
Click on Global Settings.
Check  Disable Pop-ups. Only Critical messages will now be shown.
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To show or hide a rollup

Click on Global Settings.
Check next to the rollouts you wish to display. Uncheck next to rollouts you wish to hide.
In this way you can streamline the Forest Pack interface to suit your workflow.

6.2.3 Interface

Presets list 
The presets field alows you to select from a list of saved presets or enter a new name and store the current settings 
as a new preset. Clicking a name from the list overwrites the current numeric parameters and options with those 
saved in the preset. References to all external objects, for example in the geometry list, surface list, and cameras 
rollout, remain unaffected. References to materials are saved, but they must be in the scene or the current material 
library.

Save current settings as a preset

Delete preset from list

Import preset from external file

Export preset to external file

If a preset is created with the name "default", its values will be used automatically for all new Forest objects. 

You can copy the presets to any other computer that has Forest installed by copying the file named 
"forest_presets.ini", located in the user's folder: %LOCALAPPDATA%\Autodesk\3dsMax\[max version]\ENU\en-
US\plugcfg. 
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Icon Size
Defines the size of the Forest icon. This will display when the plugin cannot create objects because not all the 
required parameters have yet been defined, or because of an error condition, 

Random Seed
A numeric value used to initialize the random number generator. This number affects any randomised properties of 
the Forest Pack plugin. For a given seed value, the Forest object will always produce the same results.

CPU Threads
Defines the number of threads used by Forest to build the scattered geometry. The default value (Auto) 
automatically detects the number of CPU cores. Usually is not recommended that you modify this parameter.

Disable Pop Ups 
When enabled all suggestions and warning messages are turned off except for critical errors (this option is global 
and persistent).

 Search for Updates
Checks the installed version of Forest Pack is up to date. If an update is available a dialog box will open with version 
information and an option to Go to the Update Site. 

 Show Forest Pack Help
Opens Forest Pack's online help files in the user's default web browser.

 Launch Forest Lister

Opens Forest Pack Lister.

For most uses this feature has been superseded by loading and saving presets via the Forest Library, 
however it remains useful as a quick way of copying settings between Forest objects and setting defaults 
values.



The "XRef Unit's mistmach" popup (shown when loading items from the library) can be disabled by setting 
disableXRefPopups=1 in forestpack.ini, or from General->Configuration->Disable Popups

Please note however that "General->Configuration->Disable Popups" will disable ALL Forest popus, not 
just this one and before turning off the popup, double check that Rescale the XRef Objects is enabled, as 
the default option. Otherwise, libraries will be not load correctly.





Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  51

 Statistics Window
Opens a floating window showing statistics of the last selected Forest object, including the number of trees created, 
build time, maximum density of trees in the area, etc.

If Forest cannot create trees because of an error condition (indicated by displaying an orange "F" icon in the 
viewport instead of the trees), this window can be used to get additional information about the cause of the 
problem.

Forest stats showing a "density too high" error

 Global Settings. 

Opens a dialog to set global settings that are used for all Forest Objects, including the ability to hide rollouts and 
disable pop-ups.
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6.3 Add Geometry

6.3.1 Overview
Forest Pro enables you to choose from an unlimited number of different objects to scatter, these are managed from 
the Geometry List. Items can be loaded from the library or picked directly from the scene, any valid geometry object 
can be used, the table below outlines the types supported by each renderer. There is no need to convert meshes to 
Proxies, Forest pack use native geometric shaders to automatically creates instances on the fly for compatible 
renderers. 

Renderer Supported Objects

Scanline Meshes (or any object that can be converted to mesh).

V-Ray Meshes, V-Ray Proxies, lights and several other non-geometric objects

Corona Meshes, lights and several other non-geometric objects

Arnold Meshes, Procedurals, lights and several other non-geometric objects

Octane Meshes, lights and several other non-geometric objects

FStorm Meshes, FStorm Proxies

Redshift Meshes, Redshift Proxies

Arion Meshes

Maxwell Meshes, Maxwell Proxies

Mental Ray Meshes, MR Proxies and RPC objects

6.3.2 Procedures

To create a new Forest Object based on a spline area or surface:
Go to Create > Geometry > Itoo Software and click Forest Pro
Select a mesh, billboard, or preset by clicking the Select button and picking from the Forest Library. If the 
object you wish to use is not in the library, skip this step and a simple plane object will be used. This can be 
adjusted later to use your own custom objects in the Geometry rollout.
Ensure the mode is set to Generate.
Click a spline area or surface in the viewport. Go to the Modify panel to access parameters for .Add Geometry 
v7.x, Areas, Distribution, Camera, Transforms, Animation and more.
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To create a new Forest object using Custom Edit:
Go to Create > Geometry > Itoo Software and select Forest Pro.
Change the mode to Custom Edit.
Click anywhere in the scene to place trees.
When you are finished, right click to exit create mode. Further parameters such as .Add Geometry v7.x, 
Surface, Camera, Transforms, Animation and more can now be adjusted in the modify panel, to further add 
or modify objects please see the Item Editor reference.

To add a new object to the Geometry list from the library:
Create a new Forest Object as described above.

Open the Geometry rollout and click   (Add New Item).
The properties section determines the type of geometry to create, to load an object from the library, Click on 

.
The library browser will open, use the directory navigator on the left of the interface to select an library, then 
pick the desired object from the items view.

 
To use the selected object, either double click, right click and select Use Item(s), or click Import Selected.

To add a new Billboard object to the Geometry List:

Open the Geometry rollout and click on  (Add New Item).
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From the Properties section select Template and set the type of billboard geometry from the drop down list.

 

Set the Width and Height, To constrain proportions click  (Lock Aspect Ratio) found to the right of the 
spinners.
Apply a material to the planes by dragging or copy and pasting an instance to the Properties > Material pick 
button. Ensure you assign the material to this button, not the Forest object itself. Forest automatically 
manages a multi-sub object material based on the materials assigned in the Geometry List rollout. If you do 

accidentally overwrite this, recover it by clicking . See the reference section below for 
more information.
If necessary, move the pivot position used for rotation by adjusting the Centre Displacement value. This is 
measured as a percentage of the overall billboard width.

To add a new geometry object to the Geometry List:

Open the Geometry rollout and click on  (Add New Item).
The Custom Object picker button (marked "none") will be automatically selected. Pick an object to be 
scattered from the scene. Any materials applied to the object will be retained.

To add lights and other non-geometric objects to the Geometry List:

Open the Geometry rollout and click on  (Add New Item).
The Custom Object picker button (marked "none") will be automatically selected. Pick an object to be 
scattered from the scene. Any materials applied to the object will be retained
Some objects will be detected as geometry even though they are not. If this is the case enable the Non-
Geometric Object option

To add a group to the Geometry List:
Adding groups must be done using the name selector. Max does not support picking groups from the scene. A group 
can be added in two ways.

Either:

Open the Geometry rollout and click   (Add New Item).
From the Properties section, change the geometry type from template to Custom Object.
Click on the Custom Object picker button (marked "none") . Groups cannot be selected by clicking on them 
in the scene, instead open the Select From Scene dialog by pressing H on the keyboard. Select a group from 
the list and either double click or press the Use button.
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Or:

Click  (Add Multiple Custom Objects) from below the geometry list, this will automatically open the pick 
from scene geometry list .

Select either a single or multiple groups from the list and click .

To add a blank object to the Geometry List (to create gaps):
To create blank spaces or gaps in a scatter, null objects can be added to the geometry list. This will be taken into 
consideration as part of the distribution but no geometry will be generated.

Open the Geometry rollout and click    (Add New Item).
From the Properties section, change the geometry type from template to Disabled.
Change the probability of a null object being selected using the Properties > Probability parameter.

To add multiple objects to the Geometry List:

Open the Geometry rollout and click   (Add Multiple Custom Objects).
Select the objects to use from the list. To select multiple object from the list either select individually while 
holding down control, or select a range by clicking the first object then hold down shift and click the last 
object.

Click  to use the selected objects.

OR 

With a Forest Object selected, go to the Geometry rollout

Click the Pin Stack button . This will allow you to keep the Forest Interface in the Modify panel even 
when you select other items. 
Select all of the items you wish to scatter.

Click on   Add New Item button in Forest Pack's Geometry rollout
All the selected items will be added to the Geometry list. 
Reselect the Forest object and turn off Pin Stack 

To delete and object from the Geometry List:
Select the item from the the Geometry List.

Press  (Delete Item).

Groups (FP4 and above only)

This mode is useful to scatter groups of objects, preserving their composition, for example clumps of 
plants like flowers or grass. It works well when used in combination with Distribution > Diversity > Clusters.

Once scattered elements of a group are handled as individual items, both for the boundary checking and 
surface placement. This also has a noticeable impact on the number of items generated, so care should be 
exercised when scattering groups that contain many objects.

Do not use groups for objects that must be handled as a unique object (for example a tree and its leaves). 
In this case, attach all the individual parts into single mesh.


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To Copy and Paste objects:
Select the source item from the geometry list.

Click   (Copy item values).

Select the target item, or create a new one by clicking  (Add New Item).

Click   (Paste item values).

To change the order of objects:
When using forest in custom edit mode items can be created in a sequence instead of randomly selected from the 
geometry list. When using this feature it is helpful to be able to rearrange the order of the objects in the Geometry 
list.

To move an object up the Geometry list, select it and click on  (Move up).
To move an object down the Geometry list, select it and click on the  (Move down).

To manually set the height and width of a billboard or custom object:
Select an item from the Geometry List.
If the item is a Custom Object, turn off Use Objects Dimensions.
Use the Width and Height parameters to set a new size for the object.

 

By default the Width and Height are constrained maintain proportions, uncheck  (Keep Aspect Ratio) to 
change the width and height independently.

To manually set the height and width of all objects:
Turn on Global Size>Apply.
Adjust the Global Size > Width and Height parameters, all items in the geometry list will use the new values.

 

To adjust the size of all objects, retaining the original proportions:
Adjust the Global Scale value, measured as a percentage of either the items original size, or as set in the 
Properties > Width and Height parameter. The default scale value is 100%.
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To assign a color ID:
Select an object from the Items List.
Click on the Color ID color swatch to open the 3DS Max color picker.
Select a new color and click OK.
Turn on Display > Viewport > Use Color ID to display the color in the viewport, or see the Distribution 
Map reference to see how to use Color IDs in conjunction with RGB maps to place items.
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To assign a material to an object:
To apply a material to an object in the Items List, select the item from the list then drag a material from the 
Slate or Compact Editor to the Properties > Material Name slot.

 

To rebuild materials if accidentally overwritten:
Since any object in Max can only have one material applied, Forest Pack Pro automatically creates a Multi/
Sub object material based on the materials assigned to each individual item in the Geometry List. If 

accidentally overwritten or lost, simply press  to recreate the Forest auto-material.
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To adjust the probability of an object being used:
Either

To manually adjust the chance of an item from the geometry list being selected change the 
Properties>Probability percentage the value will be displayed next to the name in the items list. The 
percentages are normalised automatically behind the scenes, however, if you wish to display these values, 
click  (Normalise).

or

To create randomised values for all objects in the Geometry List, click  (Randomize).
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6.3.3 Interface

Geometry List
Description of the geometry list
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Add object to the Geometry List

Remove selected object(s) from the Geometry List

Add multiple objects to the Geometry List

Copy selected object(s)

Paste objects(s)

Move selected object(s) up/down

Properties group

Library

Opens the Forest Library allowing you to import individual 3d meshes, billboards and complete presets.

 

Get Size from Library

When on an item will inherit Width, Height, Z Offset, and Center Displacement values from the library. When 
unselected only the material is imported.

Color ID

Used to define the color of items in the viewport when Display > Viewport > Use Color ID is active. This parameter 
can also be used in conjunction with Image Mode > Diversity > Match Color ID on Map. This mode allows you to 
place items according to pixel information most closely matching the Color ID on a bitmap or procedural map. 

Name

Shows the name of the selected item. The name updates automatically to match the source geometry but can also 
be edited manually.

Disable

Disables geometry for the selected item. This is not the same as deleting the item, it will still be taken into 
consideration as part of the scatter algorithm, but will not render leaving a space.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://www.youtube.com/watch?v=6Tg4A1QYU3M

In Forest Pack 4.3 this option is removed and enable by default

http://www.youtube.com/watch?v=6Tg4A1QYU3M
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Template

Use a predefined geometry template from the drop-down list. Used for billboards, for 3d geometry use the Forest 
Library

It is possible to create your own templates by editing an index.dat text file and using standard Max scenes for the 
meshes, see Installation and customisation for details.

Custom Object

Use a custom mesh. Click this button to select the source object from the scene. when an object is selected the 
button will display the source name, otherwise it will return None. To delete references to the source, click Clear.

Use Object Dimensions 

When on, objects use the size of the source object. When off the size is defined by the Width and Height values.

Scale Forest 4.3 and above Only

Set the scale of a custom object. Measured as a percentage of its original size.

Width

Set the width of Billboards. (use   to constrain proportions)

Height

Set the height of Billboards. (use   to constrain proportions)

Z Offset

Sets an offset value on the Z Axis, measured in scene units.

Center Displace

Adjust the lateral pivot position. Useful when using billboards which can rotate on the Z axis to keep them facing 
toward the camera.  Use this value to adjust the rotation point for textures that require an offset pivot.

From Forest Pack 4.3 this option is removed. To resize custom objects use the Scale value.
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Collision Radius

Defines the collisions radius for the selected item. This value is multiplied by the global radius parameter found in 
the Distribution Map rollout, to compute the distance between objects to detect a collision. 

Probability

Defines a percentage probability that the item will be selected in the random distribution. If the sum of all the 
probabilities in the Geometry List exceeds 100%, the values are normalized internally by the distribution algorithm. 
You can also use the  to normalize the list manually and  to randomize the values.

Material

Used to assign a material to the selected item. 

Non-Geometric Object

Enable this when scattering a non-geometric object but Forest Pack has detected it as standard geometry. 

Global Size group

Apply

When on, all items take the Height and Width defined in the Global Size group settings. When off Items use their 
individual height and width settings

Width

Defines the global width value.

Height

Defines the global height value.

Forest Pack Auto-Material

Forest needs to build a single multi-sub object material combining all the materials applied to the items in 
the Geometry List. Because creating this material and correctly assigning the material IDs manually would 
be a complex and time consuming procedure, Forest performs this action automatically.

Subsequently applying materials to items is very different compared with the normal workflow in 3DS Max. 
The material is NOT applied directly to the object using the Material Editor, but instead selected as a 
parameter in the Geometry rollout, using the "Material" pick button.

For Custom Objects, if material is not specified, Forest uses the material assigned to the source object.

If you accidentally assign another material to a Forest object, use the "Reassign Material" button to 
recover the auto-material.



In Forest Pack 4.3 this option is removed although these parameters can still be accessed using maxscript 
using ("globsize", "width", "height")





Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  64

1.

2.

3.

Global Scale
Applies a global scale factor to all items in the Geometry List. 

Consolidate Materials
Is possible to disable the automaterial feature and assign the materials manually, although is not recommended. 
For this, uncheck the "Consolidate Materials" parameter in the Geometry rollout.

6.4 Forest LOD

6.4.1 Overview
Forest LOD allows you to switch geometry objects based on their distance from the camera or their size in the 
render view. The most common use for this feature is to create Level of Detail models so that less complex models 
and materials can be used further from the camera to help speed up renders.

Using LOD models with Forest Pack requires a slightly different workflow from using standard geometry objects.

Instead of a single model for each object, LOD models require 2 or more models. Each of these optionally 
can have unique materials.
Models are added to a Forest LOD object. From here you can configure the trigger distance or size to switch 
between models, assign materials and blur the transition between LOD levels.
Finally the Forest LOD object is scattered by adding it to the Geometry List inside a Forest Pack object. From 
here it is also possible to override the distances used to calculate the trigger points directly from the Camera
Rollout.
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6.4.2 Procedures

To create LODs based on distance from the camera
Go to Create > Itoo Software > Forest LOD and click and drag to create a new Forest LOD object in the 
viewport.

 

Add the objects to the Forest LOD object. To add a single object click on  , select Custom Object , Click 

 and pick an item from the scene. To add multiple objects click   and pick 1 or 
more items from the Object Picker. 
Add Visibility > Max Distance values for each LOD level. The lower the value the closer to the camera, so the 
more complex models should have the smaller values. See below for a more detailed explanation. 

Alternatively you can click   to automatically create values based on the object's order in 
the LOD list.

 
Enter a Maximum Distance value. This defines the distance range over which the LOD effect is calculated.

 
Add Variation if necessary to blur the transition between LOD levels.

Select or create a new Forest Pack object. Go to the Geometry Rollout, click on   and select the Forest 
LOD object from the scene. There is no limit on the number of LOD objects that can be used.

http://docs.itoosoft.com/display/FORESTPACK/Forest+LOD#ForestLOD-Mode
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If you want to override the maximum distance settings, go to the Camera Rollout and increase the Max 
Distance value. Any value greater than 0 will override the settings used in the Forest LOD object.

 

To create LODs based on screen size
Go to Create > Itoo Software > Forest LOD and click and drag to create a new Forest LOD object in the 
viewport.

 

Add the objects to the Forest LOD object. To add a single object click on  , select Custom Object , Click 

 and pick an item from the scene. To add multiple objects click   and pick 1 or 
more items from the Object Picker. 
Change the mode to Min Screen Size.

Add Visibility > Max Min Screen Size values for each LOD level. The higher the value the closer to the 
camera, so the more complex models should have the larger values. See below for a more detailed 

explanation. Alternatively you can click   to automatically create values based on the 
object's order in the LOD list.

 

http://docs.itoosoft.com/display/FORESTPACK/Forest+LOD#ForestLOD-Mode
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Add Variation if necessary to blur the transition between LOD levels.

 

Select or create a new Forest Pack object. Go to the Geometry Rollout, click on   and select the Forest 
LOD object from the scene. There is no limit on the number of LOD objects that can be used.

To assign materials to LOD levels
Click on an object from the LOD List.

Drag a material from the Material Editor to the Material slot in the Properties group. Simpler materials 
would normally be used furthest from the camera.

 
Repeat for each object in the LOD List. Alternatively if you have a unique object for each LOD level, you can 
apply materials directly to the source geometry. 



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  68

1.

2.

1.

2.

3.

To set Maximum Distance from a camera's Environment Range
In the Forest Pack object, go to the Camera rollout and turn on Use Environment Range

 
Select the camera and you can now use the Environment Ranges values to define the Maximum Distance 
used to calculate the LOD levels.

 

To use a Custom Look-At Target
In the Forest Pack object, go to the Camera rollout and turn on Use Look-At Target.

Assign a Look-At Target from the Look-At group

 
Adjust the Max Distance. this will now be calculated radially from the Look At object.
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6.4.3 Interface

LOD List
Use this list to add LOD levels for the current object. Each item on this list 
represents a single LOD level. The number next to the name shows the percentage 
of either the distance from the camera or the screen size at which this level 
becomes active.

To add geometry use the following buttons:

Add object to the LOD List

Remove selected object(s) from the LOD List

Add multiple objects to the LOD List

Copy selected object(s)

Paste objects(s)

Move selected object(s) up/down

Properties

Disabled

Disables geometry for the selected item. This is not the same as deleting the item, 
it will still be taken into consideration as part of the scatter algorithm, but will not render,  leaving a space.
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Template

Use a predefined geometry template from the drop-down list. Used for billboards.

Custom Object

Use a custom mesh. Click this button to select the source object from the scene. when an object is selected the 
button will display the source name, otherwise it will return None. To remove references to the source, click Clear.

Scale

Allows you to proportionately scale the geometry as a percentage of its original size.

Z Offset

Sets an offset value on the Z Axis, measured in scene units.

Center Displace

Adjust the lateral pivot position. Useful when using billboards which can rotate on the Z axis to keep them facing 
toward the camera.  Use this value to adjust the rotation point for textures that require an offset pivot.

Material

Used to assign a material to the selected item. Each LOD level can use a different material

Visibility
The visibility group is used to control the point at which the LOD object switches between levels.

Max Distance

Used to set the trigger distance for each LOD level. Measured as a percentage of the Maximum Distance value. An 
object is used when it exceeds this distance. If more than one LOD is eligible, the one nearest the current distance 
value is used. 

Min Screen Size

Used to set the trigger size for each LOD level. Measured as a percentage of screen size as viewed from the active 
camera. An object is used when its size exceeds this value. 
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Normalize Values

Click this to automatically assign values to Max Distance or Min Screen Size for all LOD levels. This function used the 
order of the objects in the LOD list to automatically calculate evenly distributed values.

 Mode

There are two modes:

Maximum Distance. This is the default mode and uses a distance measured in scene units radially from the 
active camera, or optionally a manually assigned custom look-at target. An LOD level is triggered when its 
distance from the camera exceeds the percentage specified by the Visibility > Max Distance value. In the 
illustration below LOD 1 is set to 0% so displays immediately. LOD 2 is set to 33% and so becomes active and 
replaces LOD 1 when an object's distance from the camera is a third of the maximum distance. Finally all 
objects displayed further than 66% of the maximum distance from the camera are replaced with LOD 3.

Minimum screen size: This mode use the scatter object's size in the camera view to switch between LOD 
levels. This is measured by comparing the diagonal length of the bounding box to the diagonal length of the 
screen. In the illustration below LOD level 1 is set to appear only if the tree's diagonal length is greater than 
25% of the screen's diagonal. LOD 2 appears if the diagonal is below 25% but above 12.5%, and finally LOD 
3 will appear when it's diagonal length is below 12.5% to infinity. 

Variation
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Use this to add randomness to the Maximum distance or screen size settings creating a blurred boundary between 
LOD levels.  This helps to disguise the transition from one LOD level to another and reduces obvious popping when 
rendering animations.

 

Update on Viewport

When On, LOD effects will be visible in the viewport. When off LOD effects are only visible at render time.

Icon Size

Used to set the size of the Forest LOD icon.

6.5 Areas

6.5.1 Overview
The areas rollout is used to define boundaries within which items from the Geometry list are scattered. There are 5 
types of areas that can be used in combination in a single Forest object:

Splines.
Objects
Forests
Paint.
Surfaces.

Depending on the type, an area can be set to either Include or Exclude scatter items. Include is an additive mode 
that creates items within the region, Exclude is subtractive, removing items from the region. The table below 
illustrates the modes available for each area type. 

Area Type Include Exclude

Spline

Object  

Forest  

Paint
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Area Type Include Exclude

Surface  

Surfaces allow you to scatter items on uneven surfaces, it is possible to toggle surface on and off from the areas 
rollout but adding new surface areas and editing the parameters is handled in a the Surfaces rollout.

6.5.2 Procedures

To create a new Forest object based on a spline
Open the Create panel and select iToo Software from the object subcategory list.

Click  and then click any spline in the viewport. 
Open the Modify panel and make any necessary adjustment to the spline's settings from the Area rollout.

To create a new Forest object based on a  surface
Open the Create panel select iToo Software from the object subcategory list. 

Click   and then click a surface in the viewport.
Open the Modify panel and make any necessary adjustment to the settings from Surface rollout.

To add a new closed spline area
Open the Areas rollout. 

Click  found below the Areas List.
Pick a closed spline from the scene. 
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To add a new open spline area
Open the Areas rollout. 

Click   found below the Areas List.
Pick an open spline from the scene. 
Adjust the Thickness value to define the width to scatter objects either side of the spline. 

To add a new paint area

Open the Areas rollout. 

Click   found below the Areas List.

Click   to open the Painter Settings.
Set the Min and Max brush size, if you are using a tablet turn on Enable Pressure Sensitivity to use pen 
pressure to control the brush size.

To use a paint area you must also have a Surface area set to XY mode but this should be switched off in the 
Areas list to restrict the scatter to only the painted regions.


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Click   and paint on the surface in the viewport.

Click  and paint on the surface in the viewport to erase paint areas.

To convert a paint area to splines

Click  .
Modify the spline using 3DS Max's standard spline modelling tools.

If necessary, click   to restore the spline to a paint area (This can be done with any spline 
object).

To exclude scattered items using splines

Open the Areas rollout. 

Click   found below the Areas List.
Pick a spline from the scene, if it is an open spline enter a Thickness value.
Click Exclude.

 

In order to work correctly, exclude areas need to be above an include area in the Areas List. To change the 
order order of areas use  .

 


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To exclude scattered items using an object
Open the Areas rollout. 

Click   found below the Areas List.
Pick any geometry object from the scene. Where the object overlaps an include area the scatter items will be 
removed.
To improve accuracy for large scenes increase the Resolution value (default is 512px). 
To Increase or decrease the distance between scattered items and the object, adjust the Scale value.

 

To exclude scattered items using another Forest object
Open the Areas rollout. 

Click   found below the Areas List.
Select a Forest object from the scene. 
Adjust the Scale value if necessary to change the exclusion size around each tree.
Change Falloff > Exclude values for Density and scale (see below).

To create a separate region around the base of each tree.

Clone the Forest Object use in the last steps
Select the the Forest area from the list and click on Invert Curve.
Adjust falloff, Add Geometry items and Image Mode as required.

To add scale and density falloff along a boundary
Using falloff controls it is possible to affect the density and scale of objects near an area's boundary. 

Click Falloff > Density and Falloff > Scale.
Enter Include Range values to define the distance affected measured from an include area's boundary. 
Enter Exclude Range values to define the distance affected measured from an exclude area's boundary. 

The default falloff setting is linear, to change the falloff curve click  .

You can also use groups but this is recommended only when the objects are close together. If you need to 
use multiple objects that are a large distance apart, assign each one as a separate area.


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5. The falloff graphs have the range on the X Axis (from 100% to 0 %) and the Scale or Density percentage on 
the Y Axis (from 0% to 100%).
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To add scatter items around the perimeter of an exclude object
Add a Spline, Paint or Surface include area.
Add an Exclude area above the include area in the Areas list.
Turn on Falloff > Density and/or Falloff > Scale and enter an Exclude Range value.
Click Invert Curve. This will reverse the effect of the falloff curve generating items only around the perimeter 
of the exclude object. 

To override the geometry used in an individual area
Select the Area to parameterise from the Areas List.
Click Plants > Select Models.
Click   and tick the models to use from the Select Models menu. Click OK. 
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To limit the scatter using material IDs
For this feature to work, a Surface must be assigned in the Surface rollout and Forest must be set to X/Y 
Mode.
In the Mat. ID list box, enter the Material ID numbers of the faces you wish to use to scatter objects
To add multiple IDs simply add a list, ensuring there is a space between each value.

 

To override the distribution map used in an individual area
Adjust the scale of the distribution map by adjusting Override Dist. Map > Scale.
Adjust the density of the distribution map by adjusting Override Dist. Map > Threshold.
Apply a new distribution map to the selected area by dragging a map to the Distribution Map Slot. 

 

To prevent scattered items from "leaking" outside an area perimeter 
For V-Ray users, set Boundary Check mode to Edge. 

 

For Mental Ray and Corona  
users, set Boundary Check mode to Edge. 

 
Add a Forest Edge map to the Opacity or Cutout  map slot of all the object's materials. You can 
automate this process for objects with large numbers of materials using the Material Optimiser tool. 

For all other renderers, set Boundary Check mode to Size. To create large areas with well defined 
boundaries, please refer to the Grass Edges tutorial.

 

Please be aware that Edge Mode is not compatible with V-Ray proxies.If you wish to reduce file sizes 
and use Edge Mode it is recommended to use XRef objects instead.



http://www.itoosoft.com/tutorials/tutorial_grass_edges.php
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6.5.3 Interface

Areas List
The areas list details all the items being used to define the scatter region. The order is 
important, areas are processed from the bottom of the list upwards, an exclude area 
will only affect areas that are below it in the geometry list.

Icon Name Description

Add spline area Adds an include/exclude area defined 
by a spline object.

Add object area Adds an exclude area defined by a 
geometry object.

Add forest area Adds an exclude area defined by a 
Forest Pack object.

Add paint area Adds an include/exclude area by 
painting a spline using the mouse or 
tablet

Delete selected area Removes the selected area.

Add multiple areas Adds multiple areas from a list.

Move up Move the selected area up.

Move down Move the selected area down

Selecting an area from the list will change the available options in the Properties 
group. Some properties are common to all types of areas, while other are unique:

•

•

The areas are not available when working on Custom Edit mode or 
using UV Surfaces.
It is important not to overlap multiple Include areas. Overlapping 
areas duplicates geometry and the issue is not always obvious in the 
viewports, but you may get strange results in the render because of 
the coplanar faces.


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Spline Area Properties

On

When active turns the current area on. If unselected the area will be ignored when 
calculating the scatter regions.

Name

The name of the area. Default behaviour is to inherit the name of the source object but 
it can also be edited manually.

Include

When active the area creates items within the region defined by the spline.

Exclude

When active the area removes items within the region defined by the spline. Only 
items generated by areas below it in the Areas List will be affected.

Spline

Displays the name of the selected spline. Click this to pick a new spline from the scene.

Thickness

Used with open splines to define the width of the path in which items are scattered.

Force Open Splines

When enabled, all splines in the Area are treated as open splines. A distance either side 
of the spline is determined using the Thickness paramater. .

Convert to Paint

Converts the Spline area to a Paint area.

Object Area Properties
Object areas allow you to use any geometry to exclude scattered objects. Object areas 
are optimised for high polygon models and work by generating a black and white 
bitmap map by projecting the geometry onto the surface along the world Z axis.

Object

Displays the name of the assigned objects. Click this to pick a new object from the 
scene.

Top Limit

Defines a height above which the object's geometry is ignored when calculating the 
exclusion map .This feature is typically used for objects that are wider at the top than 
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at the bottom.

 

Resolution

Defines the size of the bitmap. Higher numbers result in greater accuracy typically 
required when using large models. Default value is 512px.

Scale

Scales the exclusion effect. Values of less that 100% will move scattered items closed 
to the object, values greater that 100% will push scattered items away from the object.

Forest Area Properties
Forest objects work in a similar way to Object areas allowing the use of a Forest object 
to create an exclude area.

Forest

Displays the name of the assigned Forest object. Click this to pick a new forest from 
the scene.

Shape

Select from Sphere or Mesh to define the geometry used to create the exclusion effect. 
Sphere use a virtual bounding sphere that is much faster though less accurate. The 
size of the sphere can be adjusted using the Scale value of the area or by changing the 
Collision Radius parameter for the Items found in the Geometry Rollout.

Mesh mode uses the full geometry to calculate the exclusion effect. The approach is 
more accurate but can be slower when using dense geometry.

Resolution

Defines the size of the bitmap. Higher numbers result in greater accuracy typically 
required when using large models. Default value is 512px.

Scale

Scales the exclusion effect. Values of less that 100% will move scattered items closed 
to the object, values greater that 100% will push scattered items away from the object.
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Paint Area Properties
Paint areas allow you to paint include and exclude regions with a mouse or tablet 
directly onto the terrain. Paint areas require a Surface set to XY mode.

Include

When active the area creates items within the region defined by the spline.

Exclude

When active the area removes items within the region defined by the spline. Only 
items generated by areas below it in the Areas List will be affected.

 Paint

Paint on a surface in the viewport to add to the current area.

 Erase

Paint on a surface in the viewport to subtract from the current area.

 Settings

Click to open the brush settings. From this menu you can adjust the size and pressure 
sensitivity of the brush and erase modes.
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Convert to Spline

Converts the Paint area to a Spline area.

Preview Falloff

When active the falloff effect is visible while painting (enabled by default).

Surface Area Properties
Due to the large number of options the majority of the surface areas settings are found 
in a separate Surfaces rollout. They do however display in the Areas List and can be 
toggled on or off from the Areas rollout.

On

Turns the surface on or off.

Common Properties
These properties are found in all area types.

Select Models

When active the selected area uses a subset of the models from the Geometry list 
defined in the Pick menu

Surfaces are often used to define the scattered item's position on the Z axis in 
conjunction with splines and paint areas to define the region on the X and Y 
axes. Occasionally you may find that the full terrain is filled with items,even 
though there are spline areas in the Items List. If this is the case the usual 
problem is because the Area is on, when using surfaces with other Include 
areas it is important to turn the Surface off.


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Override Distribution Map

Used to override the global distribution map.

Scale

Scales the distribution map only for the selected area.

Threshold

Adjusts the threshold only for the selected area.

Material ID

Limits the scatter surface to use faces with only the material IDs listed. To use multiple 
IDs, simply leave a space between them.

Falloff Affect

Adjusts the strength of the density and scale falloff curves. Setting this value to zero 
disables the effect completely.

Invert Curve

Inverts the falloff curve. Commonly use to create scatter items around boundaries and 
the perimeter of exclude areas.

Boundary Checking

Forest Pack 4.3 can use 3 potential modes to determine if an object falls outside of the 
scatter area and is removed.

Point: Uses the item's pivot point to check if outside the scatter area. If true the 
entire item is removed and you may get overlaps.
Size: Uses the item's width and collision radius to check if outside scatter area. 
If true the entire item is removed and you won't get overlaps but the boundary 
can be uneven if the item's size is too large.
Edge (V-Ray only): Uses the lowest Z Vertex of each of the item's individual 
elements to check if outside the scatter area. If true only the individual element 
is removed creating a clean edge, without slicing the geometry. Note that when 
using edge mode, an element is defined as a group of connected faces that 
share the same material ID. These are the same elements used by Forest Color.
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Pick

Opens the pick menu. When Select Models is active the current area will use only the 
models ticked in this list.

 

Falloff

Density

When on, items will change density as they approach a boundary. The distance from 
the boundary is controlled by the include and exclude range values and the density is 
defined by a falloff curve.

Scale

When on, items will change scale as they approach a boundary. The distance from the 
boundary is controlled by the include and exclude range values and the density is 
defined by a falloff curve.

Edge Mode does not preview in viewports

To improve viewport performance edge trimming is calculated only at render 
time. This means the effects of the this mode will not be previewed in the 
viewports. However, previews can be enabled by holding down the left CTRL 
key and clicking on the Edge radio button.



Please be aware that Edge Mode is not compatible with V-Ray proxies.If you 
wish to reduce file sizes and use Edge Mode it is recommended to use XRef 
objects instead.


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Include

Sets the range for the falloff effect on the perimeter of Include splines and surfaces.

Exclude

Sets the range for the falloff effect on the perimeter of Exclude objects, forests, and 
splines.

Affect Height only

When on the scale falloff effect only affects the height of the items. Dimensions on the 
X and Y axes remain unchanged.

 

Edit Curve

Edits the the falloff curves for the density and scale effect. There are separate curves 
for scale and density. 

 

6.6 Distribution
Forest Pack 6 includes four distribution modes. Image mode is used for traditional scattering in areas, Path mode 
allows you to distribute items at regular intervals along one or more splines, Reference mode places items on 
individual marker, and PFlow mode places items on particles. For more information, follow the links below. 

Image Mode
Path mode
Reference mode
Particle Flow mode
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6.6.1 Image Mode

Overview
This mode allows the user to specify a map to define the distribution of trees within the inclusion area.

To allow for the most flexibility an image is used as a distribution map. Each pixel in the image represents a 
potential tree position, a white pixels adds a tree, a black pixels leaves a space.

Using this method, it's possible to define nearly any distribution, from random scattering to very regular groups. In 
addition it is possible to choose which objects are placed either using built-in clustering algorithms or using a 
colour map.
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Interface

Image Settings

Forest can use a bitmap or a map as distribution image.

The plugin comes with some standard bitmaps included (Very Scattered, 
Scattered, Spread 1, Spread 2 and more). A custom bitmap can be selected as 
well by clicking the button under "Bitmap". The list of bitmaps is user 
customizable. In C:\Program Files\ItooSoft\forestpackpro\distmaps, there is a 
text file named "index.dat". It includes a list of the bitmap names and the 
associated file names.

To use a map, click the 'Map' button and select it from the Material/Map browser. 
All Max texture types are supported, from static bitmaps to animated noise maps. 
Use the "Clear" button to remove it.

The "Map channel " parameter is described in the following section.

Density

Lets the user choose the scale of the distribution map in the scene. The map is 
applied in a manner similar to the way texture maps are applied in Max. The 
image is scaled according to the defined size, and tiled in all directions.

It's important to remember that the perimeter of the forest is always defined by a 
spline boundary. The distribution map only shows how the trees are arranged 
within that spline.

X/Y Units

Defines the size of the distribution map in scene's units. If we use small values, we will see how the density of trees 
and the number of trees grows. Also, the process time and geometry size of the Forest object is higher. The plugin is 
optimized for speed, but to further speed up the plugin, here are some recommendations:

If the bitmap has fewer white pixels (less trees) but you set lower X/Y values, the density will be very high but 
most of the processing time will be wasted in computing gaps. To increase the density of trees, first set a 
higher density map, then lower the X/Y parameters. You can see in real-time some build parameters (such as 
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density, number of trees) with the "Forest Stats" window. Open it clicking the "View Stats" button in the 
"General" rollout.

The "Stats" windows also alerts the user to some warning conditions such as when the area spline is not assigned, if the density is 

too high and other conditions.

There is a limit for the number of trees created in a Forest object. This parameter is defined in the "Display" 
rollout, and the default value is 500,000. Also, when the resulting mesh has more than 100,000 faces, Forest 
builds the trees for the viewport using a simplified geometry (adaptative display). All this behavior may be 
adjusted with the "Display" parameters.

X/Y Pixels

These values are used to adjust the density in procedural maps, without modifying the X/Y Units scale. These 
parameters are locked when using bitmaps, using the number of pixels of the image as default value.

Image->Map Channel

As alternative of using the X/Y values to define the density of the distribution map, it's possible to get the scale from 
the UV coordinates of the surface. This mode is useful to adjust the position of trees in more precise way, using a 
surface map as reference.

To use this mode, a surface object must be assigned in the "Surface" rollout. The Surfaces can work in two 
operation modes, XY or UV (defined in the Surface rollout):

XY mode: the UV coordinates are taken from the map channel defined with this parameter.
UV mode: the map channel 1 is always used, and this parameter is locked.

Fit to scene

Allows the user to fit the map exactly over a position on the scene, automatically adjusting the offset and size 
values. Use Pick Start/Pick End to select on the scene the position of two opposite corners of the map. This tool is 
useful for adjusting maps which represent exact positions of elements in the image, such as modified aerial views 
using a white pixel per tree.

Lock Aspect Ratio

Locks the X/Y aspect of the map. When this checkbox is enabled, the Y size for map is ignored and only the X value is 
used.
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Offset

Adjusts the offset of the map over the scene. Values are in the scene's units.

Threshold

Defines how the image pixels are converted to black/white levels when the bitmap is in grayscale or color mode.

Rotation

Rotates the distribution map a specific number of degrees.

Max density

Set the limit of possible tree positions in the area (by default 10 million). Take care: this includes both white and 
black pixels in the distribution map, so you may reach the density limit using an empty map and low X/Y values, but 
not get a single tree in the scene.

Draw Gizmo Corners

Draws the corners of the distribution map to adjust it more easily.

Diversity Settings

This window defines different modes to select what type of object, from all items 
defined in the Geometry List, is used when planting a tree for each pixel of the 
Distribution map.

Random

Creates plants randomly, using the "Probability" values of the Geometry List. This is the default mode.

Match Color ID on Map

This mode allows you to use coloured distribution maps, where the color of each pixel defines a type of plant. In the 
scattering process, each pixel of the map is matched with the "Colour ID" values of the Geometry List, taking the 
most similar.

Note: the "Probability" values of Geometry List items are ignored on this mode.

Although it's not needed that colors be exact, to get the best results is recommended that "Color ID" values are the 
most similar possible to those used in the map. Also is better to use high contrast colours as red, blue, yellow, 
green... The gaps (empty positions) can be defined assigning a specific colour with a "Disabled" item of in the 
Geometry list.

The "Noise" parameter is used to add some random variation to the distribution.
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Clusters

This mode works grouping items of same type, in a similar way that plants are found in the nature. These groups are 
called clusters.

The following parameters are used to define the cluster appearance:

Size: use it to adjust the size of the clusters. This value is expressed in scene's units.
Roughness: set the shape of the cluster (0% = smooth, 100% = rough)
Blurry Edge: modifies cluster edge from sharp (0%) to blurred (100%)
Noise: adds random items to the distribution (0% to 100%)

Clusters require to use more than one item in the Geometry List (grass and flowers, several types of plants, etc). If 
not, it has no effect.
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Collisions

This feature checks the collisions between trees. It works scattering the items, 
and then deleting those trees that may collide with their neighbors.

Collision checking is based on exploring possible intersections between virtual 
bounding-spheres that surround each object.

To get the sphere's size of each objet, two parameters are used: Geometry 
Rollout->Radius, that is defined by each item of the Geometry List, and 
Distribution Map->Radius, that is a gobal value for the Forest object.. Both 

http://www.itoosoft.com/forestpack/reference/refgeometry
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parameters are multiplied to get the resulting size. The value is defined in percentage of tree's size (from 100% to 
1%).

The "Height" value is used to define the sphere's center in Z axis. The default value (0%) builds the sphere at ground 
level, increase it to improve the collision detection when using tall trees with large treetops.

Take care when using Collision Detection: if you increase the density of trees (using a dense map or lowering the X/Y 
parameters), you may get the same number of trees, because most of them are discarded by collisions... but the 
plugin will be have an extra workload in order to process them. This condition is alerted in the Forest Stats window, 
when the number of discarded trees is greater than 50%.

6.6.2 Path mode

Overview
Path distribution was introduced in Forest Pack 6, it enables you to distribute objects at regular intervals along one 
or more splines. The distribution remains fully parametric so you can easily adjust the spacing, offset rotation and 
more at any time.

This feature replaces the Distribute Along Spline feature found in the Tree Editor rollout in versions of 
Forest Pack prior to version 6.


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Procedures

To add spline

Click on the   button and select one or more splines by clicking on them in the viewport

To delete splines

Select the spline to remove from the paths list

Click the   button.

To add multiple splines

Click on the   button. 
A scene explorer will open called Add Multiple. 
Select all the splines you wish to add by holding down CTRL and clicking to select individual splines or using 
SHIFT and Click to select a range. 
Click Add

To distribute objects at evenly spaced intervals along spline(s)

Add splines to the Path List.
Enable Spacing mode. 
Adjust the distance between objects using the Spacing Value. 

To distribute objects on the vertices of along spline(s)

Add splines to the Path List.
Enable In Vertex positions mode.
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To align objects to follow the direction of spline(s)

To rotate objects on the X axis to follow the path enable Follow Path > X
To rotate objects on the Z axis to follow the path enable Follow Path > Z

To offset items parallel to the spline(s)

Increase or decrease the Offset property.

To create a repeating sequence of items

In the Geometry rollout, choose the order of items by moving them up and down in the stack using the arrow 
buttons. 

Go to the Distribution rollout and enable Path Mode. 
Add splines to the Splines List. 
Change Geom. ID to Sequence.
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Interface

Paths

The paths list allow to to select and manage the splines used in the scene along which items are distributed. Add 
and remove splines from the list using the buttons:

Add a single spline to the list

Delete the spline selected in the list

Open a scene explorer window and add multiple splines to the list

Geom ID

If you have more that one object in the Geometry List, this drop-down menu determines the order in which they are 
distributed along the spline. Use Sequence to loop through them in the order they appear in the Geometry list or 
use Random to shuffle the order. 

Spacing

In this mode items are positioned at regular intervals along the spline, defined using the distance paramter. 

In Vertex Positions

In this mode items are placed on a spline's vertices. 
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Spline Offset

Offsets the items on the spline. Positive numbers move the items to one side of the spline, negative to the other. 

Follow Path

This options allow you to rotate the items to follow the path of the spline. There are separate controls for the X and 
Z axis. 

6.6.3 Reference mode

Overview
Reference mode allows you to place objects on markers. A typical usage might be to replace cad objects imported 
from an architect's plans with trees or other objects. Scattered items retain a dynamic link to reference object, so if 
the object is moved, the distribution is updated automatically. You also have the choice of whether to place one 
item on each pivot point of the reference objects, or alternatively, one per face if you're referencing polygonal 
geometry.

Procedures

To select reference objects:

Either:

Add items individually by clicking on the plus button   and then clicking on an item in the scene. 

Or:

Add several items at once by clicking on the Select Multiple Items By Name button  . This launches a 
scene explorer so that you can filter and select reference items.

To delete reference objects:

Click the Delete button  to clear all the reference objects. 

To scatter one item per reference object:

Enable Distribute Using > Pivot mode.

This feature replaces the reference tools found in the Items rollout prior to the release of Forest Pack 6
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To scatter one item per face:

Ensure that your references are mesh objects.
Enable Distribute Using > Face mode.

To scatter multiple items per face:

Ensure that your references are mesh objects.
Enable Distribute Using > Face mode.

To match the reference objects' orientation and scale:

Enable Scale and/or Align checkboxes. 

Interface

Reference Objects

Add reference objects one at a time by picking them from the scene

Add multiple reference objects, selecting them from a scene explorer

Clear all reference objects

Distribute using

Determines how items are placed on reference objects. Several modes are available:

Pivot Point: the point of creation is the Pivot Point of the referenced objects. For example: to create a group 
of trees in specified points, which have been defined in an external program (such as AutoCad) and imported 
to 3D Studio Max as dummy reference objects. Align and Scale can be enabled to copy the scale and 
alignment based on the reference.
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Mesh Faces: creates an element for each face of the referenced meshes. If the Align option is enabled, items 
are aligned with the face, using as X axis a vector from the center to the farthest vertex in the triangle.

Alignment is calculated using a vector calculated from the center to the farthest vertex.

Items Per Face: Choose the number of items to add per triangle. For values greater than 1 a grid-like 
distribution on the face is created unless the Randomise Position option is selected
Material ID. Allows you to scatter on faces only with the specified material ID(s)
Align. Aligns the orientation of the scattered object to match the reference object or triangles
Scale. Scales the scattered object to match the reference object. In mesh faces mode, this setting has no 
effect. 

6.6.4 Particle Flow mode

Overview
Forest Pack 6 introduced the ability to scatter items on particles created using PFlow. Using this new mode it is 
possible to match the position, rotation and scale of particles and you can either choose to use all particle events or 
specify a selection. Animated particles are supported too as Forest Pack provides a live link to the particle object.

You are able to use all of Forest Pack's randomisation features including Forest Colour in PFlow mode.



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  101

1.

2.

•

•

•
•

•
•

Procedures

To distribute items on all particles:

Click on Particle Flow > Add   and select a PFlow object from the scene. Repeat this operation for each 
PFlow object you'd like to use as a scatter source. 
Enable All Particle Flow Events. 

To distribute items on specific particle events:

Click on Particle Flow > Add   and select a PFlow object from the scene. Repeat this operation for each 
PFlow object you'd like to use as a scatter source. 
Disable All Particle Flow Events. 

Click Events > Add  . A list of all the Events contained in the select PFlow objects will open.
Select Events and click OK.

To match the orientation and scale of particles:

Enable Align to match the orientation of particles.
Enable Scale to match the scale of particle.
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Interface

Particle Flow

Lists all the PFlow objects to be used to distribute items. To add and remove PFlow items use the following 
buttons: 

Add a PFlow item

Delete the selected PFlow object

All Particle Flow Events

When enabled all the Events from the objects listed in the Particle Flow list will be used to distribute items. Disable 
this checkbox and to specify individual Events.

Events List

Lists all the events to be used to distribute items. For this list to be active, the All Particle Flow Events option must 
be disabled. To add and remove events use the following buttons: 

Add a PFlow item
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Delete the selected PFlow object

.

Align

When enabled, items are oriented to match the particles.

Scale

When enabled, items are scaled to match the particles.

6.7 Effects
Effects allow you to extend the existing features of Forest Pack by adding new functionality from a library, 
importing them from individual files, or creating your own using Effects Expressions.

In this chapter we explain how to use Effects in the Forest Pack Pro 5.0 beta.

6.7.1 Contents
Effects Interface
Effects Library
Saving and Importing Effects Files
Creating and Editing Effects

Effects Syntax
Operators
Functions
Attributes
Parameters

Several new attributes allow you to create effects for use with PFlow objects.

fpItem.particleAge Particle Age in ticks (only for For Particle 
Flow distributions

Integer No

fpItem.particleRotation Particle rotation defined by incremental 
rotations in world axes XYZ (in radians)

Vector No

fpItem.particleScale Particle scale (only for Particle Flow 
distributions)

Vector No

fpItem.particleSpeed Particle Speed (only for Particle Flow 
distributions)

Vector No

fpItem.particleEventID Numeric ID generated from the Event's name 
in a PFlow distribution (i.e. 'PF Source 01-
>Event 02' get ID = 2)

Integer No

To learn more about Forest Effects, please visit the documentation.


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Effects Examples
Stepped Rotation
Lean out
Tint by Object
Tint by Boundary
Look At object with Falloff
Look at Boundary with Falloff
Repulsion
Bend by Object
XY Local Translate
Cars along spline
Place items on a displaced surface

6.7.2 Effects Interface
In Forest Pack 6 and onwards you'll find a revamped Effects rollout. Using this simple interface you can control the 
parameters of any effects loaded into the FP object. From here it is also possible to open the Effects Browser to 
load presets or open the Editor to create or edit effects. The interface comprises of three parts:

1 - The Effects Rollout

Use this interface to control effects parameters, and open the library and editor windows.

The Effects List. Lists all of the effects in the current object. Select an effect to see it's properties
Add Effect. Click this button to create a new empty effect.
Delete Effect. Click this button to delete the selected effect. 
The Effects Library. Click this button to open the Library and load pre-built effects.
The Effects Editor. Click this button to open the Effects Editor used to create and edit effects scripts.
On/Off. Use this checkbox to toggle all effects on or off.
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Effect Name. Used to name effects for easy identification
Parameters List. This list contains all the user editable values in the loaded effects.
Parameter Value. Used to enter a value for the parameter highlighted in the Parameters List.
Parameter Help. Displays an explanation of the parameter highlighted in the Parameters List.
Apply Only at Render Time. Activate this to apply the effect only at render time - this can speed up editing 
FP objects with complex processor intensive effects.

2 - The Effects Library

Library Menu. A drop down list to Select the library. By default you have two libraries, the Default library for 
built in effects and a User's library for your own effects.
Refresh. Click to refresh the effects navigator. This is usefully if you've made changes to the library manually 
in a file manager and you'd like to see these updates in the Effects Browser.
Effects Navigator. Displays a tree view of your selected library
Category. A category is a way of organising your effects. Categories can be nested.
Effect. An individual .eff file. Click to see more information about the effect.
Description. Shows a text description and instructions of the selected effect.
Preview Image. A image to illustrate the selected effect
Click for additional help. Click this button to go to online help for more information about the selected 
effect. For iToo effects this takes you to our documentation server.
Load. Click this button to load the selected effect.
Cancel. Click this button to close the Effects Browser without making any changes.
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3 - The Effects Editor

Use the Effects Editor to author new effects.

Command List. This 3 tabbed directory contains all the commands that are available to be used to create 
effects expressions. Click a command in this list one to show the help (5) or double click to insert the 
command at the current cursor point.
Expression Window. Use this window to create and edit a new effect,
Output Window. Shows the results of the expression, and any error or other system messages.
Toolbar: Contains buttons to save, evaluate and manage effects. Includes the following buttons:

Evaluate. Click to run the script in the expressions window.
OK. Click to run the script in the expressions window and close the editor.
Cancel. Close the editor without running or saving the script.
Clear. Delete the contents of the Expression Windows.
Data. Open the Additional Data Menu to add a name, description and thumbnail image (see below for 
more details).
Import. Open an effects file (.eff) replacing the contents of the expressions window.
Export. Save an effects file (.eff). 

Help. Shows help and information for the item selected in the command list.
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3.1 - The Parameters Tab

Use the Parameters tab in the Effects Editor to create variables whose values are assigned and edited from the 
Effects Rollout. 

Parameters List. Contains all the parameters for this Forest object.
Add new Numeric Parameter. Create a new Numeric Parameter. The value for this is edited in the Effects 
rollout.
Add new Object Parameter. Create a new Object Parameter. Allows you to use the position of other objects 
in the scene to influence Forest's properties. Assigned from the the Effects rollout.
Add new Controller Parameter. Create a new Controller Parameter. Allows you to use any other object's 
controller to influence Forest's properties. Assigned from the the Effects rollout.
Add new Texture Parameter. Create a new Texture Parameter. Allows you to use any a map to influence 
Forest's properties. Assigned from the the Effects rollout.
Add new Curve Parameter. Create a new Curve Parameter. Allows you to use a curve to influence Forest's 
properties. Assigned and edited from the the Effects rollout.
Delete Parameter. Delete the item highlighted in the Parameters List.
Properties Tab. Show the properties and attributes of the item highlighted in the Parameters List.
Parameter Name. Name of the Parameter selected in the Parameters List.
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Parameter Type. Changes the type of value used for Numeric Parameters.
Default Value. The default value used for Numeric Parameters.
Limits. Limit the values that can be entered within the minimum and maximum values
Description. This description can be viewed in the Effects rollout by clicking the Help button. Add 
instructions here to help explain an effects parameters for new users.

Additional Data menu

Thumbnail. Displays a preview of the selected effect. The browser does not rescale images so it's 
recommended to save them in a size that's appropriate.
Title. The name of the effect to be displayed in the Effects Navigator. If you leave this field blank the file 
name will be used.
Description. Add additional information about the effect such as a description and instructions for use.
Load. Click to select a preview image file in the format png, jpg, or xpm. The image is encoded in the .eff file 
so there's no need to include it if you share your files.
Clear. Click to remove the current preview image.
Additional Help (URL). Used to add a URL that can provide additional online help or information about the 
author.
OK. Click OK to save changes to the effect and return to the browser.
Cancel.Click Cancel to return to the browser without saving any changes.

6.7.3 Effects Library

Overview
The Effects Browser allows you to easily navigate the effects that ship with Forest Pack. It also allows you to import 
and manage your own effects or effects obtained from a third party. Using the effects browser makes it fast and 
simple to quickly add additional functionality to Forest Pack exactly when you need it.

Effects are saved in .eff files. These can be created using the Export feature of the Effects Editor, see this feature's 
reference for more information.
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Procedures

To open the Effects Browser

Go to the Effects rollout.

Click on the  button to add a new empty effect. 

Click to   open the Effects Browser.

To load an Effect using the Browser

Open the Effects Browser.
Use the Effects navigator to select the Effect you wish to use

Read about the effect in the description pane to see see instructions for its use. For extra information you 
may be able to click on the Click For Additional Help button to open our online documentation.

Click .
Adjust the properties if necessary from the Effects rollout.
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To access and load user and 3rd part effects from the Effects Browser

Choose User Path from the drop down list found above the Effects Navigator.

Select an effect from the effect navigator.

Click .

To create a Category in user Effects Library

Right click in the Effects Navigator

Click 
An add category dialog will open, enter a name and click OK.

To add a new Effect to the User library

Right Click on a Category and select Import Effect. 
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Select an .eff file and click Open.

The .eff file will be imported and saved to your Effects Directory.

To delete an Effect from the library

Select the effect you wish to delete from the Effects Navigator.
Right click and select Delete Effect.

To open the Effect's save location in Windows Explorer.

Right click on an effect and click Open in shell.

To add information about an effect

Select an effect from the Effects Navigator.
Right click and select Edit Data.
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The Edit Data window will open.

Enter a name for the effect in the title field (a). If this field is left blank the file name will be used.
Enter a description (b). This contain any instructions and additional information a user requires in order to 
use your effect. (optional)
Click Load to add a thumbnail (c). The plugin supports files of the type png, jpg, and .xpm. This image is 
displayed underneath the description in the effects browser. (optional)
Additional help is used to provide a link to a website (d).  This could be more informtation about the effect, 
the author or anything else you feel is helpful. (optional)
Click OK.

Though the Effect Browser allows you to import, delete and categorise your effects the plugin is actually 
just reading the directory structure of the user's effects folder. This means that it's easy to create new 
categories and organise effects using any file manager. By default user paths are saved in

C:\Users\username\Documents\Forest Pack\effects


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Interface

Library Menu. A drop down list to Select the library. By default you have two libraries, the Default library for 
built in effects and a User's library for your own effects.
Refresh. Click to refresh the effects navigator. This is usefully if you've made changes to the library manually 
in a file manager and you'd like to see these updates in the Effects Browser.
Effects Navigator. Displays a tree view of your selected library
Category. A category is a way of organising your effects. Categories can be nested.
Effect. An individual .eff file. Click to see more information about the effect.
Description. Shows a text description and instructions of the selected effect.
Preview Image. A image to illustrate the selected effect
Click for additional help. Click this button to go to online help for more information about the selected 
effect. For iToo effects this takes you to our documentation server.
Load. Click this button to load the selected effect.
Cancel. Click this button to close the Effects Browser without making any changes.

When editing the user library you can right click in the Effects Navigator to perform different functions. Depending 
on whether you click on a Category or an Effect you'll get the following menus:

Category menu
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Add category. Creates a new category in the selected location.
Delete category. Deletes the current category and its contents.
Import Effect. Import an .eff file into the current category.
Open in shell. Opens the directory of the selected category using your default File Explorer.

Effects menu

Edit Data. Opens the Additional Data menu used to include a title, description, preview image, and URL.
Delete Effect. Deletes the selected effect.
Open in shell. Opens the directory of the selected effect using your default File Explorer.

Additional Data menu

Thumbnail. Displays a preview of the selected effect. The browser does not rescale images so it's 
recommended to save them in a size that's appropriate.
Title. The name of the effect to be displayed in the Effects Navigator. If you leave this field blank the file 
name will be used.
Description. Add additional information about the effect such as a description and instructions for use.
Load. Click to select a preview image file in the format png, jpg, or xpm. The image is encoded in the .eff file 
so there's no need to include it if you share your files.
Clear. Click to remove the current preview image.
Additional Help (URL). Used to add a URL that can provide additional online help or information about the 
author.
OK. Click OK to save changes to the effect and return to the browser.
Cancel.Click Cancel to return to the browser without saving any changes.
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6.7.4 Saving and Importing Effects Files
If you'd like to import a pre-built effect or you've created one that you'd like to share with other users, then Forest 
Pack makes this process simple. Any effect, including its parameters, can be exported to an .eff file and distributed 
to colleagues or online. These files are small in size and can be easily shared. To import and export .eff files, follow 
the procedures described below.

To export an effect

From the Effects rollout, click on the  button to add a new empty effect and then click   to Open the 
Effects Editor.

Click to open the file selector.
Enter a filename and click Save.

To import an effect

From the Effects rollout, click on the  button to add a new empty effect and then click   to Open the 
Effects Editor.

Click to open the file selector.
Select a .eff file and click Open.

6.7.5 Creating and Editing Effects
Forest Pack's new Effects Editor allows anyone with basic scripting knowledge to extend Forest Pack with new 
features at any time, without having to wait for a new release. In this chapter we will introduce you to the basic 
syntax and walk you through your first example script. You'll also find all the reference for mathematical operators, 
variables and parameters, attributes, and functions you need to start writing and sharing your own effects.

Contents
Effects Syntax
Operators
Functions
Attributes
Parameters

Effects Syntax
From version 5.0 onwards you can use effects to control many of Forest Packs parameters using mathematical 
expressions. Effects are easy to use as long as you have some basic scripting and mathematics knowledge and use 
the syntax rules as described below.

Syntax reference

Effects expressions use a straightforward mathematical syntax comprising operators (+, -, *, /, etc.), mathematical 
Functions that take one or more arguments and return a result, FP's built in variables (which we have called 

Imported effects will overwrite any code or parameters you already have in the effects editor. A warning 
will be displayed to prevent accidentally losing work but be aware that the import process is not undoable.


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Attributes for clarity), user declarable Variables, and customisable Parameters that are editable from the Effects
rollout panel.  There are many built in functions, and attributes already available and these are all documented in 
the Command List on the left hand side of the Effects Editor. To see an explanation for each entry, single click on it 
and a description and example syntax will display in the Help pane at the bottom of the interface. General syntax 
rules are describe below.

Functions

Functions provide pre-built commands that can be used to perform common mathematical expressions. To use a 
function you use the name followed by any required arguments enclosed in parenthesis. For example, to convert 90 
degrees to radians you use the degToRad function as follows:

degToRad(90);

Where a function requires multiple arguments, these should be separated using commas. For example to generate 
a random integer between 0 and 350 you would use the randomInt function as shown below:

randomInt(0,359);

Functions can also be nested by including them as arguments, for example:

degToRad(randomInt(0,359));

You can find a full list of supported functions, including information about the arguments they require here.

Attributes

Attributes are Forest Pack's pre-defined variables. Dot syntax is used to access an attribute's values. This means 
that when using an attribute, the statement must always start with a reference to some object, followed by a full 
stop (. or dot) and then the name of the property you wish to access. Each dot represents a move from more general 
access to the object to more specific levels of parameter detail. For example fpItem refers to the the entirety of the 
Forest object, whereas fpItem.position accesses the local coordinates of each scattered item. Continuing down the 
hierarchy, fpItem.position.z refers only to the items position on the Z axis. Dot syntax is also used to access the 
position coordinates of Object parameters and the components of vector variables.

To assign a value to an attribute you use equals (=). For example to set the Z rotation of all scattered objects to 45 
degrees you would enter the following:

fpItem.rotation.z = degToRad(45);

Be aware that not all attributes in the Command List can be edited using expressions, but they can all be read. 
Studying the list of editable attributes is a useful first step in seeing what's possible with effects because these 
represent the aspects of Forest Pack that can be scripted with this new tool. A full list of attributes divided into 
editable and uneditable categories can be found here.

Variables

In addition to built-in attributes, variables can be created and edited in the expression script. They are declared as 
one of three types, either real for float values or scene units, int for whole numbers, or vectors. They are not case 
sensitive but there are a few restrictions on naming:

Cannot be the same as an existing attribute, function, variable or parameter.
Must only consist of alpha-numeric symbols and underscores (_).
Cannot start with a number.
Cannot contain spaces.
Variables are local to the Forest Object, this means you can use the same variable name in different objects 
without problems.
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Below are examples that illustrate how to create each of the three types of variable as well as illustrating some 
acceptable ways to construct variable names based on the rules outlined above. Green text illustrates the variable 
type, blue the name, and red the assigned value.

int objectCount = 3;
real object_rotate_z = 10.5;
vector objectPosition1 = [10,10,0];

 You can also create variables without assigning a value as follows:

int objectCount ;
real object_rotate_z ;
vector objectPosition1;

Once a variable has been declared, you assign a new value using equals (=). For example  

objectCount = 5;
object_rotate_z = 22.5;
objectPosition1 = [20,20,20];

Variable types cannot be changed once created and though you can assign an integer value to a real variable , you 
can't assign a real value to an integer. In this case you will need to use the rounding functions ceil(), floor(), trunc(), 
or round() to convert the real value to an integer, for example:

int integer;
real float = 12.3;
integer = floor(float);
print integer;

If you evaluate this code then 12 will display in the output window. This is because the floor function rounds 12.3 to 
the lowest adjacent whole number which can then be assigned to the integer variable with no errors.

Parameters

Parameters are a special type of variable whose values are assigned in the Effects rollout, this enables a user to 
control effects without needing to understand the code. Instead of being declared in the script like a normal 
variable, they are created in the parameters tab of the effects editor. 

There are 5 types available which you create by clicking on the corresponding button:
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 Numeric Parameters. Adds a numeric spinner to the effects rollout. Number format can be set to real, 
integer, percentage (real), or scene units (real).

 Object Parameters. Adds an object picker to the effects rollout and allows you to access the selected 
object's position vector.

 Controller Parameters. Allow you to access the output from any controller in 3ds Max, picked from the 
effects rollout.

 Texture Parameters. Allow you to use the RGB values from a map, picked from the effects rollout.

 Curve Parameters. Allow you to use a curve to control values. The curve can be edited from the effects 
rollout.

Use the properties section to fine tune the parameter including the type of number, minimum and maximum limits, 
a default value and the name. Irrespective of the type, you reference a parameter in the expression using its name 
and because of this, parameters have the same naming restrictions as regular variables as described above. 

To illustrate here's how you would assign parameters with names as shown in the screen capture above to a new 
variable:

int Variable1 = numericParameter; #if the type is set to integer
real Variable2 = numericParameter; #if the type is set to real, percentage or scene units
vector Variable3 = objectParameter.position; 
real Variable4 = objectParameter.position.z; #to assign just one component of an object's position (in this 
case z)
real Variable5 = controllerParameter; #if the controller outputs a float number
vector Variable7 = controllerParameter; #to assign a vector controller
vector Variable8 = controllerParameter.z; #to assign just one component of a vector controller (in this case 
z)

A parameter's values cannot be edited in the expression, only by changing the value of the spinner in the effects 
rollout or by editing the object or controller to which it is linked.

To read more about parameters and how to create and edit them, please see the parameters page.

Instruction separation

Each command must be terminated by a semi-colon ( ; ).

Comments

Comments are added by starting the line with a # symbol. Anything after the # on the same line will be ignored:

# This is a comment 
# This is another comment

Note that comment lines do not need to be terminated with a semi-colon, though it won't affect anything if you do 
so.

Debugging

To help debug effects we have provided a print command that displays the results of an expression or contents of a 
variable, parameter or attribute to the Output window. For example

real exampleVariable = 5.0;
print exampleVariable;
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1.
2.

3.

will print 5.0 to the output window.

Because you are often creating scripts designed to manipulate the values on thousands of scattered items it is not 
possible, or desirable, to see the results for every instance. Therefore the print command displays values for only 
the first scattered object

Case Sensitivity

Functions, variables, properties and attributes are not case sensitive, for example fpItem.position, 
FPITEM.POSITION, fpitem.position, and fp.ITEM.position all refer to the same attribute.

Getting Started - A simple example

To illustrate the syntax described above it is useful to go through the steps necessary to create a new effect. In this 
example the we'll add the ability to specify a step increment when using the existing Transform > Rotation > Z 
property. To do this:

Create a new Forest Pack object and assign to a simple Spline area.
As this script will control the Z Rotation, we can change the display mode to arrows to clearly see the effects. 
To do this, go to the Display rollout and change the Viewport mode to Proxy > Arrow.

Go to the Transform rollout and turn on Rotation. Set the Z Minimum value to 0 and the Z Maximum value 
to 270.

At this point the Forest object will randomise the rotation within the range specified by these two values. 
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4.
5.

6.

We want to control it so that it randomises within this range, but only in increments of a specified value.

Go to the Effects rollout and click to open the Effects Editor.
Comments
First let's add a comment to the effects so that anyone looking at the code knows what it does. Comments 
are added by starting the line with a # symbol. On line 1 write the following:
# Stepped Random Z Rotation

Because of the #, this line will be ignored when the interpreter parses the script.
Variables
Next we'll create a new Variable called rotateRange and assign to it the range specified by the Transform > 
Rotation > Z Minimum and Maximum values that we entered in step 2 above. To create a variable you must 
first specify the type of variable followed by the name. Numbers in the effects editor can one of three types: 
real (real), integers (int) or vectors (vector). In our example we want to create a Real variable called 
rotateRange so under the existing comment enter:

real rotateRange = 

We want to assign the existing rotation randomisation range specified in the Transform rollout to 
rotateRange. To do this you need to use an Attribute. These are Forest Pack's predefined variables, and a 
full list can be found in the Attributes tab on the left side of the Effects Editor.
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7.

To find the range, we need to subtract the Transform > Rotation > Z Minimum value from the Maximum.
To do this find randRotMax in the attributes list and double click on it. This will add the Attribute at the 
current cursor location. 
real rotateRange = fpItem.randRotMax

You'll notice that the full text reads fpItem.randRotMax, this is because randRotMax is an attribute of the 
fpItem object. Effects use dot syntax to access the properties or methods related to an object, for example in 
this case we only want to access the Z rotation property of the randRotMax vector, so we add a .z to the end 
of fpItem.randRotMax to give us:
real rotateRange = fpItem.randRotMax.z 

To deduct the minimum value, add a subtract sign and use the randRotMin attribute. It isn't necessary to use 
the Attributes list to add text; if you prefer too, and you're familiar with the commands, you can enter script 
manually. Type - fpItem.randRotMin.z so that the line now reads:
real rotateRange = fpItem.randRotMax.z - fpItem.randRotMin.z

Finally to separate instructions, every line (except comments) must be terminated with a semi-colon (;). So 
the final line will read:
real rotateRange = fpItem.randRotMax.z - fpItem.randRotMin.z;

Parameters
Parameters are variables whose values are assigned and edited from the Effects rollout. These can either be 
numerical value, the position of another object in the scene, or the output from another object's controller. 
In this example we need a step value parameter that can be easily accessed by the user. 
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8.

To add a new parameter you use the Parameters tab on the left of the Effects Editor. Click on the  button 
to add new numeric Parameter. You can then enter a name for the parameter, this will display in the Effects 
rollout and is also the variable name that you will use in the script to access the parameter's value. In this 
example we will name the parameter Z_Rotate_Step (note that spaces are not allowed).  You should also set 
the type of variable from the drop down list, options are Integer, Real, Scene Units, and Percentage -  in this 
case we need a Real number. 

In the Effects rollout you will now see the Z_Rotate_Step parameter. Select it and enter a value of 90 degrees 
for testing purposes. Of course any value can be used but this will make it very clear when the effect we are 
creating is working.

In the next step we will use this parameter to compute to maximum number of random values that can be 
generated by a given step size within the rotation range. This value is then assigned to a new variable called 
stepsInRange. For example with a range of 270 degrees and a step size of 90, there are 4 possible rotation 
angles if you include zero: 0, 90, 180, and 270.
To calculate this value, at the end of the script and on a new line enter the following code:



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  123

9.

10.

•
•

•

11.

real stepsInRange = rotateRange/Z_Rotate_Step;

This divides the variable we created in step 6 by the Parameter created in the previous step. 
To see the value of stepsInRange, you can use the Print function:
print stepsInRange;

Click evaluate and with the current settings the output window will display 3  (because 90 divides into 270 
three times). However if we change the Random > Z Rotate > Max  value to 300 degrees and evaluate again 
we get 3.33333. For this equation to work we need to know the number of times Z_Rotate_Step divides into 
rotateRange and return the results as a whole number. To do this we can use a function to round a 
fractional number down to the nearest whole value.
Functions
As with attributes, functions can be added by double clicking on them from the functions list or by entering 
them manually. If you select a function you will find help at the bottom of the effects editor that describes its 
application, lists the arguments and let's you know the type of number it returns.

To use a function you enter its name followed by the necessary arguments in parenthesis. For example to 
round 3.33333 down to 3 you would use the function floor(3.333). In our example we will add a floor function 
to the existing rotateRange/Z_Rotate_Step equation, so the line will now read:
real stepsInRange = floor(rotateRange/Z_Rotate_Step); 

Now we know how many times the step value divides into the rotation range we can use this value to create 
random angles and assign them to the scattered objects. To do this we'll create a random number between 
0 and StepsInRange and multply this by Z_Rotate_Step. To do add this to the last line of the expressions:
real ZRotation = randomInt(0,stepsInRange)*Z_Rotate_Step;

Let's look at each piece of this line.
real ZRotation creates a new variable of the type Real.
randomInt(0,stepsInRange) generates a random integer between 0 and the value stored in the 
variable stepsInRange.
The resultant random number is multiplied by the original rotate Z_Rotate_Steps value to generate 
the final rotation values.

Finally we need to assign the new rotation values to the Forest Pack objects. To do this you use another 
Attribute -  fpItem.rotation. Because we only need to change the z axis you append a .z to the end to give us 
fpItem.rotation.z. If you write fpItem.rotation.z = ZRotation you won't actually get the correct results because 
we have been calculating the random angle in Degrees, but fpItem.rotation uses Radians. Thankfully it's easy 
to convert between the two using the degToRad() expression. So the final line will read:
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12.

13.

fpItem.rotation.z = degtorad(ZRotation);

Remember, if you want to see more clearly what the variables are doing, add a Print command for each one. 
The final script should look like this:

steppedZRotate.eff

Click OK to save the expression. Congratulations, you've just created your first effect and you will now have 
a new spinner in the effects rollout that you can use to step the Transform Z Randomisation property of 
Forest Pack item. Remember if you want to save this effect to use on other Forest Pack objects in the future 
you can Export it from the Effects editor.

Click to download the .eff file for this example. To load it into Forest Pack follow the procedure described here.

Operators
The operators described below can be used to manipulate data.

Mathematical Operators

The following arithmetic operators are supported:

Operator Example Use Description

+ p+q Addition

- p-q Subtraction

- -p Returns the negative of a variable's value

* p * q Multiplication

/ p/q Division

^ p^q Power

Vector Operators

When using vectors the following operators apply:

# Stepped Random Z Rotation1
real rotateRange = fpItem.randRotMax.z - fpItem.randRotMin.z;2
real stepsInRange = floor(rotateRange/Z_Rotate_Step);3
real ZRotation = randomInt(0,stepsInRange)*Z_Rotate_Step;4
fpItem.rotation.z = degtorad(ZRotation);5
 6
# Print variables for debugging - shows results of 1st Forest item.7
print rotateRange; 8
print stepsInRange;9
print ZRotation;10
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Operator Example Use Description

.x V.x (eg. fpItem.position.x) Returns the 1st component of a vector

.y V.y (eg. fpItem.position.y) Returns the 2nd component of a vector

.z V.x (eg. fpItem.position.z) Returns the 3rd component of a vector

+ V+W (eg. fpItem.position+Object.position) Addition

- V-W (eg. fpItem.position+Object.position) Subtraction

* V*W (eg. fpItem.position*Object.position) Dot Product

* V*p (eg fpItem.position*5) Scalar Multiplication

/ V/p (e.g. fpItem.position/2) Scalar Division

^ V^W (eg. fpItem.position^Object.position) Cross Product

Comparative Operators

Forest effects includes an If function to allow you to create conditional rules.

This function uses the following syntax:

if(p,q,r) 

Where p is a logic test which returns q if it returns true or r if it returns false. 

To create the conditional tests for an IF function you use following operators:

Operator Example Use Description

== p==q Return true if p is equal to q

< p<q Return true if p is less than q

> p>q Return true if p is greater than q

>= p>=q Return true if p is greater than or equal to 
q

<= p<=q Return true if p is less than or equal to q

| p|q Return true if p or q are true

& p&q Returns true if p and q are true
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Functions
Forest Effects provide access to a comprehensive list of Functions to provide many common mathematical 
expressions plus additional operations that are unique to Forest Pack. You'll find the full list including syntax, 
description and parameters in the list below.  This information can also be accessed directly inside the Effects 
Editor. 

Forest Functions

fpSurfaceHitZ

Syntax fpSurfaceHitZ(p)

Description Computes the projection of p onto the 
Forest surface (XY mode only). Returns z 
value

Parameters P

Returns Real

fpSurfaceHit

Syntax fpSurfaceHit(p)

Description Check if the projection of p hits onto the 
Forest surface (XY mode only). Returns 1 
or 0.

Parameters P

Returns Vector

fpSurfaceHitNormal

Syntax fpSurfaceHitNormal(p)

Description Computes the projection of p onto the 
Forest surface (XY mode only). Returns 
normal vector

Parameters P

Returns Real

fpRandomGeom

Syntax fpRandomGeom()

Trigonometric Functions

sin

Syntax sin(p)

Description Sine of p (p expressed in radians)

Parameters p

Returns Real

cos

Syntax cos(p)

Description Cosine of p (p expressed in radians)

Parameters p

Returns Real

tan

Syntax tan(p)

Description Tangent of p (p expressed in radians)

Parameters p

Returns Real

asin

Syntax asin(p)

Description Arc sine of p (p expressed in radians)

Parameters p

Returns Real



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  127

Description Returns a random ID from the Geometry 
List. Can be assigned to fpItem.geomID

Parameters -

Returns Integer

Max Functions

evaluateTexture

Syntax evaluateTexture(texmap, uvw)

Description Evaluate a Texture Map Parameter, 
using specified uvw coordinates 
(vector). Return value as vector

Parameters Texmap, UVW

Returns Vector

evaluateCurve

Syntax evaluateCurve(curve, x)

Description Returns Y value for the Curve Parameter 
on X position

Parameters Curve, X

Returns Real

Standard Functions

ln

Syntax ln(p)

Description Natural (base e) logarithm

Parameters p

Returns Real

log

Syntax log(p)

acos

Syntax acos(p)

Description Arc cosine of p (p expressed in radians)

Parameters p

Returns Real

atan

Syntax atan(p)

Description Arc tangent of p (p expressed in radians)

Parameters p

Returns Real

atan2

Syntax atan2(x,y)

Description Returns the principal value of the arc 
tangent of y/x, expressed in radians

Parameters x
y

Returns Real

sinh

Syntax sinh(p)

Description Hyperbolic sine of p (p expressed in 
radians)

Parameters p

Returns Real

cosh

Syntax cosh(p)
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Description Common (base 10) logarithm

Parameters p

Returns Real

exp

Syntax exp(p)

Description Exponential function – exp(e) = e^p

Parameters p

Returns Real

pow

Syntax pow(p,q)

Description p to the power of q – p^q

Parameters p
q

Returns Real

sqrt

Syntax sqrt(p)

Description square root"

Parameters p

Returns Real

abs

Syntax abs(p)

Description absolute value

Parameters p

Returns Real

min

Description Hyperbolic cosine of p (p expressed in 
radians)

Parameters p

Returns Real

tanh

Syntax tanh(p)

Description Hyperbolic tangent of p (p expressed in 
radians)

Parameters p

Returns Real

radToDeg

Syntax radToDeg(p)

Description Takes p in radians and returns the same 
angle in degrees

Parameters p

Returns Real

degToRad

Syntax degToRad(p)

Description Takes p in degrees and returns the 
same angle in radians

Parameters p

Returns Real

Vector Functions

length

Syntax length(v)

Description The length of v.
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Syntax min(p, q)

Description minimum: returns p or q depending on 
which is smaller

Parameters p

Returns Real

max

Syntax max(p, q)

Description maximum: returns p or q depending on 
which is larger

Parameters p

Returns Real

mod{section

Syntaxmod(p, q)

 
Descriptionremainder of p divided by q

 
Parametersp

 
ReturnsReal

 

ceil

Syntax ceil(p)

Description smallest integer greater than or equal 
to p

Parameters p

Returns Integer

floor

Syntax floor(p)

Parameters v

Returns Real

unit

Syntax unit(v)

Description Returns a unit vector in the same 
direction as v

Parameters v

Returns Vector

comp

Syntax comp(v,i)

Description I-th component, where i=0, 1, or 2. 
comp(5,6,7, 1) = 6

Parameters v
i

Returns Real

dotprod

Syntax dotprod(u,v)

Description Dot product of vectors u and v. Same 
result can be obtained using u * v

Parameters u
v

Returns Vector

crossprod

Syntax crossprod(u,v)

Description Cross product of vectors u and v. Same 
result can be obtained using u ^ v

Parameters u
v
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Description largest integer less than or equal to p

Parameters p

Returns Integer

round

Syntax round(p)

Description value of p rounded to the nearest 
integral

Parameters p

Returns Integer

trunc

Syntax trunc(p)

Description nearest integral not larger in magnitude 
than p

Parameters p

Returns Integer

Conditional Functions

if

Syntax if(p,q,r)

Description Conditional: if p is nonzero then returns 
q, otherwise r

Parameters p
q
r

Returns Any

Interpolation Functions

easeIn

Syntax easeIn(x,x1,x2,y1,y2)

Returns Vector

Random Functions

randomReal

Syntax randomReal(a,b)

Description Returns a real random number in the 
range (a,b)

Parameters a
b

Returns Real

randomInt

Syntax randomInt(a,b)

Description Returns an integer random number in 
the range a,b

Parameters a
b

Returns Integer
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Description Returns an ease-in interpolation 
between y1 and y2. Returns y1 when x < 
x1

Parameters x
x1
x2
y1
y2

Returns Real

easeOut

Syntax easeOut(x,x1,x2,y1,y2)

Description Returns an ease-out interpolation 
between y1 and y2. Returns y2 when x > 
x2

Parameters x
x1
x2
y1
y2

Returns Real

easeInOut

Syntax easeInOut(x,x1,x2,y1,y2)

Description Returns an ease-in-out interpolation 
between y1 and y2. Returns y1 when x < 
x1 and y2 when x > x2

Parameters x
x1
x2
y1
y2

Returns Real

Attributes

Atributes allow you to read and edit the properties of Forest Pack to create sophisticated new 
effects. The list below is also replicated in the Effects editor for easy access.
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Read/write Forest Pack item attributes
The attributes below can be both read and edited. These important attributes represent all the aspects of a 
scattered item that can be controlled using Forest Effects.

Attribute Description Returns Writable

fpItem.position Position of Forest Item in local 
coordinates

Vector Yes

fpItem.rotation Rotation of Forest Item in local 
coordinates (expressed in radians)

Vector Yes

fpItem.xrotaxis Rotation of Forest Item expressed as a 
system of 3 vectors (X component)

Vector Yes

fpItem.xrotaxis Rotation of Forest Item expressed as a 
system of 3 vectors (Y component)

Vector Yes

fpItem.xrotaxis Rotation of Forest Item expressed as a 
system of 3 vectors (Z component)

Vector Yes

fpItem.scale Scale of Forest Item in local coordinates Vector Yes

fpItem.visible Set this to zero to hide the item from 
distribution

Integer Yes

fpItem.geomID Index in the Geometry List, starting at 
zero

Integer Yes

fpItem,tintColor Tint color (R,G,B) Vector Yes

fpItem.tintMulti Tint Multiplier (0.0 to 1.0) Float Yes

fpItem.animSample Animation Sample index (zero based) Integer Yes

fpItem.surfDirection Direction on Surface (-100 to 100) Integer Yes

fpItem.randTransMin Random translation minimum range 
(X,Y,Z)

Vector Yes

fpItem.randTransMax Random translation maximum range 
(X,Y,Z)

Vector Yes

fpItem.randRotMin Random rotation minimum range (X,Y,Z) Vector Yes

fpItem.randRotMax Random rotation maximum range (X,Y,Z) Vector Yes

fpItem.randScaleMin Random scale minimum range (X,Y,Z) Vector Yes

fpItem.randScaleMax Random scale maximum range (X,Y,Z) Vector Yes
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Read-only Forest Pack item attributes

The attributes below are read only and cannot be edited using Forest Effects. You can however use them to create 
expressions that manipulate the values of attributes detailed in the list shown above.

Attribute Description Returns Writable

fpItem.geomColor Color ID in the Geometry List (R,G,B) Vector No

fpItem.userID Generic value which can be assigned from 
Tree Editor

Integer No

fpItem.geomProbability Probability value in the Geometry List Float No

fpItem.distXPixel X pixel index in the Distribution Map 
(Generate mode only)

Float No

fpItem.distYPixel Y pixel index in the Distribution Map 
(Generate mode only)

Float No

fpItem.distXTile X Tile index in the Distribution Map 
(Generate mode only)

Float No

fpItem.distXTile Y Tile index in the Distribution Map 
(Generate mode only)

Float No

fpItem.distUVW UVW Coordinates for Distribution Map 
(using Surfaces only)

Vector No

fpItem.distPathPos Normalized position of item on path 
(Distribution by Path only)

Real No

fpItem.distPathTangent Tangent vector of path on item position 
(Distribution by Path only)

Real No

fpItem.collisionRadius Radius of the virtual sphere used for 
Collisions checking

Float No

fpItem.collisionHeight Height of the virtual sphere used for 
Collisions checking

Float No

fpItem.mirror 1 if item is mirrored, 0 if not Integer No

fpItem,animOffset Animation Offset (in ticks, 4800 ticks per 
second)

Integer No

fpItem.animNumSamples Number of animation samples (as defined 
in Animation rollout)

Integer No

fpItem.surfNormal Normal to Surface Vector No

fpItem.surfSlope Slope angle on Surface Real No
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Attribute Description Returns Writable

fpItem.areaIncDistance Distance to nearest include area Real No

fpItem.areaIncNearest Position of the nearest point of include 
areas (splines only)

Vector No

fpItem.areaExcDistance Distance to nearest exclude area Real No

fpItem.areaExcNearest Position of the nearest point of exclude 
areas (splines only)

Vector No

fpItem.areaFalloffScale Scale factor applied to the item due to 
Areas->Falloff

Vector No

fpItem.particleAge Particle Age in ticks (only for For Particle 
Flow distributions

Integer No

fpItem.particleRotation Particle rotation defined by incremental 
rotations in world axes XYZ (in radians)

Vector No

fpItem.particleScale Particle scale (only for Particle Flow 
distributions)

Vector No

fpItem.particleSpeed Particle Speed (only for Particle Flow 
distributions)

Vector No

fpItem.particleEventID Numeric ID generated from the Event's 
name in a PFlow distribution (i.e. 'PF 
Source 01->Event 02' get ID = 2)

Integer No

 Read-only Max attributes

The list below details the attributes of Max that have been exposed if Forest Effects.

Attribute Description Returns Writable

max.time Current animation time (in ticks, 4800 
ticks per second)

Integer No

Parameters
In addition to variables declared directly in the expression and Forest Packs built- in attributes, you can also create 
Parameters. These allow the user to control effects by editing values directly in the Effects rollout without needing 
to open the Effects Editor or understand the expression. Parameters are created using the Parameters Tab found 
on the left side of the effects editor. 
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There are 5 types available which you create by clicking on the corresponding button:

 Numeric Parameters. Adds a numeric spinner to the effects rollout. Number format can be set to real, 
integer, percentage (real), or scene units (real).

 Object Parameters. Adds an object picker to the effects rollout and allows you to access the selected object's 
position vector.

 Controller Parameters. Allow you to access the output from any controller in 3ds Max, picked from the 
effects rollout.

 Texture Parameters. Allow you to use the RGB values from a map, picked from the effects rollout.

 Curve Parameters. Allow you to use a curve to control values. The curve can be edited from the effects 
rollout.

Each parameter must be assigned a unique name which is used in the expression to call the parameter's value, the 
following restrictions apply:

Cannot be the same as an existing attribute, function, variable or parameter.
Must only consist of alpha-numeric symbols and underscores (_).
Cannot start with a number.
Cannot contain spaces.
Parameters are local to the Forest Object, this means you can use the same name in different objects 
without problems.

The procedures show below explain how to create and edit the five different parameter types.



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  136

1.
2.

3.
4.

5.

6.

7.

8.

Procedures

To create a Numeric Parameter

In the Effects rollout, click  to open the Effects Editor.
Select the Parameters tab in the Command List.

Click  to add a new Numeric Parameter.
In the Name box, assign the Parameter a unique variable name. This will be shown in the Effects rollout and 
is used in the expression to refer to the value it contains.
Use the Type dropdown to set the type of number from Integer, Real,  Percentage (real) and Scene Units 
(real).
Set a Default Value, this is the value that will be used when the effect is first loaded and applied, before the 
user has made any edits.
If necessary active Limits and enter a Minimum and Maximum value to constrain the parameter to within a 
range.
Optionally enter a Description explaining the parameter. This message will display when a user clicks the 

 button in the effects rollout.
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To edit a Numeric Parameter

Open the Effects rollout.
Select a Parameter from the list. 
Enter a new value.

To see a description of the parameter, click .
To deactivate an effect in the viewports, click the Apply only at rendertime checkbox. This can improve 
interactivity for complex effects.

To create an Object Parameter

In the Effects rollout, click  to open the Effects Editor.
Select the Parameters tab in the Command List.

Click   to add a new Object Parameter.
In the Name box, assign the Parameter a unique variable name. This will be shown in the Effects rollout and 
is used in the expression to refer to the value it contains.
Optionally enter a Description explaining the parameter. This message will display when a user clicks the 

 button in the effects rollout.
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To assigning an Object Parameter

Open the Effects rollout.
Select an Object Parameter from the list. 

Click on 
Pick an object from the scene. 

To remove the object from the Parameter, click 

To creating a Controller Parameter

In the Effects rollout, click  to open the Effects Editor.
Select the Parameters tab in the Command List.

Click   to add a new Controller Parameter.
In the Name box, assign the Parameter a unique variable name. This will be shown in the Effects rollout and 
is used in the expression to refer to the value it contains.
Use the Type dropdown to set the type of number from Integer, Real,  or Vector. Only tracks of the same type 
will be pickable from the Effects rollout.
Optionally enter a Description explaining the parameter. This message will display when a user clicks the 

 button in the effects rollout.
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To assign a Controller parameter

Open the Effects rollout.
Select a Controller parameter from the list. 

Click on 
The Track View Pick dialogue will open showing the scenes objects and their controllers. Controllers that are 
compatible with the parameter's type are selectable, incompatible tracks are greyed out. 

Select a compatible controller and click OK.

To create a Texture Parameter

In the Effects rollout, click   to open the Effects Editor.
Select the Parameters tab in the Command List.

Click   to add a new Texture Parameter.
In the Name box, assign the Parameter a unique variable name. This will be shown in the Effects rollout and 
is used in the expression to refer to the value it contains.
Optionally enter a Description explaining the parameter. This message will display when a user clicks the 

 button in the effects rollout.
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To assigning a Texture Parameter

Open the Effectsrollout and go to the Parameters list
Pick the Texture parameter
Click on the TexMap picker and select a texture, or drag a texture from the material editor to this slot. 
Use the Clear button to remove the existing Texture map. 
In the Effect you can use the following format to access the texture information:

evaluateTexture([parameter name], [UVW Coordinate]);

E.G.
vector tintColor = evaluateTexture(DisplacementMap,fpItem.distUVW);

To create a Curve Parameter

In the Effects rollout, click   to open the Effects Editor.
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Select the Parameters tab in the Command List.

Click   to add a new Curve Parameter.
In the Name box, assign the Parameter a unique variable name. This will be shown in the Effects rollout and 
is used in the expression to refer to the value it contains.
Optionally enter a Description explaining the parameter. This message will display when a user clicks the 

 button in the effects rollout.

To edit a Curve Parameter

Open the Effects rollout and go to the Parameters list
Pick the Curve parameter
Click on Edit Curve to open the curve editor
Forest Pack uses Max's default curve editor.
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Use: 
a - to move points
b - to scale points
c - to add points
d - to delete points
e - to reset curves
f - right click to change the curve type (choices include corner, bezier-smooth, and bezier-corner).
In the Effect you can use the following format to access the curve's output:

evaluateCurve([Curve name], [X Position]);

E.G.
fpItem.position.x = evaluateCurve(X_position,timePosition);

To delete a parameter

In the Effects rollout, click  to open the Effects Editor.
Select the Parameters tab in the Command List.
Select the parameter you wish to delete from the list.

Click 

To use a Parameter's value in an expression

Type the name of the parameter, case is ignored.
For vectors, append .x, .y, and .z to access the 3 components.

6.7.6 Effects Examples
Please find links to examples of effects below with accompanying .eff files and a list of the parameters, attributes 
and functions used.

Stepped Rotation
Lean out
Tint by Object
Tint by Boundary
Look At object with Falloff
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Look at Boundary with Falloff
Repulsion
Bend by Object
XY Local Translate
Cars along spline
Place items on a displaced surface

Stepped Rotation
Stepped rotation allows you to control the rotate the Z 
Rotation of forest items using a stepped increment. To 
use it:

Go to the Transform rollout and enable 
Rotation.
Enter a value for Z > Min and Z > Max as normal.
Go to the effects rollout and enter the stepped 
increment value in degrees for the parameter 
named Z_Rotate_Step. The objects will now 
only rotate using increments of this angle.

Effect Script:

You can find this Effect within the Forest Effects Library.

This Effect Uses:

Parameters

Z_Rotate_Step
Type: Real

Attributes

fpItem.randRotMin.z
Minimum Z rotation as 
set in the Transform 
rollout.
fpItem.randRotMax.z
Maximum Z rotation 
as set in the 
Transform rollout.
fpItem.rotation.z
Individual item's Z 
rotation.

Functions

Floor(p)
Lowers p to nearest whole number.
RandomInt(p,q)
Generate a random integer between p and q.
degToRad(p)
Converts degrees to radians. The opposite, 
radToDeg(p) is also possible.

real rotateRange = fpItem.randRotMax.z - fpItem.randRotMin.z;1
real stepsInRange = floor(rotateRange/Z_Rotate_Step);2
real ZRotation = randomInt(0,stepsInRange)*Z_Rotate_Step;3
fpItem.rotation.z = degtorad(ZRotation);4
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Lean out
The lean out expression rotates trees towards the 
nearest include spline boundary, to use it.

Create a Forest object with Splines defining the 
Include areas. Randomise rotation as you would 
Normally
Go to the Effects rollout and enter a value in 
Lean_Out_Amount. This will determine the 
angle of the lean effect
To adjust the distance from the boundary's edge 
that the lean out effect influences, edit the 
Lean_Out_Distance parameter.
Because the lean out rotation overwrites any 
randomised rotation use used in the transform 
rollout you can reintroduce to rotation variation 
using the RandomWiggle parameter.

Effect Script

You can find this Effect within the Forest Effects Library.

This Effect Uses:

Parameters

Lean_Out_Amount
Type: Real
Lean_Out_Distance
Type: Scene Units
RandomWiggle
Type: Real

Attributes

fpItem.areaIncNearest
Vector to nearest 
include area edge.
fpItem.areaIncDistance
Distance to nearest 
include area.

Functions

atan2(x,y)
Returns the principal value of the arc 
tangent of y/x, expressed in radians
degToRad(p)
Converts degrees to radians.
easeIn(x,x1,x2,y1,y2)
Returns an ease-in interpolation 

Sorry, the widget is not supported in 
this export.
But you can reach it using the 
following URL:

https://www.youtube.com/watch?
v=WCiQmqdo9ck

#Find vector to nearest border1
Vector vec1  =  fpItem.areaIncNearest- fpItem.position;2
#calculate lean angle3
real angle = atan2(vec1.x,vec1.y)-degtorad(90);4
 5
#calculate falloff6
real leanOutX = easeIN(fpItem.areaIncDistance,Lean_Out_Distance,
0,fpItem.rotation.x,sin(angle+degtorad(randomReal(-
randomWiggle,randomWiggle)))*Lean_Out_Amount);

7

real LeanOutY = easeIn(fpItem.areaIncDistance,Lean_Out_Distance,
0,fpItem.rotation.y,cos(angle+degtorad(randomReal(-
randomWiggle,randomWiggle)))*Lean_Out_Amount);

8

 9
#assign lean angles to forest item10
fpItem.rotation.x = leanOutX;11
fpItem.rotation.y = leanOuty;12

https://www.youtube.com/watch?v=WCiQmqdo9ck
https://www.youtube.com/watch?v=WCiQmqdo9ck
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fpItem.position
Position vector of 
individual fp Item.
fpItem.rotation.x
Individual item's X 
rotation.
fpItem.rotation.y
Individual item's Y 
rotation.

between y1 and y2. Returns y1 when x < 
x1

Tint by Object
Tint by Object allows you to control the tint of a Forest 
Colour map based on the item's distance from an 
object. To use it:

Make sure the source objects have a material 
that uses a Forest Colour map.
The Forest Colour map must have override 
turned Off in order to be controlled by an 
expression.
In the Materials rollout the Random Strength
value is still applicable - for the tint to work fully 
set the start and end to 100%. Use different 
values if you'd like to retain some 
randomisation.
Forest colour can be used as a sub-map. For 
example, the example code below is blending 
between black and white based on distance and 
the Forest colour map is then being used in the 
Mix Amount slot of a Mix map.
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Effect Script:

You can find this Effect within the Forest Effects Library.

This Effect Uses:

Parameters

lookAt
Type: Object
tintFalloff
Type: Scene 
Units

Attributes

fpItem.position
Minimum Z 
rotation as set in 
the Transform 
rollout.
fpItem.tintColor
Maximum Z 
rotation as set in 
the Transform 
rollout.

Functions

easeIn(x,x1,x2,y1,y2)
Returns an ease-in interpolation between y1 and y2. 
Returns y1 when x < x1.
length(v)
The length of v.

Tint by Boundary
Tint by Object allows you to control the tint of a Forest 
Colour map based on the item's distance from an 
include spline's boundary. To use it:

Make sure the source objects have a material 
that uses a Forest Colour map.
The Forest Colour map must have override 
turned Off in order to be controlled by an 
expression.
In the Materials rollout the Random Strength
value is still applicable - for the tint to work fully 
set the start and end to 100%. Use different 
values if you'd like to retain some 
randomisation.
Forest colour can be used as a sub-map. For 
example, the example code below is blending 
between black and white based on distance and 
the Forest colour map is then being used in the 

vector v = Lookat.Position - fpItem.Position;1
real tintStrength = easein(length(v),tintFalloff,0,0,1);2
fpItem.tintColor = [tintStrength,tintStrength,tintStrength];3
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Mix Amount slot of a Mix map.

Use the tintFalloff parameter to set the size of 
the falloff effect.

Effect Script:

You can find this Effect within the Forest Effects Library.

This Effect Uses:

Parameters

distanceToEdge
Type: Scene 
Units

Attributes

fpItem.position
Minimum Z rotation as 
set in the Transform 
rollout.
fpItem.areaIncNearest
Position of the nearest 
point of include areas 
(splines only).
fpItem.tintColor
Maximum Z rotation as 
set in the Transform 
rollout.

Functions

easeIn(x,x1,x2,y1,y2)
Returns an ease-in interpolation between y1 
and y2. Returns y1 when x < x1.
length(v)
The length of v.

vector v = fpItem.areaIncNearest - fpItem.Position;1
real tintStrength = easein(fpItem.areaIncDistance,DistanceToEdge,0,0,1);2
fpItem.tintColor = [tintStrength, tintStrength, tintStrength];3
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Look At object with Falloff
Look At object with Falloff allows you to rotate items to 
look at a specified object and additionally specify a 
falloff range so that only items within a certain radius of 
the object are affected. To use it.

Use the Effects > lookAt parameter to pick the 
look at target from the scene.
Use the Effects > falloffDistance parameter to 
specify the falloff for the look at effect.

Effect Script:

You can find this Effect within the Forest Effects Library.

This Effect Uses:

Parameters

falloffDistance
Type: Scene 
Units
lookAt
Type: Object

Attributes

fpItem.position
Minimum Z 
rotation as set in 
the Transform 
rollout.
fpItem.rotation.z
Rotation of Forest 
Item on Z axis in 
local coordinates.

Functions

easeIn(x,x1,x2,y1,y2)
Returns an ease-in interpolation between y1 and y2. 
Returns y1 when x < x1.
length(v)
The length of v.
atan2(x,y)
Returns the principal value of the arc tangent of y/x, 
expressed in radians

vector v = Lookat.Position - fpItem.Position;1
fpItem.rotation.z = easein(length(v),falloffDistance,0,fpItem.rotation.z, 
-atan2(v.x, v.y));

2
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Look at Boundary with Falloff
Look at Boundary with Falloff allows you to rotate items 
to look at the nearest Include spline's boundary edge 
with additional controls to  specify a falloff range so 
that only items within a certain distance of the edge are 
affected. To use it.

Make sure you use Splines as include areas (can 
be used in combination with surfaces).
Use the Effects > distanceToEdge parameter to 
specify the falloff for the look-at effect.

Effect Script:

You can find this Effect within the Forest Effects Library.

This Effect Uses:

Parameters

distanceToEdge
Type: Scene 
Units

Attributes

fpItem.position
Minimum Z rotation as 
set in the Transform 
rollout.
fpItem.areaIncNearest
Position of the nearest 
point of include areas 
(splines only)
fpItem.areaIncDistance
Distance to nearest 
include area
fpItem.rotation.z
Rotation of Forest Item 
on Z axis in local 
coordinates.

Functions

easeIn(x,x1,x2,y1,y2)
Returns an ease-in interpolation between y1 
and y2. Returns y1 when x < x1.
atan2(x,y)
Returns the principal value of the arc 
tangent of y/x, expressed in radians

vector v = fpItem.areaIncNearest - fpItem.Position;1
fpItem.rotation.z = easein(fpItem.areaIncDistance,DistanceToEdge,
0,fpItem.rotation.z, -atan2(v.x, v.y));

2
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Repulsion
Repulsion computes the distance in 2 dimensions to a 
given object and applies a "repel" effect according to 
the distance and strength paramters. Next, the item is 
projected onto the surface in its new position using the  
fpSurfaceHitZ function. To use it:

Use Object to pick an object from the scene that 
will repel forest items.
Use the Distance parameter to set falloff limits 
of the repulsion effect.
Use the Strength parameter to push scattered 
items away from the repulsion object.
Use the Controller property to pick a track from 
the scene that is added to the distance 
parameter to control the falloff limits. For 
example if you are using a ball to repel Forest 
items you could use the Radius controller to 
automatically adjust the falloff distance as the 
ball is re-sized.

Effect Script:

You can find this Effect within the Forest Effects Library.

This Effect Uses:

Parameters

Object
Type: Object
Distance
Type: Scene 
Units
Strength
Type: 
Percentage

Attributes

fpItem.position
Position of 
Forest Item in 
local 
coordinates
fpItem.geomID
Index in the 
Geometry List, 
starting at zero

Functions

easeOut(x,x1,x2,y1,y2)
Returns an ease-out interpolation between y1 and y2. 
Returns y2 when x > x2.
unit(v)
Returns a unit vector in the same direction as v.
length(v)
The length of v.
fpSurfaceHitZ(p)
Computes the projection of p onto the Forest surface (XY 
mode only). Returns z value.

Sorry, the widget is not supported in 
this export.
But you can reach it using the 
following URL:

https://www.youtube.com/watch?
v=ReAHoaA3xnY&feature=youtu.be

vector vec = [fpItem.position.x - Object.position.x, fpItem.position.y- 
Object.position.y, 0];

1

vector dir = unit(vec);2
real dist = length(vec);3
real dd = easeOut(dist, 0, (Distance+Controller)*5, 
(Distance+Controller)*2.5, 0) * Strength / 100;

4

vector displ = dir * dd;5
fpItem.position = fpItem.position + displ;6
fpItem.geomID = if(dd > 0,1, fpItem.geomID);7
fpItem.position.z =  fpSurfaceHitZ(fpItem.position);8

https://www.youtube.com/watch?v=ReAHoaA3xnY&feature=youtu.be
https://www.youtube.com/watch?v=ReAHoaA3xnY&feature=youtu.be
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Controller
Type: 
Controller

Bend by Object
Bend by Object allows you to change the angle of 
scattered items so that they rotate away or towards a 
selected object. It's ideal for illustrating objects 
interacting with grass or rugs with many other possible 
applications. To use it:

Use the Object property to select an object from 
the scene that will be used to affect the angle of 
scattered items.
Use leanOutAmount to change the amount 
objects will bend. Negative values lean away 
from the object and positive values lean towards 
the object. 
Use leanOutDistance to control the distance 
from the object that the angle change affects. 
The effect will falloff until it reaches this 
distance.
Use randomWiggle to add some rotation 
variation to the items that are affected by the 
bend effect.

Effect Script:

You can find this Effect within the Forest Effects Library.

Sorry, the widget is not supported in 
this export.
But you can reach it using the 
following URL:

https://www.youtube.com/watch?
v=DKqugZ27eTw

Vector vec1  =  object.position - fpItem.position;1
real angle = atan2(vec1.x,vec1.y)-degtorad(90);2
 3
real lengthVec = length(vec1);4
real leanOutX = easeIN( length(vec1),Lean_Out_Distance,
0,fpItem.rotation.x,sin(angle+degtorad(randomReal(-
randomWiggle,randomWiggle)))*Lean_Out_Amount);

5

real LeanOutY = easeIn( length(vec1),Lean_Out_Distance,
0,fpItem.rotation.y,cos(angle+degtorad(randomReal(-
randomWiggle,randomWiggle)))*Lean_Out_Amount);

6

 7
fpItem.rotation.x = leanOutX;8
fpItem.rotation.y = leanOuty;9

https://www.youtube.com/watch?v=DKqugZ27eTw
https://www.youtube.com/watch?v=DKqugZ27eTw
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This Effect Uses:

Parameters

Object
Type: Object
Lean_Out_Amount
Type: Real
Lean_Out_Distance
Type: Scene Units
RandomWiggle
Type: Real

Attributes

fpItem.areaIncNearest
Vector to nearest 
include area edge.
fpItem.areaIncDistance
Distance to nearest 
include area.
fpItem.position
Position vector of 
individual fp Item.
fpItem.rotation.x
Individual item's X 
rotation.
fpItem.rotation.y
Individual item's Y 
rotation.

Functions

length(v)
The length of v.
atan2(x,y)
Returns the principal value of the arc 
tangent of y/x, expressed in radians
degToRad(p)
Converts degrees to radians.
easeIn(x,x1,x2,y1,y2)
Returns an ease-in interpolation 
between y1 and y2. Returns y1 when x < 
x1

XY Local Translate
The translation controls found in the Transform rollout 
move each item on the world's XY axis. In contrast this 
effect allows you to randomly move the object along 
each individual item's local axis. It also works in scene 
units instead of as a percentage of the object's size. To 
use it:

Use xOffsetStart to set a minimum X translation 
value, in scene units.
Use xOffsetEnd to set a maximum X translation 
value, in scene units.
Use YOffsetStart to set a minimum Y translation 
value, in scene units.
Use YOffsetEnd to set a maximum Y translation 
value, in scene units.
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Effect Script:

You can find this Effect within the Forest Effects Library.

This Effect Uses:

Parameters

YOffsetStart
Type: Scene 
Units
YOffsetEnd
Type: Scene 
Units
YOffsetStart
Type: Scene 
Units
YOffsetEnd
Type: Scene 
Units

Attributes

fpItem.position
Position vector of 
individual fp Item.
fpItem.rotation.z
Individual item's 
Z rotation.

Functions

randomInt
Returns an integer random number in the range a,b
degToRad(p)
Converts degrees to radians.
cos(p)
Cosine of p (p expressed in radians)
sin(p)
Sine of p (p expressed in radians)

Cars along spline
We recently released a tutorial on how to use Forest 
Pack to scatter cars. In this we discussed the best way 
to place pivots and paths, and the final scene used 
splines that were placed through the centre of the car 
parks so that we could use the mirror and offset 
features to create parked cars facing in either direction.

You may however already have a spline at the top of the 
car park that you wish to re-use. Normally this would 
mean you couldn't mirror the car but with Forest Effects 
we can now easily extend the plugin to make this 
possible.

This Car Parking effect allows you to use a spline at the 
top or bottom of the parking bay and the vehicles are 
automatically offset along their length to fit into the 
space.  In addition it also randomises the car's position  
along it's local axis and add controls to make it easier to 
adjust the probability of spaces and choose which side 
of the spline the cars should be positioned on. You can 

real angle = fpItem.rotation.z;1
real randomOffsetX = randomInt(xoffsetStart,xoffsetEnd);2
real randomOffsetY = randomInt(YoffsetStart,YoffsetEnd);3
vector positionX = [cos(angle)*randomoffsetX, sin(angle)*randomoffsetX,0];4
vector positionY =  [cos(angle-degtorad(90))*(randomOffsetY), sin(angle-
degtorad(90))*(randomOffsetY),0];

5

fpItem.position = fpItem.position+positionX+PositionY;6

Sorry, the widget is not supported in 
this export.
But you can reach it using the 
following URL:

https://www.youtube.com/watch?
v=EXcCsHAJJZo&feature=youtu.be

https://www.youtube.com/watch?v=EXcCsHAJJZo&feature=youtu.be
https://www.youtube.com/watch?v=EXcCsHAJJZo&feature=youtu.be


Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  154

•

•

•

•

•

•

•

•

•

• •

also randomise the direction of the cars by rotating 
through 180 degrees instead of flipping the car which 
removed any issues of left and right hand drive cars and 
mirrored number plates and logos. To use it, set up the 
cars as described in the tutorial with the pivot in the 
centre of the car. Place the cars using Tree Editor > 
Creation Tools > Along a Path as normal and then 
adjust the following parameters:

Use switchSides to move all the cars from one 
side of the path to the other
Use emptySpaces to change the probability of 
empty parking spaces
Use randomiseParkDirection to randomise 
whether cars are parked bonnet of boot first in 
each space.
Use xOffsetStart to set a minimum X translation 
value, in scene units.
Use xOffsetEnd to set a maximum X translation 
value, in scene units.
Use YOffsetStart to set a minimum Y translation 
value, in scene units.
Use YOffsetEnd to set a maximum Y translation 
value, in scene units.

Effect Script:

You can find this Effect within the Forest Effects Library.

This Effect Uses:

Parameters

YOffsetStart
Type: Scene Units
YOffsetEnd
Type: Scene Units

Attributes

fpItem.position
Position vector of 
individual fp Item.

Functions

randomInt
Returns an integer random number 
in the range a,b

real angle = fpItem.rotation.z;1
fpItem.rotation.z =fpItem.rotation.z + 
if(randomInt(0,randomiseParkDirection)==1,degtorad(180),0);

2

real randomOffsetX = randomInt(xoffsetStart,xoffsetEnd);3
real randomOffsetY = randomInt(YoffsetStart,YoffsetEnd);4
vector position = [cos(angle)*(fpItem.collisionRadius+randomoffsetX), 
sin(angle)*(fpItem.collisionRadius+randomoffsetX),0];

5

position = position + [cos(angle-degtorad(90))*(randomOffsetY), sin(angle-
degtorad(90))*(randomOffsetY),0];

6

fpItem.position = if(switchSides==0,fpItem.position+position, 
fpItem.position-position);

7

int spaceProbability = randomInt(1,100);8
fpItem.visible = if(emptySpaces >= spaceProbability,0,1);9
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2.

3.

YOffsetStart
Type: Scene Units
YOffsetEnd
Type: Scene Units
switchSides 
Type: Int (0 is off, 1 is on)
emptySpaces 
Type: Int
randomiseParkDirection
Type: Int (0 is off, 1 is on)

fpItem.rotation.z
Individual item's Z 
rotation.
fpItem.visible
Individual item's 
visibility
fpItem.collisionRadius
The collision radius of 
the item. Measured as a 
sphere who's diameter 
matches the size of the 
object's largest 
dimension.

degToRad(p)
Converts degrees to radians.
cos(p)
Cosine of p (p expressed in radians)
sin(p)
Sine of p (p expressed in radians)

Place items on a displaced surface
If you use Displacement maps to create terrain, then 
this effect can help. It allows you to position the objects 
on the Z axis to match the displaced mesh with 
additional controls to randomise each item's position 
on the Z axis. To use it download and load items on 
displaced surface.eff and follow these steps:

Add item(s) in the Geometry rollout in the usual 
way. You can mix items of different heights.
Align Forest Pack with the displaced plane on 
the Z axis. 

In the Transform rollout, enter a value of 100%
for both the Z Min and Z Max parameters. 

https://docs.itoosoft.com/download/attachments/23003316/items%20on%20displaced%20surface.eff?api=v2&modificationDate=1473918081000&version=1
https://docs.itoosoft.com/download/attachments/23003316/items%20on%20displaced%20surface.eff?api=v2&modificationDate=1473918081000&version=1
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Activate Z > Map and Probability map.

Apply the displacement texture to the Map
input slot.
Feel free to add any Scale randomisation, the 
effect can compensate for differently sized 
items. 
In the Distribution rollout, set the Collision 
Height to 100%. Once the value has been 
changed, collisions can be turned off if you don't 
need them. 

Go to the Effects rollout and click 
DisplacementSize, select the Amount
controller of the V-Ray Displacement modifier 
(or other similar plugin) that is applied to the 
surface. The tree's Z position is now driven by 
this value, changing the parameter also 
automatically updates Forest Pack's 
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12.

distribution.

Use zRandMin and zRandMax to add additional 
Z position randomisation to the items after 
displacement.
Use AltitudeLimitTop to hide objects above a 
certain height.
Use AltitudeLimitBottom to hide objects below 
certain height.
Use topFalloff to gradually scale objects to 0 as 
they approach the height set in
AltitudeLimitTop.
Use bottomFalloff to gradually scale objects to 
0 as they approach the height set in
AltitudeLimitBottom.

This effect will not allow you to use the Slope
or Direction controls in the surface rollout.


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Effect Script:

You can find this Effect within the Forest Effects Library.

Sample scene: displacementEffect.max

This Effect Uses:

Parameters

DisplacementSize
Type: Scene Units
This reads the value 
of another controller 
in the scene. Use it to 
select the Amount 
parameter of a 
displacement 
modifier.
zRandMin
Type: Scene Units
zRandMax
Type: Scene Units
AltitudeLimitTop
Type: Scene Units
AltitudeLimitBottom
Type: Scene Units
topFalloff
Type: Scene Units

Attributes

fpItem.position
Position vector of 
individual fp Item.
fpItem.collisionHeight
The collision height of 
collision sphere for the 
current item.

Functions

randomReal(a,b)
Returns a real random number in the 
range a,b

#set position1
real actualHeight = (fpItem.collisionHeight/fpItem.scale.z)*1;2
real displacedPercentage = fpItem.position.z/actualHeight;3
fpItem.position.z =(displacedPercentage*DisplacementSize)
+randomReal(zRandMin, zRandMax);

4

 5
#Limit by altitude6
fpItem.visible = if(fpItem.position.z<AltitudeLimitTop,if(fpItem.position.
z>AltitudeLimitBottom,1,0),0);

7

 8
#Size by altitude9
vector falloffScale = if(fpItem.position.z>AltitudeLimitTop-topFalloff, 
((topFalloff-(fpItem.position.z-(AltitudeLimitTop-topFalloff)))/
topFalloff)*fpItem.scale,fpItem.scale);

10

fpItem.scale = falloffScale;11
 12
falloffScale = if(fpItem.position.z<AltitudeLimitBottom+BottomFalloff, 
(((fpItem.position.z-AltitudeLimitBottom))/
BottomFalloff)*fpItem.scale,fpItem.Scale);

13

fpItem.scale = falloffScale;14

https://docs.itoosoft.com/download/attachments/23003316/displacementEffect.max?api=v2&modificationDate=1473918081000&version=1
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• bottomFalloff
Type: Scene Units

6.8 Surface

6.8.1 Overview
In most Forest scenes, we will not be placing trees over planar surfaces, instead we have hills, mountains, etc. With 
this panel we can choose the surface that the trees will be placed over.
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6.8.2 Interface
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Surfaces List
In the Surfaces list we can choose the objects which represents the terrain. They 
must be a simple meshes (we cannot use groups, etc.), and the trees will be 
placed along the local  Z axis.

The "Add" button (   ) add a new surface to the list, and "Delete" (  ) 

removes the selected item.   Add multiple elements from a list of objects 
selected from the scene.

If we modify the terrain, the objects will not be adjusted automatically over the 

new surface, the user must press the   button to process the changes through 
Forest. This may be a limitation for scenes with animated terrain, but it's 
implemented this way because Forest builds an internal table with the terrain 
characteristics to optimize the speed of tree placement.

Anyway, this table is common for all Forest objects, so when we have used the 

same surface for several Forest objects it is only necessary to use the   button 
in one of them. All trees will be placed automatically. Use the 'Auto' checkbox if 
you need to update the surface automatically (this may add a performance hit for 
complex surfaces).
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Mode
Forest can use the surfaces in two modes of operation:

XY mode: the items are scattered using the XY plane of the Forest object (in local coordinates), and then 
placed on the surface moving each object along its Z axis. This mode is best suitable for smooth terrains and 
used by default when there is not a surface assigned, using the Area splines as boundaries.
UV mode: uses the mapping coordinates of the surface as alignment guide for the Distribution map. This 
mode is best used on rough terrains or to scatter items over convex 3D objects (as a sphere). Note that using 
this mode, the UV coordinates must be precisely defined to get a coherent result.

Note: Several Forest features are not available in UV mode: Area splines, Bitmap rotation, Dist.Map Channel (locked 
to 1) and "Link to Surface" on Custom Edit mode.

Randomize Stacked
By default Forest uses the XY position of each item to compute its random seed. If you scatter items that are aligned 
on the same XY coordinates (i.e. adding several stacked surfaces), all of them will share the same random 
properties.

Turning on this parameter will avoid this issue, generating different items on stacked surfaces. It is disabled by 
default, to keep compatibility with scenes created with previous Forest versions.

 
Scattering by UV coordinates

6.8.3 UV Transform
You can use the UV Transform parameters to modify the alignment and scale of the items according to the UV 
coordinates. These options are available only in the UV Surface mode.

6.8.4 Direction
Lets you to modify the direction of the items relative to the surface's normal: -100 (Down), 0 (aligned with the 
Normal), 100 (Up).
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Scale to fit sloped areas
When using sloped terrains on XY mode, this may do that not all trees be equally spaced. This effect is more 
noticiable in high density distributions (as grass fields). To fix it, you can use this option to scale the items's width 
proportionally to the surface's slope.

When "Scale to fit" is enabled, the Direction value is fixed to 0 (Normal aligned). This feature is not used on UV 
mode.

6.8.5 Altitude Range
These parameters define the altitude limits for tree placement. When the "Limited" checkbox is enabled, trees will 
only be created in the range specified by Top and Bottom.

The Fallof parameters allows us to define density and scale curves based in the item's altitude. The faloff scale is 
applied in the range defined by the Top and Bottom values.

6.8.6 Slope Angle Range
Limits the creation of trees over a range of slope terrain. 0 degrees is equal to a horizontal surface, and 90 degrees is 
a totally vertical surface.

6.8.7 Custom Edit Mode only
Since in Custom Edit mode must be possible to move each tree individually (including Z axis), these parameters 
defines how the trees are placed over the surface: automatically, if "Link to Surface" checkbox is enabled, or 
manually using the "Place Trees" button.

6.9 Item Editor
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4.
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6.9.1 Overview
To add scatter items Forest can work in two modes: Generate or Custom Edit. In Generate mode, items are created 
randomly within the regions defined in the Areas rollout according to the Distribution rules. The Custom Edit mode 
allow for a precise level of control, allowing you to edit and create individual items manually. A typical workflow 
might involve working between the two modes by creating an initial scatter of a large area of plants using Generate 
mode and then switching to Custom Edit to make final adjustments to individual objects to fine tune the 
composition. 

6.9.2 Procedures

To manually add individual scatter items
From the Tree Editor rollout, click Custom Edit. 

Enable the tree sub object level from the Modifier Stack Display or by clicking 
To determine which items to use from the Geometry list select one of the following modes. 

To use a specific model, click Model and select an item from the drop down list.
To use a random item from the Geometry list, click Random.
To use a sequence of items as defined in the Geometry list, Click Sequence.

Click Add.
Click in the scene to place a new item.
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To manually edit existing scattered items
From the Tree Editor rollout, click Custom Edit. 

Enable the tree sub object level from the Modifier Stack Display or by clicking  .
You can now select individual or groups of trees in the viewport. Edit them using the following methods:

Manipulate them with the translate,rotate and scale tools in the usual way.
Randomise geometry by clicking Randomise.
Randomise transforms by clicking Re-Seed.
Specify the geometry used from the items list by selecting an item from the geometry drop-down list

•

•

New items will be positioned at zero on the Z axis unless a Surface area is being used and the Link 
to Surface option is active in the Surfaces rollout.

Alternatively you can set 3DS Max's Grid and Snap settings to Face to click on any geometry to 
determine the Z position of a new item.


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To attach another Forest object

To attach a single Forest object

Click Attach > Single.
Click the Forest object to add from the viewport.

To attach multiple Forest objects

Click Attach > Multiple.
Select the Forest objects to add from the Attach List.
Click Attach. 

To detach selected items to a new Forest object
In Custom Edit mode, select the items to detach.
Click Detach. 
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6.9.3 Interface

Mode

Generate

In generate mode scattered items are placed within regions defined in the Geometry List according to rules defined 
in the Distribution rollout.
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Custom Edit

In custom edit mode, items can be created one at a time or distributing along paths or on the pivot points or faces 
of reference geometry. Once created, scattered objects can be edited manually using Max's default transform, 
rotate and scale tools.

When switching between Generate and Custom Edit mode, Forest Pack will always display a warning to ensure you 
don't accidentally lose any changes.

Generate →Tree Editor

Tree Editor → Generate

To edit the items, you must also activate the sub-object level using the Modify Stack Display on the Modify panel, or 

by clicking .

Add Items
This button creates individual items by clicking in the scene. To use is you must be at the Trees sub-object level.

There are three selectable modes, that work when adding individual items and using the Creation Tools (described 
below).

Selection. Uses the plant type defined in the Properties combo.
Random. Select a random plant from the Geometry List.
Sequence. Gets the plants models sequencially, as defined in the Geometry List.

Properties (Selection)
Lets you to change the type of plant (from the models defined in the Geometry List.) for the selected items.
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Sub Item

When using Groups as Custom Objects this value defines the index of the element inside the group.

Select By Type

Selects all the items that use the type defined in the selection combo box.

Randomize

Randomizes the plant type for all items selected.

Reset Size

Resets the scale of the items selected.

Re-Seed

Applies new random seeds to the selected item's transform setting. Use this option to re-randomize items that have 
been created by a copying process.

Store Transform

Stores the current random transformations into the items properties, and disables the randomness settings. Useful 
for attaching Forest objects but maintaining their original randomised transforms. 

Detach
Detaches the selected elements to a separate Forest object.

Attach
Attaches items from other Forest objects. You may select a single object or choose from a list.

Consolidate Geometry List

If enabled, the plugin will try to match the Geometry Lists using the Name property and the type of geometry. If not, 
Forest will append the items from the Geometry List of the attached object.

Creation Tools
These tools are used to automatically build elements inside a Forest object.

6.10 Camera

6.10.1 Overview
Top optimise your renders, Forest Pack can automatically remove items that are not visible to the camera. allowing 
you to create huge areas of vegetation while minimizing the number of scattered items.
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6.10.2 Interface

Area

Limit to visibility

Using this checkbox, we limit the items only to the areas covered by the camera's field of view.

In Forest Pack 7 and above, it is no longer necessary to manually select the camera used for culling. 
Instead Forest Pack will automatically uses the last camera view from the viewport or render. This does 
not include non-camera views such as perspective and orthographic cameras, if you switch to one of these 
views, then the last used camera view is retained. 


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Expand

Sometimes (in scenes with camera motion), it's possible that some items will appear or disappear "suddenly" from 
the edge of view because the vision limit is very narrow. With this parameter, we can widen the field of view. With a 
10% or 20% value, the effect is solved in most scenes.

Far Clipping Plane

This parameter limits the creation of items beyond a specified distance from the camera. This value is defined in 
scene's unit system.

Back Offset

Extends the creation of items behind the camera's position. Use it in combination with the "Expand" parameter, to 
fix the problem of items and shadows appearing suddenly from the edge of view.

Copy Parameters
Copy the current camera parameters to all Forest objects in the scene.

Look-At
When enabled, rotates the items to look at a specified object (the camera or other node from the scene). This option 
is commonly used for One-plane billboards, but it also works with Custom Objects.

LOD (Level of Detail)
When on Forest LOD objects added to the scatter are active. This features enables you to switch objects based on 
distance from the camera or by the size of the objects in the rendered view.

Override Max. Distance

If zero Forest uses the Maximum Distance value specified in the Forest LOD objects. If greater than zero, the value 
specified in Forest LOD objects are ignored and the value specified here is used.

Use Environment Range
When enabled, the maximum distance is derived from the Environment Range settings of the active camera.

Use Look - At Target
When enabled Forest uses the pivot point of the object assigned in the Look-At Target slot as the origin for the Max 
Distance measurements.  This enables you to separate the camera and origin used for all LOD calculations.

Density/Scale Falloff
Lets you to define density and scale curves for camera distance.

If "Use Environment Range" is on, the range values are taken from the Canera's environment range. This allows us 
to assign different ranges from each camera easily.

Be careful if you use falloffs with camera motion, because items may appear or disappear suddenly (the distance to 
camera changes when moving).



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  172

Density/Scale Falloff
Enable this option to preview Camera Culling in the viewport. This can cause slow viewport performance so it is 
disable by default.

6.11 Shadows

6.11.1 Overview
The Shadow rollout is used to define the shadow casting behaviour when using billboards. Most of these features 
are not applied with mesh trees.

Forest can use two types of shadows for the trees: XShadow and Raytrace.

XShadow must be used exclusively with the Scanline renderer, for other render engines as Mental Ray or VRay use 
the Raytrace mode.

In the Raytrace mode, Forest automatically builds some additional planes, one vertical and the other horizontal, 
which are used ONLY to project the shadows. By default, these planes are not visible in the viewport or rendering.

 Raytraced shadows requires Forest Material to work, because this plugin does the job of hiding or 
rendering the shadow / texture for each plane. Be sure that the material applied to the Forest object uses 
the "Forest Material" plugin as a base.


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6.11.2 Interface

Use Fake Shadows
This checkbox allows you to disable all XShadow and raytrace options, and cast 
standard shadows just as any other object in the scene.

XShadow / Raytrace

Vertical

When enabled, this option builds a vertical texture for the trees.

Horizontal

Same as the horizontal shadow. The shadow mask must be defined in the "Forest Material" plugin.

Z Offset

Adjusts the separation of the horizontal shadow from the base of the tree. The value is defined as a percent of the 
height of the tree. By default it is 5%, you may use higher values if the shadow is hidden by the terrain or the bias 
parameter in the light is too low.

Width Scale

Use this option to scale the horizontal shadow. A value of 100% will create a shadow of same size as the tree's 
width. Note: the horizontal shadows created by Forest are squared.
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Cast opacity mask for Custom Objects

By default, the plugin casts opacity masks only for trees created from templates. Enable this option to use also on 
"Custom Object" trees.

Raytrace

Pick/Clear

Assigns the light which casts the raytraced shadows. The shadow planes created by Forest will face this light 
automatically. "Clear" un-assigns it. Without a raytrace light assigned in this parameter, Forest doesn't build the 
shadow planes. The "Copy" buttons assigns the current Light to all Forest objects in the scene.

Hide Planes in viewport

By default the shadow planes are hidden, use this checkbox if you want to see these additional geometry in the 
viewports. This checkbox doesn't affect the visibility on the render; if a "Forest Material" is applied to Forest, the 
shadow planes are not visible but cast shadow. Without "Forest Material" the planes are visible and cast shadow 
(just as any other geometry in the scene).

Prevent Self-shadow

In Mental Ray and VRay, enable this checkbox to avoid that a tree cast the shadow over itself.

Every tree over itself

Defines how the self-shadowing detection is applied, to the full object (trees don't cast shadows to other trees on 
the same Forest object) or only each tree to itself.

{If you use Mental Ray, set Shadows Mode to "Simple" or "Sort", but not "Segments" (Render Setup -> Mental Ray 
Renderer> Renderer> Shadows & Displacement -> Shadows Mode). This mode is not supported by Forest.

If you use Mental Ray, set Shadows Mode to "Simple" or "Sort", but not "Segments" (Render Setup -> 
Mental Ray Renderer> Renderer> Shadows & Displacement -> Shadows Mode). This mode is not supported 
by Forest.


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6.12 Transform

6.12.1 Overview
In a natural distribution, trees have different orientations and sizes. With this rollout we can apply these variations 
to the elements.

6.12.2 Interface
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When enabled, this value defines a random translation of the tree object over its original position. The translation 
come defined as a percentage of the width of the tree for X/Y and height for Z.

Note: This translation is applied after placing the tree over its position (as indicated in distribution map), so it's 
possible if we apply a high random translation the tree will be placed outside the area spline. If this happens, we 
must lower the translation value or modify the area spline until trees are placed in a good position.

Rotation
These parameters apply a random rotation over each axis. The degree of rotation ranges from Min to Max values 
specified (from 0 to 359 degrees).

Note: the rotation is not applied if "facing camera" checkbox is enabled in the "Camera" rollout.

Scale
Use this option to apply a random scale for each tree. It's possible to define independent ranges for XYZ, and to lock 
the aspect ratio with the "Lock aspect ratio" option.

Probability Curves
Lets you to define the probability of each random value in the rotation range (X axis = Min/Max range, Y axis: 0-100% 
probability).

Rotating to discrete values of 0º, 90º, 270º using a Probability Curve
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Non-uniform scale distribution using a Probability Curve

Using Maps
The map parameter may be used to adjust the transform amounts using a texture map.

If the 'Color map' checkbox if off, the map is evaluated in monochrome mode, the white color is considered as the 
Max rotation value, and the black color as Min.

Turning on 'Color map', the RGB components of the image are used to define the scale for each axis, in this way: 
Red color-> X, Green color->Y, Blue color->Z.

If you have three monochrome scale maps, one for axis, it is easy to combine them in a unique RGB map using a 
Composite texture, in this way:
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Probability Map
Activating this option uses a map to define a probability amount for the random range defined by the Min/Max 
values. Scatter objects in black areas of the map will not be randomised, objects in white areas will receive a value 
selected from the full range.

Using a probability map to control scale randomisation. (black = no randomisation, white = full randomisation)

Mirroring
This option flips the tree horizontally, creating a mirror image. It is useful to increase the variation of the textures 
without using additional maps. By default, it's applied only to trees created from templates, enable the "Use on 
Custom Objects" checkbox to use on custom object trees as well.
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6.13 Material

6.13.1 Overview
Applies a random color tint to the items. There are two possible modes of operation, tint by gradient and tint by 
map. You can also use the settings in this rollout to colour correct all of the assets contained in a scatter from one 
easy-to-access location. 

6.13.2 Interface

Color Tint

Get Color from Gradient

You may define a Color Range by clicking in the colour boxes, and the Random 
Strength range determine the magnitude of tint applied, from 0 to 100%. Use 
Min=0 and Max=0 to disable the effect.
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Get Color from Map

Forest uses a custom map as tinting source. With "Random Values", a random pixel from the map is taken for each 
tree, and "As Texture" applies it as a standard Max texture.

By default, Forest uses the parameters defined in the Distribution Map rollout (X/Y, offset, rotation...) for scaling, but 
it's also possible to get the mapping coordinates from the surface, if there any assigned in the Surface rollout, and a 
value greater than zero is assigned to "Map Channel".

It is possible to customize the tinting options for each material using the "Override" option. See Forest 
Material and Forest Color reference for details.

Color Tint requires Forest Material or Forest Color to work. Be sure that the materials used in the Forest 
object (assigned in the Geometry rollout or applied directly to the object) use one of these plugins. "Forest 
Material" is a custom Material included with Forest Pack, and "Forest Color" is a 2D texture map. Without 
them, Color Tint won't work.



http://www.itoosoft.com/forestpack/reference/refdistmap.php
http://www.itoosoft.com/forestpack/reference/refsurface.php
http://www.itoosoft.com/forestpack/reference/mat.php
http://www.itoosoft.com/forestpack/reference/mat.php
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6.13.3 Color Correction

The Colour Correction settings allow you to modify the hue saturation and value all of the materials applied to 
objects in a scatter. It's designed to help artists adjust the look of their assets without the need to edit the materials 
directly which can be a fiddly and time consuming task. 

Apply to Hue Range
Enabling this option allows the artist to constrain the colour correct effect so that it operates only on the hue 
identified in the colour swatch. Generally this feature is used in conjunction with the Range Width setting . 

Range Width

Specifies a range either side of the selected Hue colour which will be affected by colour correction. 

Hue Shift
Adjusts the Hue of all maps from materials used in the scatter that are connected to a Forest Colour map



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  183

Saturation
Adjusts the Saturation of all maps from materials used in the scatter that are connected to a Forest Colour map

Brightness
Adjusts the Brightness of all maps from materials used in the scatter that are connected to a Forest Colour map.

Colour correction can be disabled for individual maps by disabling the  Apply Color Correction option in a 
Forest Color map


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6.13.4 Optimize Materials

This tool helps you to convert and optimize the materials used by Forest, selecting automatically the best settings 
for each renderer. It includes the following features:

Convert Standard Materials to VRay (VRayMtl) / Mental Ray ( Arch & Design), or Corona.
Apply Forest Color to the Diffuse maps.

You can optionally control the RGB level
If there are materials you do not wish to use a Forest colour map include their names here. For 
example it is often the case that you only want to randomise leaf colours not the trunk and branches. 
Separate material names with spaces.

Apply Forest Material (billboards only).
Disable filtering for Opacity Maps (recommended for leaves created using alphas).
Modify Custom Objects material. When this is on materials applied to custom objects as well as billboards 
will be optimised
Apply Forest Edge. Add Forest Edge maps to opacity slots to enable the object to function with Areas > Edge
mode. 
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6.14 Animation

6.14.1 Overview
The animation rollout provides a number of options to allow you to control animated scatter objects. By default 
animation is turned off so animated scatter objects will appear static, to use animation, choose from one of the 
following 4 methods.

Follow Geometry: All scattered instances animate in sync with the source geometry.
Random Samples: The starting frame of scattered instances is randomised from a fixed number of sample 
points along the timeline.
Random from Map: The starting frame of scattered instances is selected using a grayscale map from a fixed 
number of sample points along the timeline.
Frames from Map: The absolute frame of the scattered instance is controlled by a grayscale map.

See the Interface section below for a more detailed description of these modes.

Some renderers that use our custom interface are not currently compatible with the Disabled, Random 
Sample, Random From Map, and Frame from Map animation modes. This limitation affects V-Ray RT, 
Octane, Thea, Moskito, and Arion. Currently Forest Pack returns only a pointer to the custom object in 
the scene and a transformation matrix, so all items are pure instances of the original geometry and 
animation will be treated as though it is Follow Geometry mode.

To improve this behaviour we have included new functions to our API, and then all 3rd party renderers 
update their Forest Pack implementation using the new interface. 



http://docs.itoosoft.com/display/FORESTPACK/Animation#Animation-Interface
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6.14.2 Procedures

To sync animations
Add 1 or more animated scatter objects from the Add Geometry rollout.
From the Animation rollout, activate Follow Geometry.
To preview the results in the viewport, deselect Animate Only at Render Time.  

To create randomised animations
Add 1 or more animated scatter objects from the Add Geometry rollout.
From the Animation rollout, activate Random Samples.
Set the number of samples using the Count value. Higher numbers create a greater variation. 
Set the number of frames between each sample using the Time Offset parameter. Time Offset and Count 
work together, for example a time offset of 10 and count of 3 will randomly select between animation start 
points at frames 0, 10, and 20. 
To preview the results in the viewport, deselect Animate Only at Render Time.  

To control the starting frame of an animation using a map
Add 1 or more animated scatter objects from the Add Geometry rollout.
From the Animation rollout, activate Random From Map.
Set the number of samples using the Count value. Higher numbers create greater variation. 
Set the number of frames between each sample using the Time Offset parameter. Time Offset and Count 
work together, for example a time offset of 10 and count of 3 creates samples at frames 0, 10, and 20 that will 
be selected by the map. 

Click   in the map group to open the Map Browser and select a grayscale image or 
procedural map. Alternatively assign a map by dragging onto this button from the Material Editor.
To preview the results in the viewport, deselect Animate Only at Render Time.  

To control the absolute frame of an animation using map
Add 1 or more animated scatter objects from the Add Geometry rollout.
From the Animation rollout, activate Frame From Map.
Define the animation range to be controlled by the map by entering the appropriate frame numbers from 
the timeline in the Start and End value boxes. 

Click   in the map group to open the Map Browser and select an animated grayscale 
image or procedural map. Alternatively assign a map by dragging onto this button from the Material Editor.
To preview the results in the viewport, deselect Animate Only at Render Time.  
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6.14.3 Interface

Disabled
The plugin doesn't apply animation to the trees. All geometry, including templates 
and custom objects remain static.

Follow Geometry
Forest follows the mesh animation of the source trees (defined in the Geometry 
rollout), for each frame. If you use the built in billboard templates, only the "Low/
Medium/High Animated Planes" templates have animation applied. For "Custom 

Object" trees, the animation depends on the the selected objects.

Random Samples
Using this option, Forest takes several sample points along the timeline, and selects them randomly to set the 
starting point for the animation. The "Samples" parameters, defines the number of mesh samples, and "Time 
Offset", the difference in time between them, starting from time 0.

In this example, Count=4, Time Offset=10 (using frames as unit-time), will take four mesh samples at frames 0, 10, 20, 30.

Random from Map
This option works similar to Random Samples, but uses a grayscale map to select the sample point from which the 
animation will start.  The UV coordinates for the map are derived from the surface assigned in the Surfaces rollout.
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Following the above example of Count=4, Time Offset=10, a black pixel in the map will take an animation sample at frame 0, a white pixel at 

frame 30, and interpolated samples for pixels in the gray range.

Frame from Map
Using this option you can control the absolute frame of an animated object using a grayscale map. This map can 
then be animated to control the playback of the scattered objects. The animation range controlled by the map is 
defined using the Start and End parameters. 

In this example the Start is set to 0 and the End is set to 30. A black pixel on the map will set the object to frame 0 and a white pixel sets the 

object to frame 30. Other grayscale values  smoothly interpolate between these two frames.

6.15 Display

6.15.1 Overview

6.15.2 This rollout allows the user to define different levels of visualization for 
viewport and render modes.



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Plugin –  189

6.15.3 Interface

Display

Mesh/Adaptative/Proxy

These options allows Max to display the items using the original geometry or a 
proxy (Planes, Pyramid, Box, Thin Box, Plant). For proxy objects, it's possible to 
adjust the transparency and display them in wireframe mode.

The Adaptative option, automatically switches the display mode when the number of faces exceeds the specified 
value.
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Points Cloud

This is an ultra-fast view mode which lets you to see a 3D preview of plants on Viewport. Some of its features are:

Adjustable density of points, both to the local object of global to all Forest objects.
Color by ID or from Material. Forest gets the material color from the Diffuse slot.
See Random Tint colors in real-time.
Fake shading effect, to enhance 3D look. Adjust it using the Shade slider.

Display

Selects the size of points-cloud dot. Choices are small and large. This is a global setting that affects all Max scenes.

Max Items

Defines the maximum number of items drawn on screen. This is an approximated value, Forest adjusts the density 
of the distribution to not exceed this limit. Setting this value to 0 removes the limitation, but users should be careful 
if they use this option not to create huge amounts of geometry that could slow down or even crash Max.

Manual Update

Set the update mode of the selected Forest object: automatic or manual (clicking the Update button).

Disable Object

When enabled the object is disabled in the viewports and the render.

Freeze All

This option allows you to Freeze ALL Forest objects in the scene, except before rendering a frame. It is useful to 
reduce the load on 3D Studio when there are a lot of objects.

Render

Mesh/Adaptative/Proxy

These options allows Max to render the items using the original geometry or a proxy (Planes, Pyramid, Box, Thin 
Box, Plant).

Simplification Level

With "Simplification Level" we can reduce the number of items created by the plugin. With the 0 value, all trees are 
built, and with 1,2, etc., the number of trees is reduced progressively.

Normally, we leave the simplification level to 0 for normal render. Higher values are used to quickly reduce the final 
density of trees over the scene without changing the distribution map parameters.

Render Mode

This parameter defines the behaviour of Forest when it creates the elements for rendering. The possible values are 
"Automatic" and "Meshes".

In "Automatic" mode, the plugin uses all capabilities of the renderer to get the best results in complex scenes, 
creating automatically instances, meshes or proxies according to the type of objects defined in the Geometry 
rollout. Currently, this mode is used only in Mental Ray and VRay.
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In "Meshes" mode, Forest creates a single mesh containing all trees. This mode may useful, as instance, if you want 
to create a Forest object that uses another Forest as tree sample (this must use "Meshes" mode to work with MR/
VRay).

Max Items / Max Faces

Limits the maximum number of items or mesh's faces created by the plugin. The default value is 1000,000 objects 
and 5 million faces. When this limit is reached, the plugin builds an "F" icon instead of trees, and the Forest 
Stats window shows a warning message. Setting these values to 0 removes the limitation, but users should be 
careful if they use this option not to create huge amounts of geometry that could slow down or even crash Max.

Note: The "Max Faces" value is ignored in Mental Ray / VRay and "Automatic" mode, since these renderers are not 
limited by the number of faces when working on this mode.

Hide Custom Objects before rendering

If this option is on, the plugin hides from the render the objects assigned in the Geometry->Custom Object rollout. 
Use it to avoid rendering the high-poly meshes, proxies and other objects that are used only as source geometry for 
Forest.

http://www.itoosoft.com/forestpack/reference/refgeneral
http://www.itoosoft.com/forestpack/reference/refgeneral
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7 Forest Library
Library Browser
Editing a library
Integrating third-party libraries with Forest Pack
Installing The3dGarden plant collections

7.1 Library Browser

7.1.1 Overview
The library browser allows you to easily organise, access and share objects and presets that you use regularly. 
Forest Pack comes with an expanding range of objects including 2D Billboards, flower, grass and rock 3d models 
and grass, leaf and stone presets. Additional libraries from XFrog, Evermotion and HQ Plant can be purchased that 
integrate easily with the library browser, or custom libraries can be created from your own objects.

7.1.2 Procedures

To open the Library Browser
To access the library go to the Geometry rollout, select or add a geometry item and click on 
Properties>Library to open the Library Browser.

•

•

•

Object types

The library is able to store three types of object:

2D Billboards use bitmap textures stored in a material library. These are mapped to 2D planes 
generated automatically by the plugin. No geometry is stored in the external file

3D Objects use geometry stored in an external .max file. When used the object can be either 
XReferenced or merged into the current scene. Forest Pack will use the material assigned to the 
object in the original file unless specifically overridden.

Presets import complete Forest Pack objects, including any combination of Billboards and 3D 
objects plus all the rules that govern their distribution and appearance. Using presets allows you to 
quickly share and reuse complete styles without having to set the Forest Parameters for each use. 
Presets are simply created by referencing a completed Forest Object in an external .max file.


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To use a library object
Use the Tree Navigator to locate your library.

Select the library object you wish to use from Items Grid.

Either double click, right click and select use item, or click   to use.
Set area, distribution, transform and other settings as appropriate.

To use a preset
Use the Tree Navigator to select your presets library.
Select the preset you wish to use from the Items Grid.
Either double click, right click and select Use Item, or click Import Selected to use.
Most of the Forest Pack parameters will be imported, update the Area or Surfaces controls if required.

To manually choose a material for a renderer
Select the item you wish to use, note that not all library objects have multiple materials assigned.
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From the options bar at the bottom of the Library Browser, go to Materials > Using and select the renderer 
you wish to import a material for from the drop-down list.

Either double click, right click and select Use Item, or click Import Selected to use.

To merge the library object's geometry into the scene
Select the item you wish to use.
From the Options bar at the bottom of the library browser, change the 3D Objects Creation mode to Merge 
into Scene

 

7.1.3 Interface
The Library Browser is divided into three parts. On the left is the tree navigator, where you select, edit and open 
your libraries. These are organised into two types of folder. System folders, represented in blue, are the default 
libraries that come with Forest Pack. These are read-only and cannot be modified. Editable user folders are green 
and are where your custom libraries can be found. On the right is the Items grid, where the contents of the selected 
library are shown. Along the top is the toolbar, with several command buttons.
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Tree navigator
The tree is used to navigate, edit and select libraries. To use simply use the mouse or keyboard to expand folders 
and select libraries as you would in Windows Explorer, the following operations also apply:

To open a library: left click on it.

To move libraries: left click and drag to the new location.

To copy libraries: left click + CTRL key while dragging.

As mentioned system wide folders are read-only, if you wish to modify them, simply make a copy to a User's library 
folder. Libraries can be copied between computers or shared in a network.

Items grid
To choose an item, use the mouse or the arrow keys. The selected item is identified by a yellow border. To use the 
selected item in Forest Pack Plugin, press return, double click, right-click>use item, or press "Import Selected". To 
add multiple items at same time, select while pressing the SHIFT or CTRL key and press Enter

When using Billboards, each item has an associated Width, Height, Z Offset and Center Displacement values. To use 
these parameters in the Forest object, ensure the "Get Size from Library" checkbox in the Geometry panel is on.
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Options Bar
At the bottom of the screen are the options to control various aspects of how the library item is imported into the 
scene

Materials Using.

Library items can be configured to use a different materials dependant on renderer. This drop down list allows you 
to manually select which materials to import, or to let Forest Pack automatically select the best material for the 
current renderer, leave on automatic.

On Duplicate Material.

Determines what to do in the event that a material applied to an item shares a name with a material already in the 
scene. Options include using the scene material, replacing the scene material with the library material, or 
prompting a decision from the user for each item.

3D Objects Creation.

Defines how to import the geometry, the default option is to XRef to the library files but it is also possible to merge 
the original geometry into the scene.

Show Warnings.

Turns on/off any warning prompts related to these settings.

Toolbar

Icon Name Description

Previous folder Go to previous folder.

Next folder Go to next folder.

Up one level Go to parent folder.

Refresh view Forces the reload all folders, libraries and items from 
disk.

Ordering Choose to view items ordered in alphabet or inverse 
order.

Language Choose to view the common name or scientific names in 
the grid.

Zoom out Decrease size of thumbnail images.
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Icon Name Description

Zoom in Increase size of thumbnail images.

Zoom slider Click and drag right to increase size of thumbnail images 
and left to decrease size of thumbnail images.

Save changes Saves to disk the changes in current library.

Edit preferences Open the catalog preferences window.

Search Write text to filter items.

7.2 Editing a library

7.2.1 Overview
In addition to the tree libraries included with Forest Pack and a 
comprehensive range of Xfrog, Evermotion and HQ Plants 
expansions it is often desirable to create and edit custom 
libraries to re-use and share commonly used assets. The library 
browser allows you to easily organise and edit your libraries and 
create new 3d objects and billboards.

In this Section:

7.2.2 Procedures

To add and modify library locations

With the library editor open go to File>Preferences… or click the preferences button from the top toolbar.

•

•

User editable libraries are available to Forest 
Pack Pro users only.
Only user libraries are modifiable, to change the 
built in libraries they must be duplicated to a 
users location.



Forest Pack can access objects from a number of different libraries. These are located automatically from a 
list of folder paths defined in the preferences. Folders can be stored locally or in a shared network 
location.


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The Library Paths rollout shows a list of all the locations currently being used. To add a new location click 
on the Add button and navigate to the folder for your libraries.

In the Label field enter a location name to display in the tree navigator.
Click Use Path to add the location to the library and return to the preferences.

Click OK and you should now see all the sub folders and libraries displayed in the tree navigator on the left 
hand side of library browser.

Alternatively to modify or update an existing location:

With the library editor open go to File>Preferences or click from the top toolbar. Setting button.
To modify a location select it from the library paths list and click Modify.
Navigate to the root folder of the new location and select Use Path.

To organise and Create new libraries.
Each library location path can be further organised into subfolders. Forest Pack will scan these subfolders and 
replicate the directory tree in the tree navigator found on the left hand side of the library browser window. From 
this panel folders and libraries can be created and deleted using the procedures outline below, and the directory 
structure easily reorganised using drag and drop.

To create a subfolder:

With the Library Browser open, in the tree navigator on the left hand side, right click on a user library and 
select Create Folder.
A new folder has been created. The name will be highlighted, type in a new name for the folder.
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Alternatively to create the subfolders directly in Windows Explorer:

Navigate to the library location in Windows Explorer or locate it automatically using the Library Browser by 
right clicking its name from the tree navigator and selecting Open in Shell…
Create your directory structure in the usual way using Windows Explorer
When you are done, update the view in the Library Browser to reflect the new directory tree by clicking on 
the Refresh button (button image)from the top toolbar or select from the View menu.

 
The same directory showin in Windows Explorer and the Tree Navigator 

To create a new library:

When you create a library Forest Pack creates a new folder that includes an XML file and sub folders for thumbnails. 
This and any other sub folders found in the library location will not be displayed. This allows you to add additional 
directories for models, maps and materials used by the library without them cluttering up the tree navigator.

In the tree navigator, right click on the folder where you would like to save your new library and select Creat
e Library
The library name will be highlighted, enter a title and press return
If you need to rename your library at a later date, simply right click on it and select Rename.

To delete a library or folder

To delete a folder or library, simply right click and select Delete.

To add a new object or preset to a library from the scene
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It is possible to add selected objects from a scene directly to a library with just a few clicks. This can include Forest 
Pack object which will be added as a complete preset with their source objects. 

To add a new object or preset:

Select the objects you wish to add to the library
Open the Library Browser using the button on the Forest Toolbar 
Navigate to the library to which you wish to add the items
Right-click in the items list and select Import Objects.
A new dialog will open with a number of options. For the most part you won’t need to change much here and 
it’s pretty self explanatory, but let’s take a look at what each option does.
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Create 3DS Max Scene allows you to change the name of the Max file to store the new library objects. You 
can let FP automatically name files for you, or you can specify them manually. The browser cannot add 
objects to an existing file, so a new max file we be created each time you run the process, and you’ll be 
warned if you try to overwrite something
Create Material Library will save the materials assigned to the objects to a new material library. The 
materials in this library are assigned to the objects on import. we separate them in this way to allow users to 
have a different matlib for each renderer should they want it. If you choose a material library name that 
already exists, the new materials are appended to the existing file. This option allows you to overwrite the 
file instead.
Collect Assets moves all the external files referenced by the selected objects to a Maps folder in the library 
location. This will help to ensure that assets never go missing and can be found by Max.
Create Thumbnails allows you to create and assign a thumbnail captured from the viewport for each object.

Click Import. Wait a few seconds and the items will be added to the whole library

To add a new 3D object to a library from a file
3D geometry can be added to any library saved in a user location (represented in the tree navigator as a green 
folder). Items are stored in .max files located anywhere on your computer or network. However sharing is simplified 
if the files and any material libraries and bitmaps use relative paths and are located in the library folder. If images 
with the same name as the object are placed in the thumbnails folder, these will be used automatically.

To add a new 3d object:

From the navigator on the left, select a user's library.
Right click in the browser and select Create Item>3d Object
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A new blank 3d item will be created in the item browser. To edit, right click on the item and select Propertie
s…
Fill in the Taxonomy values, note that the common name is the text displayed by default in the library 
browser though this can be toggled to display the Latin name. Other values can be left blank if not required

Click on the folder item next to the Max File field to select the .max scene file that contains the new object
A list will open containing the objects in the scene, pick the item you wish to add to the library.

Adding grouped content

If an item is grouped instead of a single object its elements can automatically attached into one mesh 
upon import. To do this, when selecting your the item from the objects list, simply select select the group 
name containing the object's elements.


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If the object had a material applied this will be also be used in Forest Pack. It is also possible to override the 
material from an external material library. In order to do this enable the Override Material tick box.
Select the material library by clicking the folder icon next to the Mat. Library field. Find the library and 
click Open
Next click the Select Material button, this brings up a list of the contents of the material library. Highlight 
the material to be used and clickOK.
Add a thumbnail by clicking the image file button below the thumbnail preview window. Select an image 
file and click OK.
Click OK to accept the changes

Save the library by going to File>Save or selecting from the top toolbar.

To create a new preset
Creating a new preset is the same as creating a new 3d object, the only difference being that you select a pre-made 
Forest object in an external file instead of a mesh.

First prepare .max files, these will contain a separate Forest object for each preset. Configure the Forest 
object's parameters as you would normally including geometry, distribution, transforms, materials, diversity 
etc.
Save the max file to your Forest library folder, see below for more information on file structures.
Open the library browser and from the navigator on the left, select a user library.
Right click in the items grid and select Create Item>3d Object
A new blank Preset will be created in the item browser. To edit, right click on the item and select Properties
…
Fill in the Taxonomy values if required
Click on the folder icon next to the Max File field to select the .max scene file that contains the preset 
(created in step 1).
A list will open containing the objects in the scene, pick a Forest object that you wish to use as a preset. A 
single max file can contain multiple objects, geometry and presets that be combined in a single external file 
without problems.
Add a thumbnail by clicking the image file button below the thumbnail preview window. Select an image 
file and click OK.
Click OK to accept the changes

Save the library by going to File>Save… or selecting    from the top toolbar.
To use the preset, select in the same way as though it were a 3d object. See the Library Browser reference for 
more information.

•
•

Using nested forest objects

 From Forest Pack 5.0, presets can use nested Forest objects as items. In order for this to work the nested 
objects must adhere to the following restrictions:

Nested objects must use only area splines, not surfaces or exclusion objects.
There should be no duplicate names in custom objects or areas.


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1.
2.

3.
4.
5.

To add a new billboard object to a library
2D billboards can easily be added to a user's library. These are loaded from a material library file that can be saved 
anywhere on the local machine or network though for ease of sharing it is common to move the files to the library 
folder and use relative paths.

From the navigator on the left, select the library you wish to add a new object too.
Right click in the browser and select Create Item>Billboard

A new blank billboard item will be created, to edit it right click on the item and select Properties…
As above, fill in the Taxonomy values.
Choose the material library by clicking on the folder icon to the right of the Material Library field, select the 
library and then Open.
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6.

7.

8.

9.

Choose the material from the library by clicking on the Select Material button to bring up a list of the 
contents, select a material and click OK.

 
Add a thumbnail by clicking the image file button below the thumbnail preview window. Select an image 
file and click OK.
Set a Default Height and Width from the Dimensions settings. To retain the proportions of the image 
ensure Keep Aspect Ratio is turned on.

 
The center point for the rotation, scale and position can be adjusted using the Center 
Offset and ZOffset attributes, represented as a percentage. A dashed line on the thumbnail illustrates the 
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10.

1.
2.
3.

effect of these settings. Typically the lines should intersect at the base of a plant's trunk or stem.

 
Click OK to finish and save the library by going to File>Save Library or pressing F2

To adding multiple 3D objects to a library
The library editor can speed up the creation of libraries by loading multiple objects from a single scene file

Open the Library Browser and use the tree navigator to locate the library you wish to add items to.
Right click anywhere in the items grid and select Import Objects…
An Import From Scene window will open, select the .max file containing the objects by clicking on the 
ellipsis (…), locating the files and clicking Open.

Prerequisites

To automatically create thumbnails, preview images that share the same name as the scene objects 
should be moved to the thumbnails folder.



Adding objects from multiple .max files
It is possible to import objects from multiple source files. To do this, you just  select additional .max 
files while holding down CTRL or SHIFT.


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4.

5.

6.

•

1.
2.

You will now see a list of all the objects in the scene. Select the items you wish to add to the library. Use 
control and shift to select multiple objects in the usual way.

Click import. If bitmaps are located in the thumnbnails folder with the same name as the items being loaded, 
these will be used as previews in the item browser.
If necessary edit the objects as described above.

Adding Multiple Billboards to the Library
The library editor can greatly speed up the creation of libraries by loading multiple billboards contained within a 
single material (.mat) file. When creating libraries using this process thumbnails can be generated automatically 
and materials can remain in the original location or be consolidated into a single material file in the library folder.

Prerequisites:

A single .mat file containing multiple billboard materials.

To add multiple billboards:

Open the Library Browser and use the tree navigator to locate the library you wish to add items to.
Right click anywhere in the items grid and select Import Billboards…
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3.

4.

5.

The Material Importer will open. Select a material library by clicking on the ellipsis under the Source 
section. Locate a material library and click open. Highlight the billboards you wish to import.

Under the Catalog Location section tick the desired options:

Create Items in Forest Catalog adds the selected materials as billboards to the active library
Create Thumbnail Images automatically generates thumbnails from the diffuse maps of the selected 
materials
Create Material Library consolidates the selected materials into a single material library located in the 
library folder. There is also an option to automatically convert them to Forest Materials.

The default settings are generally OK.
Click Import and the materials will be added to the library.

To add a macro to assign a material according to the active renderer
When creating libraries it is possible to use macros to add variables to an item's property fields. This is very useful 
for creating flexible libraries that can dynamically respond to individual installations or changeable 3DS Max 
settings. One common usage is the creation of library items that automatically load appropriate materials based on 
the active renderer.
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1.
2.

3.

4.

5.

6.

Auto-loading a material library by renderer:

Either create a new object as described above, or right click and select Properties to edit an existing item.
Turn on Override Material, this allows you to use a separate material library to texture the object. In this 
example it will automatically select a different material library according to the current renderer.
In the Max File field type the parts of your material library name that is common to all files. In the examples 
given above you would type MaterialLibraryName-.mat
Position the cursor where you want to add the renderer variable, in this case it would after MaterialLibrary
Name- and before .mat
Click on Macros… and select hdfreerenderer from the subsequent list. Click OK to add the variable to the 
filename. The material filename should now read MaterialLibraryName-$(HDFREERENDERER).mat.

Select an appropriate material by clicking the select material button and picking one from the list. If the 
materials are identically named in each library, this macro will change the material depending on the 
currently selected renderer.

7.2.3 Interface

Library Browser Preferences

To access the Library Browsers go to File>Preferences or click  from the toolbar 

•

•

•

•

Prerequisistes

Items are created in the usual way but materials are taken from a separate material library. In this 
example we assume three libraries, one for each of the three supported renderers: Mental Ray, V-
Ray, and scanline.
Each material library's name should have two sections, one part that will be identical for all three 
files and a second part that matches the variable names assigned by Forest Pack's macro. 
[libraryName][macroValue].mat
Forest Pack uses "mental", "vray", and "standard" as values for the renderer macro. The following 
three file names demonstrate appropriate file names. 
MaterialLibraryName-mental.mat
MaterialLibraryName-vray.mat
MaterialLibraryName-standard.mat
The actual materials contained in each library should have identical names irrespective of the 
render. This allows you to dynamically switch between materials by automatically loading a 
different library for each renderer.


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Name Description

Use scene material When selected in the event of a a duplicate material the version 
already in the scene will be used

Replace material from library When selected in the event of a a duplicate material the version 
in the library will be used

Ask user When selected in the event of a a duplicate material the which 
of the two options above should be used

Merge into scene When adding objects the geometry will be merged into the 
scene.

XRef to library When adding objects the geometry remains in a external file 
and is XRef is used to add to the scene

Add... Adds a new library location.

Modify... Modifies the location of an existing library.
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Name Description

Delete Deletes a library location.

Evaluate Shows the currect values for all macros.

Folder and Library Addition
Use the context menu accessible by right clicking in the tree navigator to create new sub folders and libraries, and 
reorganise your directory using the mouse to drag and drop folders and libraries. 

Commands available in the tree navigator context menu :

Name Description

Open in Shell Opens the file location of the library 
in Windows Explorer.

Create Library Creates a folder with and a new 
"index.xml" file.

Create Folder Creates an empty folder on the disk.

Rename Renames a Folder or Library.

Delete Deletes a Folder or Library with all 
its contents. Use with caution !

Item Addition
To access the commands to edit a library's content, right click anywhere in the item grid. Note that changes are only 
stored in the system memory until the library is saved to disk.

Commands available in the item context menu :

Name Description

Use Item(s) Adds the selected item to Forest's 
geometry list..

Properties Shows the Item Settings dialog box.

Delete Delete the selected item.

Create Item Creates either a billboard or 3d object

http://www.itoosoft.com/forestpack/reference/library_editor.php#item_properties
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Name Description

Import Materials Loads multiple billboads from a .mat material library Material 
Importer.

Import Objects Loads multiple 3d objects from a .max scene file Object Importer.

Item Settings, Billboards
This window is used to set the properties for a billboard item. The Forest plugin uses this settings to construct the 
plant object, most of them match properties in the plugin Geometry panel.

 Settings available for items :

Name
Description

Scientific name Latin plant name.

http://www.itoosoft.com/forestpack/reference/library_editor.php#import
http://www.itoosoft.com/forestpack/reference/library_editor.php#import
http://www.itoosoft.com/forestpack/reference/library_editor.php#import
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Name
Description

Common name Common plant name.

Family Botanical family of plant.

Description Textual description about the plant.

Geometry 3D Geometry applied to the plant when is generated. Choose one 
of the general Forest geometry templates.

Material library 3DS Material library for material.

Material name Name of the material to apply. Choose one of the materials in the 
selected material library.

Width Width of the tree object in world units.

Height Height of the tree object in world units.

Keep aspect ratio Keep the width/height of the object synchronized with map 
aspect ratio.

Center Offset Center of rotation for the object in % of width.

ZOffset Elevation offset from the floor level.

Thumbnail Preview image of object, represented with the same aspect ratio 
as real object.

Thumbnail Selector button Press this button to change the thumbnail image.

Item Settings, 3D Objects
This window is used to set the properties for a 3d object item. The Forest plugin uses this settings to construct the 
plant object, most of them match properties in the plugin Geometry panel.

http://www.itoosoft.com/forestpack/reference/refgeometry
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Settings available for items :

Name Description

Scientific name Latin plant name.

Common name Common plant name.

Family Botanical family of plant.

Description Textual description about the plant.

Max File The location of the scene file contatining the item geometry

Object The name of the object in the scene file.

Override material When on the object uses a material from a separate material 
library.

Mat. Library The location of the material library

Material The name of the material to be used if override is on.

Thumbnail Preview image of object, represented with the same aspect ratio 
as real object.

Thumbnail Selector button Press this button to change the thumbnail image.

The settings are similar as for billboards, however instead loading a material we supply a 3dsmax scene with a 
object name. Optionally is possible to set a material override. The loading process can be done merging or XREF the 
object into our scene.

Material Importer
If you have a 3DS material library with tree materials and textures, you can import them directly into a Forest 
Library as billboards using this window. Forest and Planes Materials are recognized in the process and their 
properties (such as plane size or offsets) are copied to the new items.
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Name Description

Mat. Library Used to select a material library to import billboard materials 
from.

Create items in Forest Catalog When activated adds the selected materials to the current 
library.

Create thumbnail images When activated automatically generates thumbnail images and 
saves them to the thumbnails folder.

Create material library When activated adds and consolidates the selected materials to 
a new material library.

Create as Forest Materials Saves new billboards as Forest Materials.

Object Importer
As for materials, you can import a whole directory of 3DS Max objects into a library automatically.
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Name Description

From Scene Used to select a Max 
scene to import 
geometry.

Object list Lists all the objects found 
in the selected scene.

All Selects all objects.

None Deselects all objects.

Invert Inverts the current 
selection.

Adding objects from multiple .max files

It is possible to import objects from multiple source files. To do this, you just  select additional .max files 
while holding down CTRL or SHIFT.


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File Structure

A library is a special folder on the disk which contains an index.xml file, 
where the items are listed. This file points to the files necesary to define a 
library item. The browser stops to scan directories when an index.xml file is 
found, so a library folder can't contain other libraries and all subfolders are 
hidden in the interface, this permits to you to organize the data in several 
subfolders.
Each library item points to a single template object in a .max file or to a 
material in a .mat file. Each time you select a library item, all settings in the 
template object are loaded and applied to the current Forest object. You can 
group several objects in a single file, or have separate files for each one. You 
can also use macro substituion (see section below) to use conditions or 
complex structures.

Each library item also has an associated image file, typically stored in the thu
mbnails folder. This image is used to show the image preview in the library 
and you should have one image for each library item. If you name the files 
using the same name of the object, the image is automatically selected in the 
editor.

Additionally, you can have materials libraries to override the object's 
default material. This way you can have several library items with the same geometric base, but with different 
materials and textures.

Macros
In some fields, such as filenames and object or material names, you can use macro sustituions to add more 
flexibility to your library structures. These macros represent the library root location, current folder, or 3dsmax 
state values. The macros are instanced using the $(NAME) format.

To open the Insert Macro window, press the Macros... button in the properties window, select a macro and click 
OK, the selected macro will be inserted in the current field of the properties.

 

7.3 Integrating third-party libraries with Forest Pack
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•

•

•
•

•

•

•

 

7.3.1 Overview
Users expect that libraries sold through our store should be integrated with the Forest Pack library. This will allow 
them to quickly preview and load assets directly inside Forest Pack with materials automatically applied to match 
their current renderer..

In the case of ground cover assets like grass, rather than provide individual models we prefer to create presets with 
key Forest Pack settings already applied. You can find out more about this in our Creating Presets tutorial.

7.3.2 General rules:
Each item should use just one material. It could be a "consolidated" Multi/Sub-Object material containing 
materials for the current renderer. Then by using a macro, user can choose from several material libraries 
upon renderer used in the scene.
Materials should be stripped from the objects in the Max file, or replaced with Standard materials. This is to 
avoid problems with users getting messages about missing maps and shaders. 
Each item must have an unique name - in case of variations numbering should be used.
Do not use Proxy objects with the Forest Pack library. It increases file sizes by requiring a separate file for 
each renderer and there is very little performance advantage in using Proxies with Forest Pack.
Each asset in the library needs its own thumbnail, rendered in a square 1:1 aspect ratio no smaller than 800 x 
800 and ideally 1024 x 1024. This should be on a simple light background similar to the one shown below. If 
you like we have a template file for this that we can provide.

Where possible use standardised specular and glossiness PBR workflows, this will allow us and our users to 
easily create additional materials to support new renderers with relatively predictable results. 
Plant information and descriptions are need for each asset. Naming is important. We believe we should try 
to be as specific as possible about the species of plant or tree. A short description of each plant can also be 
included in the library XML. For multiple versions of the same plant, this can simply be duplicated. The asset 
names, descriptions and thumbnails are also used to automatically populate an online catalogue. 

https://www.itoosoft.com/tutorials/creating-libraries
https://www.allegorithmic.com/pbr-guide
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•

•
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Where possible add Forest Colour maps to add texture and/or tint variety to your objects. Users expect that 
libraries provided for use with Forest Pack make full use of its features. 
Where possible it is better to use leaf geometry than opacity maps which can have a negative impact on 
render times. For some very large trees or for leaves that have complex leaf shapes we understand it may 
not always be necessary.
Keep polygon counts reasonable. It's impossible to give an exact figure because it depends on the size and 
complexity of the tree/plant, but for a large tree up to 2 million should be OK. Less if possible and only go 
higher than this if absolutely necessary. 

7.3.3 Creating the Library
Forest Pack’s Library Browser needs to have a folder structure with an index.xml file (storing all library information 
needed) and a set of thumbnail images, that are be stored in thumbnails folder (containing thumbnail images) or in 
the same path as object files.

Additionally, it’s recommended to have a <library name>.ms maxscript file handling any function needed by the 
library, like getRenderer for detecting the current renderer, custom actions etc...

File Names and directory structure
Items can share maps and materials, all necessary maps and material libraries should be stored in separate 
directories, as follows:

\objects\<plant_name>.max (one mesh object per file, same name as filename)
\thumbnails\<plant_name>.jpg
\maps\<mapname>.jpg
\matlibs\scanline.mat
\matlibs\mentalray.mat
\matlibs\vray.mat

If possible, please add a “fp_” to the start of all files and names of objects. It makes it easier for users to identify the 
origins of the files. For maps use the following formula:

fp_assetname_<maptype>.jpg

For example an asset named daffodil1 might have these assets

fp_daffodil1_diffuse.jpg
fp_daffodil1_glossiness.jpg
fp_daffodil1_normal.jpg
fp_daffodil1_translucence.jpg
fp_daffodil1_opacity.jpg

This also makes it simpler for us to recreate materials for other renderers and opens the option to automate the 
process further down the line, similar to the approach used by Quixel.

Index.xml structure:
 

http://docs.itoosoft.com/display/FORESTPACK/Library+Browser
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Header

The Header part is used to assign correct materials to selected item by calling the getRenderer() function defined in 
the forestlib.ms maxscript file (or in the <product name>catalog.ms) to evaluate the currently used renderer in the 
scene.

In any case (using the default forestlib.ms or custom <product name>catalog.ms), the macro name needs to be set 
up properly by setmacro="<product name>RENDERER"> and needs to be different from default 
setmacro="RENDERER"> to avoid any error possible error messages.

 

Item

    <item class="maxobject">
        <name lang="english">Latin plant name</name>
        <name lang="latin">Common plant name</name>
        <family>Botanical family of plant</family>
        <description>Textual description about the plant</description>
        <bitmap>\thumbnails\<plant_name>.jpg</bitmap>
        <maxfile>\objects\<plant_name>.max</maxfile>
        <object><plant_name></object>
        <matlib>\matlibs\$(<product name>RENDERER).mat</matlib>
        <material><plant_material></material>
    </item>

The path to any models / textures could be also handled in two ways:

Relative to the location of XML file:

        <maxfile>objects\_fp_<plant_name>.max</maxfile>

Reference by macros:

        <maxfile>$(<product name>_PATH)\objects\_fp_<plant_name>.max</maxfile>

<?xml version="1.0"?>1
<library version="100" order="1">2
    <select class="material" setmacro="<product name>RENDERER">3
        <option value="@forestlib.ms:getRenderer()" default="1">Automatic 
Selector</option>

4

        <option value="standard">Standard</option>5
        <option value="mental">MentalRay</option>6
        <option value="vray">VRay</option>     7
    </select>8

http://forestlib.ms
http://catalog.ms
http://forestlib.ms
http://catalog.ms
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The use of macros for mapping files is not mandatory, however this mechanism is useful for point to models stored 
in another location, or add variations to the library (by renderer, season or other criterias).

Library Installation
Note: If you are producing libraries to be branded as iToo products, you can ignore this section.

The Library Paths section of Forest Pack's Library Browser holds the location of the different libraries. The user can 
add their manually their own libraries under File - Preferences ... Library Paths section and by Add... the path where 
the .xml files are stored. This values are stored in the user’s registry:

[HKEY_CURRENT_USER\Software\Itoo Software\Forest Pack Pro\LibraryDir]

Also, it could be defined globally in following system registry key by any third-party installer:

[HKEY_LOCAL_MACHINE\Software\Itoo Software\Forest Pack Pro\LibraryDir]

Each library vendor is responsible to install, manage and reference all their objects and files. Although custom 
automation is possible via the .ms, the library doesn’t copy or move any file from their original locations. 

Library Macros
The Library Macros are the mechanism to store and automate elements in the library. The library macros are stored 
in the registry in the following locations:

Macros modifiable by maxscript and stored in the user’s profile:

[HKEY_CURRENT_USER\Software\Itoo Software\Forest Pack Pro\LibraryMacros]

Macros defined globally by any third-party installer:

[HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\RailClone Pro\LibraryMacros]

The content of the macro can be any free text, when applied to any of the maxfile, object, matlib or material fields, 
the text is substituted and applied to the item. Additionally, it’s possible to get the macro value from maxscript, 
using the following format:

@<library name>.ms:<maxscript call>

For example

@hqcatalog.ms:getHDFlowerRenderer()
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Where the function asks 3dsmax for the current renderer and returns the appropriate prefix to modify the file or 
object paths. The .ms file must be located in the same path as .xml file.

Macros selectors

For values that can be selected dynamically by user, is possible to show a combo box handled by the library code. 
This option allows to change macros values without the need of programming additional code:

Currently only combo for material selection is allowed, however could be possible to add more combo boxes in the 
future.

   <select class="material" setmacro="<product name>RENDERER">1
        <option value="@forestlib.ms:getRenderer()" default="1">Automatic 
Selector</option>

2

        <option value="standard">Standard</option>3
        <option value="mental">MentalRay</option>4
        <option value="vray">VRay</option>     5
   </select>6
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Library examples:

Simple library without macros:
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Index.xml:

Library with auto-shader selections:

<?xml version="1.0"?>1
<library version="100" order="1">    2
    <item class="maxobject">3
        <name lang="english">English Oak</name>4
        <name lang="latin">Querqus robur</name>5
        <family>Fagaceae</family>6
        <description>Quercus robur is commonly known as the English oak or 
pedunculate oak or French oak. 

7

        It is native to most of Europe, and to Anatolia to the Caucasus, 
and also to parts of North Africa.</description>

8

        <bitmap>_fp_English Oak01.jpg</bitmap>9
        <maxfile>objects\_fp_English Oak01.max</maxfile>10
        <object>_fp_English Oak01</object>11
    </item>    12
    <item class="maxobject">13
        <name lang="english">Holm Oak</name>14
        <name lang="latin">Quercus Ilex</name>15
        <family>Fagaceae</family>16
        <description>Quercus ilex, the evergreen oak, holm oak, or holly 
oak is a large evergreen oak native to the Mediterranean region. 

17

        It takes its name from holm, an ancient name for holly. It is a 
member of the white oak section of the genus, 

18

        with acorns that mature in a single summer.</description>19
        <bitmap>_fp_Holm Oak01.jpg</bitmap>20
        <maxfile>objects\_fp_Holm Oak01.max</maxfile>21
        <object>_fp_Holm Oak01</object>     22
    </item>    23
    <item class="maxobject">24
        <name lang="english">Silver Maple</name>25
        <name lang="latin">Acer saccharinum</name>26
        <family>Sapindaceae</family>27
        <description>Acer saccharinum, commonly known as silver maple, 
creek maple, silverleaf maple, 

28

        soft maple, water maple, swamp maple, or white maple — is a 
species of maple native to eastern 

29

        North America in the eastern United States and Canada. It is one 
of the most common trees in the United States.</description>

30

        <bitmap>_fp_Silver Maple01.jpg</bitmap>31
        <maxfile>objects\_fp_Silver Maple01.max</maxfile>32
        <object>_fp_Silver Maple01</object>33
    </item>    34
</library>35
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Index.xml:

 1
<?xml version="1.0"?>2
<library version="100" order="1">3
    <select class="material" setmacro="RENDERER">4
        <option value="@forestlib.ms:getRenderer()" default="1">Automatic 
Selector</option>

5

        <option value="scanline">Standard</option>6
        <option value="mentalray">MentalRay</option>7
    <option value="vray">VRay</option>     8
   </select>9
    <item class="maxobject">10
        <name lang="english">English Oak</name>11
        <name lang="latin">Querqus robur</name>12
        <family>Fagaceae</family>13
        <description>Quercus robur is commonly known as the English oak or 
pedunculate oak or French oak. 

14

        It is native to most of Europe, and to Anatolia to the Caucasus, 
and also to parts of North Africa.</description>

15

        <bitmap>_fp_English Oak01.jpg</bitmap>16
        <maxfile>objects\_fp_English Oak01.max</maxfile>17
        <object>_fp_English Oak01</object>18
        <matlib>matlibs\$(RENDERER).mat</matlib>19
        <material>_fp_English Oak</material>20
    </item>    21
    <item class="maxobject">22
        <name lang="english">Holm Oak</name>23
        <name lang="latin">Quercus Ilex</name>24
        <family>Fagaceae</family>25
        <description>Quercus ilex, the evergreen oak, holm oak, or holly 
oak is a large evergreen oak native to the Mediterranean region. 

26

        It takes its name from holm, an ancient name for holly. It is a 
member of the white oak section of the genus, 

27

        with acorns that mature in a single summer.</description>28
        <bitmap>_fp_Holm Oak01.jpg</bitmap>29
        <maxfile>objects\_fp_Holm Oak01.max</maxfile>30
        <object>_fp_Holm Oak01</object>31
        <matlib>matlibs\$(RENDERER).mat</matlib>32
        <material>_fp_Holm Oak01</material>33
    </item>    34
   <item class="maxobject">35
        <name lang="english">Silver Maple</name>36
        <name lang="latin">Acer saccharinum</name>37
        <family>Sapindaceae</family>38
        <description>Acer saccharinum, commonly known as silver maple, 
creek maple, 

39

        silverleaf maple, soft maple, water maple, swamp maple, or white 
maple — is a species of maple native to eastern 

40

        North America in the eastern United States and Canada. 41
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        It is one of the most common trees in the United States.</
description>

42

        <bitmap>_fp_Silver Maple01.jpg</bitmap>43
        <maxfile>objects\_fp_Silver Maple01.max</maxfile>44
        <object>_fp_Silver Maple01</object>45
        <matlib>matlibs\$(RENDERER).mat</matlib>46
        <material>_fp_Silver Maple01</material>47
    </item>    48
</library>49
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Custom actions (open website):
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Index.xml:

<?xml version="1.0"?>1
<library version="100" order="1">2
    <maxscript file="CustomActionsLibrary.ms" script='onLibOpen 
"CustomAction1";' execute_on="lib_open"/>

3

    <maxscript file="CustomActionsLibrary.ms" script='onItemSelect 
"CustomAction2";' execute_on="item_select"/>

4

    <select class="material" setmacro="CustomActionsLibraryRENDERER">5
        <option value="@CustomActionsLibrary.ms:getRenderer()" default="1">
Automatic Selector</option>

6

        <option value="scanline">Standard</option>7
        <option value="mentalray">MentalRay</option>8
        <option value="vray">VRay</option>9
    </select>10
   <item class="maxobject">11
        <name lang="english">English Oak</name>12
        <name lang="latin">Querqus robur</name>13
        <family>Fagaceae</family>14
        <description>Quercus robur is commonly known as the English oak or 
pedunculate oak or French oak. 

15

        It is native to most of Europe, and to Anatolia to the Caucasus, 
and also to parts of North Africa.</description>

16

        <bitmap>_fp_English Oak01.jpg</bitmap>17
        <maxfile>objects\_fp_English Oak01.max</maxfile>18
        <object>_fp_English Oak01</object>19
        <matlib>matlibs\$(RENDERER).mat</matlib>20
        <material>_fp_English Oak</material>21
   </item>    22
   <item class="maxobject">23
        <name lang="english">Holm Oak</name>24
        <name lang="latin">Quercus Ilex</name>25
        <family>Fagaceae</family>26
        <description>Quercus ilex, the evergreen oak, holm oak, or holly 
oak is a large evergreen oak native to the Mediterranean region. 

27

        It takes its name from holm, an ancient name for holly. It is a 
member of the white oak section of the          

28

        genus, with acorns that mature in a single summer.</description>29
        <bitmap>_fp_Holm Oak01.jpg</bitmap>30
        <maxfile>objects\_fp_Holm Oak01.max</maxfile>31
        <object>_fp_Holm Oak01</object>32
        <matlib>matlibs\$(RENDERER).mat</matlib>33
        <material>_fp_Holm Oak01</material>34
   </item>    35
   <item class="maxobject">36
        <name lang="english">Silver Maple</name>37
        <name lang="latin">Acer saccharinum</name>38
        <family>Sapindaceae</family>39
        <description>Acer saccharinum, commonly known as silver maple, 
creek maple, silverleaf maple, soft maple, water maple, swamp maple, 

40
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2.

 

7.4 Installing The3dGarden plant collections

To install The3dGarden collection manually to your Forest Pack library, just follow these easy steps. 

When you purchase The3dGarden plant collections you will receive an email with the download links. They 
are also available from your User Panel.
To add the trees to the Forest Pack library, first of all, just unzip the folder to your HDD. It doesn't matter 
where, as long as the directory structure remains intact.  

        or white maple — is a species of maple native to eastern North 
America in the eastern United States and Canada. 

41

        It is one of the most common trees in the United States.</
description>

42

        <bitmap>_fp_Silver Maple01.jpg</bitmap>43
        <maxfile>objects\_fp_Silver Maple01.max</maxfile>44
        <object>_fp_Silver Maple01</object>45
        <matlib>matlibs\$(RENDERER).mat</matlib>46
        <material>_fp_Silver Maple01</material>47
   </item>    48
</library>49

https://www.itoosoft.com/login
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3. Now in 3DS Max, create a new Forest Pack object. switch to the Modify panel and open the Forest Pack 
Library Browser. 
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4.

5.

In the Library Browser window, go to File > Preferences and in the Library Paths section, click Add.

Navigate to where you saved your files in step 1. You should select the folder called The3dGarden (or Itoo 
Libraries, depending on the collection). 
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6.

7.
8.

Give the library a name in the Label field. 

And then click Use Path. 
Click OK to accept the change of settings and you should now see the new library has been added to the 
library browser and is ready to go! If you have multiple versions of Max installed, the new library will appear 
in all of them. 
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1.

8 Forest Lister

8.1 Overview
Forest Lister simplifies the management of scenes that contain multiple Forest Pack objects. It comprises a 
simplified interface allowing you to rename, enable/disable, hide/unhide, and select Forest objects, display useful 
information, and speed up editing properties. To access Forest Lister:

Select any Forest Pack object.
Open the General rollout.

Click   to open the Forest Lister window.

Or:

Click the  button from the RailClone toolbar

The interface consists of a table view of all Forest objects in the scene with a row for each object and a column for 
each of the commonly used rollouts. Each rollout is represented by a Label which displays relevant information and 
also acts as a button to take you to the modify panel so that you can edit the object's parameters. Forest Lister's 
layout can be customised to show only the columns you need and change their order, for example for still images 
you may want to hide the Animation column as it's not required, in this way the interface can be customised to suit 
your individual workflow.

8.2 Procedures

8.2.1 To select a Forest object using Lister
To select a Forest object using Forest Lister you have 2 options, either:

Click any Label and Forest Lister automatically selects the Forest Pack object.

Or:

Highlight a Forest object by activating the Selection Marker in the first column and then click .

8.2.2 To pick multiple Forest objects using Selection Markers
Forest Lister allows you to easily select multiple Forest objects using Selection Markers. These are the 
buttons in the first column that are highlighted blue when clicked to indicate a Forest object has been 
selected. You use markers with the following mouse and keyboard combinations:
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2.

•

1.

2.

•

•

Ctrl + Left Click to add Forest objects to the selection.
Alt + Left Click to remove Forest objects from the selection.
Right Click to clear the current selection.
Left Click and then Shift + Left Click to to select a range.

Click   to select all Forest objects in lister.

Click  to deselect all currently selected objects.

Marking objects in the lister does not automatically select them in the scene. To select marked objects, click 

the  button.

8.2.3 To edit a Forest object's properties
Click any Label. Forest Lister automatically selects the Forest Pack object and takes you to the relevant 
rollout in the modify panel.

8.2.4 To edit multiple Forest object's properties

Use Selection Markers to highlight the Forest objects you intend to edit (see above). There's no need to 
select them in the scene, they only need to be highlighted in Forest Lister.
Change the enable/disable, hide/unhide or display mode settings in Forest Lister.

8.2.5 To display a Forest object's statistics
Click next to the Forest object's name to display its statistics. If an object is in an error state the sphere 
will display red   instead of green. A warning is signified by an orange sphere . 

To close the window you can either click the sphere a second time or use the close button.

In this release it is only possible to batch modify the Enable/Disable, Hide, and Display Mode properties. In 
future releases we will extend this function to include other parameters.


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1.

8.2.6 To change display mode
Choose a display mode using the drop-down list. Note that there's no need to select the Forest Pack object 
first.

To change the display mode of multiple Forest Pack objects, highlight them first using Selection Markers
(see above)

8.2.7 To enable or disable a Forest object
Click on the checkbox in the second column

To enable/disable multiple Forest Pack objects, highlight them first using Selection Markers (see above)

8.2.8 To hide or unhide a Forest object

Click on the lightbulb icon in the third column
To hide/unhide multiple Forest Pack objects, highlight them first using Selection Markers (see above)

8.2.9 To rename a Forest object
Click in the Name field and enter a new value.

8.2.10 To synchronise lister with the Max selection
To synchronise the selection markers in the lister so that they match the Forest objects selected in the 

scene, click 

8.2.11 To show/hide hidden Forest objects in the lister

Click the gear icon  to open the Settings menu.
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Turn on Include hidden objects to show hidden Forest object's in the lister. If you'd prefer to see only visible 
objects, leave this option unselected. 

8.2.12 To add columns

Click the gear icon  to open the Settings menu.
Select the column you wish to add from the Exclude List on the left hand side. 

Click the Add button.

8.2.13 To remove columns

Click the gear icon  to open the Settings menu.
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Select the column you wish to remove from the Include List on the right hand side. 

Click the Remove button.

8.3 Interface 

8.3.1 Forest Lister
Select. Selects the Forest objects in the scene that have been highlighted using Selection Markers (6).
Synchronise with Max Selection. Highlights the Selection Markers for the objects in Forest Lister that are 
currently selected in the scene.
Number of Objects. Displays the number of Forest objects managed in Forest Lister.
Refresh. Forces a manual update of Forest Lister. Use this in the rare event that Lister and the scene are out 
of sync. 
Settings. Opens the settings menu (see below).
Selection Marker. Click this to select Forest objects in the Lister. Note that this does not also select the 

objects in the scene unless you click .
Enable/Disable. Toggle the Forest object on or off.
Visible. Hide or Unhide the Forest object.
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11.
12.
13.
14.

15.

16.

17.

18.

19.

20.

Name. Used to display and edit a Forest object's name.
Statistics. Displays the health of the Forest object:  = OK,  = Warning,  = error. Click the label to 
open the Forest Stats window for more information.
Geometry. Displays the number of entries in the Items List. Click the label to open the Geometry rollout.
Areas. Displays the number of areas used. Click the label to open the Areas rollout.
Distribution. Displays the number of scattered items. Click the label to open the Distribution rollout.
Camera. Displays the name of the camera assigned to the Forest object or No Camera if none is used. Click 
the label to open the Camera rollout.
Surfaces. Displays the number and type of surfaces used by the scatter. Click the label to open the Surfaces 
rollout.
Transforms. Displays types of Transform randomisation used: T = translation, R = Rotation, S = Scale. Click 
the label to open the Transform rollout. 
Effects. Displays Effects On if an effect is loaded and active or No Effects if this feature is not used. Click the 
label to open the Effects rollout.
Animation. Displays the type of Animation  control used: Static = disabled, Follow = follow geometry, 
Random = random samples, Rand.Map = random from map, Frame Map = frame from map. Click the label 
to open the Animation rollout.
Display Mode. Displays the current display mode. The parameter can be changed directly in the Lister using 
the drop down list.
Edit Mode. Displays the Forest object's distribution mode. Click the label to open the Tree Editor rollout.

The columns and their order may be different for your configuration. To change these options, open 

Settings by clicking 


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8.3.2 Settings

The settings menu is used to configure the columns that are displayed in the Lister window. Use the left and right 
arrows to add or remove columns, and the up and down arrows to change their order.

Exclude list. Contains the columns that are not shown in Forest Lister.
Include list.  Contains the columns that are shown in Forest Lister.
Add. Moves the selected item in the Exclude list to the Include list.
Remove. Moves the selected item in the Include list to the Exclude list.
Include hidden objects. When active the lister shows all Forest objects, even if they're hidden. If the 
checkbox is disabled hidden Forest objects will not be seen.
Reload on Open. Forces Lister to automatically refresh when it is opened. Can slow down scenes with over 
100 Forest objects
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9 Instantiating and Exporting
This section includes information about converting Forest Pack objects to standard Max instances for use when the 
plugin is not available, as well as how to export to other popular programs. Please see the sections below. 

Forest Tools
Exporting to Unity
Exporting to Unreal
Exporting to Chaos Vantage

9.1 Forest Tools

9.1.1 Overview
Forest Tools is a utility that allows you to convert a forest object to individual instanced geometry. This can be used 
when you need to share a file with someone who does not have the forest plugin, use a renderer that does not 
natively support Forest Pack, or export the scene to another program.

9.1.2 Procedures

To add Forest Tools to the Utilities panel

From the Command Panel click   to open the Utilities Panel.
Click   to open the Configure Button Sets menu.
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1.

From the Utilities list on the left, drag Itoo Software > Forest Tools to an empty button slot on the right. If 
necessary increase the number of buttons using the Total Buttons spinner.

 
Click OK.

To create instances from a Forest Pack object
Select the Forest object to instantiate.
Open Forest Tools from the Utilities Panel.
In the objects group activate Move to layer and enter a name for the new layer.

Optionally select the Freeze checkbox to freeze the layer and select the Boxes checkbox speed up viewport 
performance by displaying instances as boxes.
Click Instantiate.

To delete existing instances
Select a Forest Object that has previously been used to create instances.
Open Forest Tools from the Utilities Panel.
From the Objects group, click Delete.

To update instances 
Select the Forest object to update.

It is also possible to add instances to the current layer or add them to a new group, however 
creating a new layer is recommended for more efficient scene management.


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1.

Open Forest Tools from the Utilities Panel.
If there are instances already in the scene that you need to replace, from the Objects group click on the Auto 
delete old items checkbox. This will delete any existing instances before creating new ones. Alternatively to 
remove them immediately click on Delete.
If the forest object is disabled, click Enable and make the necessary changes. If the Forest object is disabled 
and you do not need to enable it to make the changes, ensure that the Enable before start checkbox is 
selected.
To automatically disable the Forest object after instances have been created, select the Disable at 
end checkbox.
Click Instantiate.

To optimise materials for the active renderer
Open Forest Tools from the Utilities Panel.
Click Optimize in the Material Optimizer section. The material optimizer tool will open.

From the Render Engine drop down list, pick the current render engine (this should be automatic).
From the Apply to drop down list, select whether to run the optimizer on the current Selection or the 
Material Library.
For most situations the default settings are suitable. To exclude specific diffuse maps from being optimized, 
enter their names, separated by commas, in the Exclude materials using these names text box.
Click Optimize.

To export XML data
Select a Forest Pack object
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2. Go to the Command Panel > Utilities and click Forest Tools.
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Click Export Data.

 

From the Forest Data Exporter utility set a save path by clicking 
Enable the IDs of the channels you want to export.



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Instantiating and Exporting –  247

6. Click Export.
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9.1.3 Interface 

Instantiate
Converts the geometry items of the selected Forest object to instances.

Objects

Individual objects

When enabled, creates instances as stand-alone objects.

Create group

When enabled, adds all instances to a new groups.
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Move to layer

When enabled, creates a new layer and moves the instances to it. Use with the following options:

Freeze. Freezes the new layar
Boxes. Displays new instances as boxes, useful for improving viewport performance with large numbers of 
instances or complex meshes. 

Auto delete old items

When enabled, old instances are removed before creating new objects.

Delete

Removes instances manually. This only works if the instances and the Forest object and the have not been 
renamed .

Geometry List

Disable at end

When the instances are created, we don't need anymore the trees created by the Forest object in the scene. To hide 
them, Forest Tools set the elements of the Geometry List to "Disabled". So, if you would like to recover the Forest 
mesh, set the Geometry back to "Custom Object". If this checkbox is disabled, Forest Tools doesn't modify the 
Geometry List.

Enable before start

Sets the Geometry to "Custom Mesh" automatically before creating the instanced objects.

Enable

Used to set the "Custom Mesh" mode in the Geometry List manually (of the selected Forest object).

Forest Exporter
Export Data. Click this button to open the XML exporter tool. Using this menu you can export most of the internal 
options in a standardised format for use in advanced pipelines and to aid interoperability between software.

 3DS may be very slow handling a huge number of objects in a group, most of times is better to put them as 
non grouped objects in a separate layer.


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Click to set the save path for the XML file.

Choose from a generic export with configurable settings, or a Unity export that 
prepares files for use with the Forest Pack Unity plugin. 

Exports the source geometry to an FBX file. Used to import a scatter into other 
applications such as Unity

ID  ... Enables the data channels to be exported. By default all are selected.

Click to select all IDs.

Click to deselect all IDs.
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Click to save the XML data to disk.

Click to close the XML export utility.

Material Optimizer

Runs the Material Optimizer for the selected Forest objects. See Materials for more information about this tool.

9.2 Exporting to Unity

Accessing Forest Exporter using Maxscript

To export all the Forest objects in a scene to an XML file using maxscript, you use the following command:

Forest_pro.ForestPack.exportData <file> <list of fields separated by spaces>

For example:

Forest_pro.ForestPack.exportData "c:\\tmp\\data.xml" "geomID colorID size"


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Using Forest Tools and our Plugin for the Unity asset store, it is possible to export items scattered with Forest Pack 
to Unity for use in games and other real-time products. To export with Forest Tools and the Unity plugin, you must 
be using Forest Pack 7 or above and Unity 2018 or above. 

The basic procedure for sending a scatter to a unity project involves 3 steps

Export Scatters using Forest Tools. This will create a .forest file that contains the distribution information 
and .fbx files that contain the source geometry.
Install our Importer package in Unity
Import the .forest and .fbx files to Unity

9.2.1 1 - Export Scatters
To export a scatter from 3DS Max. 

Select one or more Forest Object 

Open Forest Tools from the Utilities panel. You can also access this by clicking the button on the Forest 
toolbar.
Click on Forest Exporter > Open

Change the Format to Unity

Click the elipsis button (...) to choose a save location
Click Export. A .forest and .fbx file will be created. 

https://www.unity3d.com/
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9.2.2 2 - Install Importer Packages in Unity
To import the assets exported in Step 1, you will need to install the plugin packages to your Unity project. To do this

Manual Installatation 

Download the plugin package from the iToo Software website
Drag the package to Unity's asset browser. 

Asset Store Installation

Pending asset store approval

9.2.3 3 - Import Forest Objects to Unity
Once the packages are installed, you can import the Forest Objects. To do this:

Drag and drop your .forest files along the .fbx files generated by the Forest Tools exporter, alternatively, you 
can right-click and select "Import New Assets"
Your scatter will import and display with a FP logo in the asset browser. You can add this to the scene like 
any other object

1.
2.
3.

4.

ECS - Experimental Features

Unity’s Data-Oriented Technology Stack (DOTS) allows programmers to improve performance when using 
multicore processors. This feature is still experimental and is in constant evolution. The iToo Uity plugin is only 
compatible and tested with specific versions of Unity 2018 and 2019. To use it you'll need to install several 
additional Packages. To do this:

In Unity go to Windows -> Package Manager
Enable Show Preview Packages.
Find and install the following packages

For Unity 2018
Burst version 1.3.6 or above
Entities version 0.012-preview.24 or above
Hybrid Renderer version 0.01-preview.4

For Unity 2019
Burst version 1.3.0 or above
Entities version 0.11.1-preview.24 or above
Hybrid Renderer version 0.5.2
Once the packages have compiled correctly you can open a test scene included in the iToo Package. It 
can be found in Assets>Scenes >SampleScene. 



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Instantiating and Exporting –  254

1.
2.

9.3 Exporting to Unreal

Unreal Engine's Datasmith tools support exporting Forest Pack and RailClone objects to Unreal with no need to 
Instantiate using Forest Tools. To use these features you need to install a Datasmith plugin for 3ds Max that's 
compatible with the Unreal Engine version that you are using.  

9.3.1 To export a full Forest Pack or RailClone object to Unreal
Select the Forest or RaiLClone object(s) you wish to export. Go to File > Export > Export Selected. 
Choose a file name and change the filetype to Datasmith

https://www.unrealengine.com/en-US/datasmith/plugins
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In the Datasmith Export options. Make sure that Include is set to Selection. 

Click Export. And wait a while. Depending on the number of instances and sources geometry this can take 
anything from a few seconds to a few minutes. 
Once that’s done, switch over to Unreal and click the Datasmith button

Select the file you just exported from 3ds Max and click Open
Choose the folder in which you wish to save the Forest Objects. Create a new one if necessary, then click OK. 
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Next, the import options will open. Change the  settings as desired and then click Import

Datasmith creates a single Actor in the Unreal Engine Level, named according to the name of the object in 
3ds Max. 

Each Forest or RailClone object is reconstructed in Unreal as a Hierarchical Static Mesh. This is a very efficient way 
of creating thousands of instances in real-time. It also creates a Static Mesh asset for each unique piece of 
geometry. In Forest Pack this will match the number of source models, in RailClone it depends on whether 
segments are sliced or bent as to whether they are instance or not and therefore exported as unique items.

If you click on a Hierarchical Static Mesh actor, you will see that it contains one Hierarchical Static Mesh component 
for each asset as well a list of all the individual instances. From here you can swap the geometry if you like simply by 
selecting another Static Mesh from the content browser and clicking the Use Selected Assets button.

9.3.2 To export only Bounding Boxes
Locate and select the source geometry used by the Forest objects you wish to export. With a Forest Object 
selected, you can do this easily by right-clicking and selecting the Select Forest Custom Objects option. 
Add a Datasmith Attributes Modifier to each one. Change the Export Geometry As option to Bounding 
Box. When this is active, a simple box is exported in place of the original geometry, allowing you to swap it 
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for something much more optimised in Unreal. 

Go to File > Export > Export Selected. 
Choose a file name and change the filetype to Datasmith
In the Datasmith Export options. Make sure that Include is set to Selection. 

Click Export. And wait a while. Depending on the number of instances and sources geometry this can take 
anything from a few seconds to a few minutes. 
Once that’s done, switch over to Unreal and click the Datasmith button

Select the file you just exported from 3ds Max and click Open
Choose the folder in which you wish to save the Forest Objects. Create a new one if necessary, then click OK. 
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10. Next, the import options will open. Change the  settings as desired and then click Import
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1.

2.
3.

9.3.3 Swapping Source Objects in Unreal
Once a scatter has been imported into Unreal, it's possible to swap the source geometry. You might want to do this 
if you've just imported bounding boxes, or if you've imported meshes that are not well optimised for realtime and 
you want to replace them with something more performant. There are two ways depending on how many items 
there are in a scatter. 

For scatters in the early thousands or less

Select the Hierarchical Static Mesh actor and in the Details panel, select the Hierarchical Static Mesh 
component for the object you wish to replace. 
Select an object you wish to substitute from the Content Browser
Click the Use Selected Asset in Content Browser button to assign the new object to the Hierarchical Static 
Mesh component. All instances will be updated. 

1.
2.

Locating source objects and adding Datasmith modifiers can be a somewhat tedious task if you have a lot 
of Forest Objects in the scene. So we have written a script to automate the process. It’s a part of the 
ForestToolbox, an ever-evolving set of handy functions that registered users can download from our forum.
 To use this:

Select one or more Forest Objects.
In the Datasmith section, change the mode to Bounding Box and click Add Modifier. 



https://forum.itoosoft.com/forest-pro-(*)/scripts-for-forest-pack/60/
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2.
3.

4.
5.

6.

For scatter greater than a few thousand objects 

The Hierarchical Static Mesh Component lists all the instances in the UI. Because of this, scatters that contain too 
many objects can cause slow-down or freezing as the UI attempts to list all the items. To swap items like this, you 
can use a different approach that doesn't involve you needing to open the UI for the component. Here's how:

In the Content Browser, find the folder containing the placeholder assets used in the scatter. 
Open a second Content Browser and locate the object you’d like to substitute
Drag the new plant into the same folder as the placeholder. Makes sure you choose Copy. This is so that you 
don’t accidentally end up deleting items from the content browser that you might need later. 

Now select the new object and the placeholder object. 
Right Click and select Asset Actions > Replace References 

A dialog opens. From the list you need to select the asset you wish to keep. The unselected assets will be 
removed and the references swapped to the selected asset. 
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8.
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Click Consolidate Assets. 
The scatter will update in the scene. 
Using this technique you can easily swap any geometry imported from Forest Pack. 

9.4 Exporting to Chaos Vantage
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1.

2.

Chaos Vantage support exporting Forest Pack and RailClone items without any need to instantiate the geometry. To 
export a scene containing Forest Pack and/or RailClone items the usual procedure can be followed:

Right-click in the scene and choose the export to .vrScene option.

Open the exported file in Chaos Vantage. For large scenes you may have a short wait while as it reconstructs 
the scene but even with thousands or even millions of instances scattered with FP it should load without 
issues

Forest Color Support

As with exporting to any other renderer, you need to be mindful of material and map compatibility. At 
present Forest and RailClone Colour aren't supported. When these maps are found they are bypassed and 
Chaos Vantage will use the map in the first input slot. 



It's common that tree, plant and other foliage asset use Opacity maps, but by default these are disabled in 
Chaos Vantage. To enable them, go to the Renderer > Advanced options and enable Opacity Maps (Clip 
Mode). 


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10 Forest Color

10.1 Overview
This 2D texture map is used to add color variation to the Forest items. It works similar to Forest Material but it is a 
2D map instead a material. Usually, Forest Material is used for billboards and Forest Color for 3D objects. 

Even with Path, Reference and Particle modes, it's still possible to assign a Surface while retaining the 
item's Z position. This is useful for using the Colour By Texture feature with modes that don't actually 
require a surface. To enable this feature, turn off "Non Image modes->Link to Surface" in the Surface 
rollup.



From Forest Pack 7 and onwards Forest Colour maps can be used on items that have been instantiated 
with Forest tools. Forest Colour maps can also be used on items outside of Forest pack but Tint By Surface 
and get ID by "Element" are not supported. 


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•

10.2 Interface

.

10.2.1 Maps
You can define up to 10 texture maps to Forest Color, that are assigned randomly on two selectable modes: by 
'Item' or by 'Element':

The Items are the base objects assigned in the Geometry List, and scattered by Forest creating the main 
distribution, for example the trees on a nature scene.
The Elements are the mesh pieces that define an Item, as the leaves or the branches of an individual tree. 
Note that the Elements are not the faces of a mesh, but an upper hierarchy. Internally, Forest Color 
consideres an Element as each group of adjacent faces of a mesh that share the same material ID.

The "Default" map is used as default texture when the other 10 map slots are disabled.
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10.2.2 Tint
By default Forest Color applies the Color Tint defined in the .Forest Color v7.x rollout of Forest object to the 
resulting map. This includes Color Range, Min and Max values and the other parameters (see Forest->Material for 
details). You can override these values on each instance of Forest Color, turning on the "Override" checkbox.

In this rollout you can find some additional parameters that define how the Color Tint is applied to the map:

Variation
Defines the amount of Color Tint applied by Item or by Element (see above the definition of these concepts), using a 
weight scale from 0% (Item) to 100% (Element). See the following images for some examples of use.

Blending Mode
Use the drop-down list to choose how the Color Tint is mixed with the map. The following modes are available: 
Normal, Color, Additive, Average and Multiply. These modes work in the same way that the Composite map 
included in Max.

Sample Images
A Forest scene using different values of Color Tint. Note how changes the Variation weight from trees (Item), to leaves (Element).

"Get color from map->As Texture on Surface" works only at Item level, it's not compatible with tint by 
Element.



http://www.itoosoft.com/forestpack/reference/refmaterial.php
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This scene uses a clump of grass as custom object, using Tint by Element to apply a different colour to each blade of grass
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Apply Color Correction
This option (enabled by default) allows you to turn on or off the effect of the Color Correct settings found in Forest 
Pack's Material rollout. It gives users the ability to override these settings on a per map basis. 
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1.

11 Forest Edge map

11.1 Overview
Forest Edge is a map used in conjunction with Edge boundary checking mode when using Corona and Mental Ray 
renderers to create clean edges. In this mode Forest Pack  uses the lowest Z Vertex of each of the item's individual 
elements to check if they're outside the scatter area. If so, only the individual element is removed creating a clean 
edge, without slicing the geometry. Note that when using edge mode, an element is defined as a group of 
connected faces that share the same material ID. These are the same elements used by Forest Color. In order for 
this mode to work correctly in Corona and Mental Ray, a Forest Edge map must be applied to the material's opacity 
channel. 

11.2 Procedures

11.2.1 To use Edge Boundary checking with Mental Ray
Apply a Forest Edge map to the material's Cutout map slot.



Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Forest Edge map –  270

2.

3.

1.
2.

3.

If the material also requires an alpha, apply this to the Forest Edge map's Opacity map slot.

In the Forest Object, go to the Area's rollout and set Boundary Check mode to Edge. 

11.2.2 To use Edge Boundary checking with Corona
Apply a Forest Edge map to the material's Opacity Color map slot.
If the material also requires an alpha, apply this to the Forest Edge map's Opacity map slot.

In the Forest Object, go to the Area's rollout and set Boundary Check mode to Edge. 
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•

1.

2.

3.

11.2.3 To use Edge Boundary checking with V-Ray
In the Area's rollout set Boundary Check mode to Edge. 

 
When using V-Ray there's no need to apply a Forest Edge map to the materials. 

 

11.2.4 To automatically apply Forest Edge to multiple materials
In the Forest Object. go to the Material rollout and click Optimise Materials.

In the Material Optimiser, turn on Apply Forest Edge, if you also need to add Forest Colour maps to the 
Diffuse slots you can turn this on too. 

Click Optimise. To find out more about the Optimise Tool and its settings, see the reference section for the 
Material rollout.
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11.3 Interface

Forest Edge maps should be use in the Opacity or Cutout map slot of materials. If your material already has maps in 
these slots, then these should be added to Forest Edge's Opacity Map slot. 

Edge Mode does not preview in viewports
To improve viewport performance edge trimming is calculated only at render time. This means the effects 
of the this mode will not be previewed in the viewports. However, previews can be enabled by holding 
down the left CTRL key and clicking on the Edge radio button.


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12 Forest Material

12.1 Overview
This material plugin is used for some advanced features of Forest, as Random Tinting or Fake Shadows.

It is mainly used on billboards, if you want to add color variation on 3D objects, we suggest to use Forest Color, that 
is a 2D texture map.

It works as a enveloping layer over the base material used on the object, and modifying the result of this (applying 
the tint, or hidding the shadow planes).

You can use any material as base (from Standard Mat. to VRayMtl), but for billboard trees we suggest to use a 
Standard Material (specially with Mental Ray), because some features only work with it.

Forest Material is compatible with V-Ray, Mental Ray and Scanline renderers only. For other renderers you 
can use native shaders for billboards.



On Multi-sub materials, always use "Forest Material" as a sub-material, in this way:
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12.2 Interface

12.2.1 Shadow Textures
When billboard trees are used, Forest has native support of shadows using our XShadow plugin or raytraced lights. 
For each tree, two opacity textures are used: vertical and horizontal.

By default, XShadow searches automatically in the the material tree to find the vertical texture (Standard, Multi 
Sub-Object and "Forest Material" only) but this can be defined explicitly in Planes Material using this parameter. 
The horizontal texture must always be assigned here.

Raytraced shadows and Mental Ray need "Forest material" to work, because this plugin does the job of hiding or 
rendering the shadow / texture for each plane. Be sure that the material applied to the Forest object uses the 
"Forest Material" plugin as a base.

12.2.2 Override Tint
By default, Forest uses the Random Tint values defined in Forest->Material rollout for all tree samples used in the 
object, but those parameters may be overrided here for each material.

This feature is specially useful for mesh objects that use a Multi-sub material (as mat.ID 1 for trunk, mat.ID 2 for 
leaves), allowing to apply different tint for leaves and trunk (or disable tinting setting Min/Max values to 0).
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12.2.3 Forest Shader (Mental Ray only)
Forest includes a custom shader that enhances the rendering of billboard trees. It fixes some problems inherent to 
planar trees, as the illumination or the slow transparency computing in raytracing modes. Although the shader 
must work in all modes, if you are experiencing some material issue or get unexpected results, you can disable it 
from here.

Forest Shader works only if a "Standard Material" is used as base material. This is specially important for billboard 
trees, for Custom Objects you can use other type of materials if you like.

The behaviour of Forest Shader is defined by some parameters of the Forest object as well. See Forest reference-
>Material for details.
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13 X Shadow

13.1 Overview
Shadow is a plugin to create realistic shadows for billboard trees.

13.2 Interface
When you create trees using planar geometry, they cast ugly rectangular shadows. You must use Raytrace Shadows 
to get a good projection, but it's very slow. This plugin builds a perfect shadow for Forest objects in all conditions. It 
works as a Shadow Map and there are no problems at render time:

 
This is a shadow plugin, and must be chosen in the shadow parameters of each light. At present, it only works with 
directional lights (with spots and omnis it doesn't create any shadows for trees):

This plugin is used only with Scanline renderer, it's not compatible and there is not any benefit for using 
with Mental Ray or VRay.


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13.2.1 Shadow image
XShadow uses two opacity textures to build the shadow: one vertical and the other horizontal.

By default, the plugin searches automatically in the material tree to find the vertical texture (Standard, Multi Sub-
Object and "Forest Material" only). The horizontal texture must be defined in a "Forest Material" (see Forest 
Material reference for details).

These parameters define the vertical texture in the XShadow plugin:

Opaque
Builds the rectangular original shadow (from Forest mesh)

Opacity material
Use the opacity texture applied for each tree as shadow.

Custom
Lets you choose a custom texture map.

Disable texture cache
The plugin builds an optimized cache buffer to increase the render speed. In the most scenes, it works well, but if 
you get some "blocky" shadows or other visual problems, use this option to disable the cache (you can use it also to 
compare the render time in both states).

The other parameters works the same as standard shadow maps, and for non Forest objects the shadows obtained 
are the same.

http://www.itoosoft.com/forestpack/reference/mat.php
http://www.itoosoft.com/forestpack/reference/mat.php
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Prevent Self-Shadow
Enable this checkbox to avoid that a tree cast the shadow over itself.

13.2.2 Optimizing XShadow
To get the best results with XShadow, we must understand how shadow maps work:

The "size" parameter in XShadow defines that Max will use a bitmap of that number of pixels to draw the shadows 
on it. But this map is applied ONLY to the light's hotspot area. So, to get better shadows you must close the hotspot 
to surround only the objects to shadow. This is a sample of a well adjusted hotspot for XShadow (seen from a light 
viewport):

Light hotspot adjusted to object

Using a well adjusted hotspot, a shadow map of 4000 pixels should be enough for most scenes. For very large 
terrains, we suggest you use different cameras and lights, adjusting them individually to shadow only the trees 
visible in each view or use raytraced shadows.

XShadow needs large buffers of memory to work, and if the scene is complex, Windows might not have enough free 
memory for it. If this occurs, XShadow stops and displays an error.

And sometimes adding more memory to the system may not solve the problem, especially if you are using a 32 bit 
version of Windows, because there are other limits due to the 32 bit architecture, for instance memory 
fragmentation is an issue (when there is free memory that cannot be allocated in a contiguous space).

This is not only an XShadow problem. When Max uses its standard shadow map plugin, and there is not enough 
memory for the buffers, it doesn't build the shadows but doesn't show any error! This may be annoying for the user, 
who doesn't know why shadows are not working. In XShadow, we prefer to display a warning message. In order to 
fix the problem, here are some possible solutions:

If you have at least 4 GB of memory, always use Windows 64 and 3D Studio 64 bit versions.
Don't use a higher value than 4000 for the "size" parameter in XShadow. The memory needed grows 
exponentially with this value. Also, optimize the shadow hotspot of the light (see previous section in this 
FAQ).
In XShadow, enable the checkbox "Disable exclusivity buffer" to reduce memory used for XShadow by half. 
When this option is enabled, the plugin doesn't check to see if each tree shadows itself... but this effect is not 
noticeable in most of scenes.
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• Use raytraced shadows, which are natively supported by Forest.

•
•

•

XShadow works only with directional lights (targeted or free).
If you use other lights in scene with shadow enabled (without using XShadow), they cast 
rectangular shadows for Forest objects... the Forest mesh always exists, of course.
When using Forest Pro and custom meshes, XShadow builds the standard shadow of an object, 
except if you enable the checkbox "Cast opacity mask for Custom Object" in Forest's Shadows 
rollout.





Forest Pack Help  –  Forest Pack Lite / Forest Pack Pro for 3dsMax Help

Rendering Best Practice –  280

•
•
•
•
•
•
•
•
•
•
•
•
•

14 Rendering Best Practice
Forest Pack includes native geometric shaders for the renderers listed below, making it possible to render scenes 
with millions of high poly trees, meshes and proxies:

Arnold
Mental Ray
V-Ray
V-Ray RT
Maxwell Render
Octane Render
Arion Render
Corona Renderer
Thea Render
Moskito Render
Redshift
Fstorm
Final Render

Usually, these techniques push the rendering engine to its limits. In the following notes, we include technical 
information that can help you to optimize your renderings, and avoid some problems.

14.1 Common Tips
- Boundary Checking > Edge Mode is compatible with V-Ray, Corona, Arnold and Mental Ray. If this mode is used 
with unsupported renderers, point mode is used instead. 

- To use Boundary Checking mode with Mental Ray, Arnold and Corona, it is necessary to add a Forest Edge 
map Map to the material's Opacity input. 

- Minimize the use of opacity maps in your plants. Raytracers are slow computing transparencies, when possible use 
mesh leaves instead masked textures, although number of polygons be higher. If you need to use opacities, 
disabling the filter map may help to speed up the render.

- You can use the Material Optimizer included with Forest Pack, to converts the materials to VRay/Mental Ray and 
tune up the texture maps.

- When possible, use Max 64 bit. The 32 bit versions are very limited, and you may get memory errors when 
rendering complex scenes.

- Don't mix 32 bit and 64 bit environments for rendering, you would get unexpected results. Because the different 
numeric precision of both architectures, some problems may appear as: misaligned objects, color variation and 
others. Generally, it's not a good idea to mix 32 bit and 64 bit nodes in 3DS Max, to avoid issues as rendering 
flickering or glitches in procedural textures.

- XShadow is not compatible with Mental Ray and VRay. This plugin, based on Shadow maps, was written for 
Scanline renderer but is obsolete with the new rendering engines. Instead it, use raytraced shadows in Mental Ray 
or VRayShadow in VRay. If you use billboards, don't forget to assignthe main light in the Shadows rollout.

14.2 Arnold
To use Forest Color and Forest Edge maps with Arnold, you will need to turn on Legacy 3ds Max Map 
support in Render Settings->System.

http://docs.itoosoft.com/display/FORESTPACK/Areas#Areas-CommonProperties
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14.3 Mental Ray
To get acceptable rendering times in large scenes, it's necessary to use BSP2 as raytrace method. It is 
available only in Max 2009 or greater. For previous versions, or small-to-medium size scenes, you can use 
BSP instead.
Always disable "Scanline" checkbox (in "Rendering Algorithms" rollout), and we suggest to enable "Use 
Placeholder Objects" (in "Translator Options"). These settings are specially necessary when rendering 
complex scenes with large number of instances.
In Forest Pack 6, Material->Forest Shader parameters are removed from the interface. These are only used 
for billboards in Mental Ray and if needed, you can modify them from Maxscript as: fastopac, tracedepth, 
opaclevel, selfillum, irradiance.

Note 1: The use of Placeholder objects is incompatible with the G-Buffer channel "Coverage". This channel is used 
in the RPF format, for some Render Effects and by third-party plugins as "PSD Manager" from Cebas. If the 
Placeholders are enabled, the channel is rendered as pure black. Unfortunately, this is a Mental Ray limitation and 
there are not known workarounds for it.

Note 2: We also found that the Placeholder objects feature crashes with some types of proxy elements used on Civil 
View (3DS Max Design), specifically the Street Lamps. Be care if you use these elements in your scene.

- You can use assign billboards, meshes, mrProxies or any other object for your trees. In our sample scenes, we have 
not found differences (in render time or memory used) between using meshes or proxies, but we suggest that you 
make your own tests.

- Forest Color using "Element" mode is not compatible with Distributed Rendering. Instead, this feature works fine 
rendering locally.

- Rendering times with more than 500.000 items may grow exponentially. However in the latest Max releases (2014 
and above), we have noticed improvements on this limitation. If you plan to scatter large distributions, we suggest 
you make your own tests, to know the limitations of the render engine.
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14.4 V-Ray
- V-Ray native shader requires Max 9 with VRay 1.50 SP3 or greater.

- To render high-poly objects or proxies, increase the Dynamic Memory Limit from the default value to a percentage 
of your total RAM. The optimal value depends of the complexity of the scene, but usually a minimum of 2000 or 3000 
Mb. is required. In V-Ray 2.0 and later, you can set this to 0 to remove any limit in that case, V-Ray will take as much 
memory as needed.

- You can use billboards, meshes, or V-Ray proxies in Forest. In our test scenes, we have found that meshes usually 
render slightly faster than proxies.

14.5 VRayRT / Maxwell Render / Octane / Arion / Thea Render
Due to technical restrictions, support for these engines is limited and several features are supported. 

You can find the compatibility list here.

Version
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15 Forest Release Notes
Full release notes are online.
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16 Forest Pack Licensing Guide

16.1 Overview
Software License Management is available in two models, Standalone Licenses and Floating/Network licenses. 
Under a stand-alone license, any given product is constrained to a certain host. A license is needed for each 
computer that the software will be installed on. In floating license mode, a pool of licenses is available on the 
server, for use in any computer on the network. You only need to have licenses for the maximum number of 
simultaneous users expected, not for each computer where the software will be installed.

Depending on the size of your business and expected use of the software, one of the two models is usually 
preferred. In small sites with few computers, the Stand-alone licenses is fast and easy to deploy, the licensing 
process is part of the software installation, leaving the software ready to use in one step. For larger sites, the 
floating network licensing is preferred because it provides more flexible use of licenses, you only pay for 
simultaneous users and not for nodes, while the centralized management tool simplifies control of all your licenses.

16.1.1 Stand-alone License
The Stand-alone license ties a single software application to a single computer. This method of licensing requires a 
machine's unique identifier (SID) to be incorporated in the license activation process. After buying the product, an 
generic license code is sent to you, the license is installed and activated. In the activation process the license is 
linked to the computer and can be used only for that computer.

16.1.2 Floating Network Licenses
Network licenses (also known as floating licenses) allow multiple users to share a limited pool of licenses in a local 
network. After installing the License Server on a server machine, the server will handle requests for licenses from 
the users computers. If you have a team of 20 people and 10 licenses for a product, the entire team will share access 
to the 10 licenses, while no more than 10 people can use the software at the same time.

While Stand-alone licenses use a license file installed and activated for each computer, and can be used only in that 
machine, the network licenses are installed and activated only one time in a server. When a license request arrives, 
the server determines whether the proper license for a requested product is available. If an appropriate license is 
present and not in use, the server will allow access to the software.

As the licenses are stored on a server, you cannot use the software if you are not connected to the network. 
Although the server software does not require a powerful system, it is mandatory that the computer hosting the 
license server be running and available while there are computers using the licensed software.

16.2 License Activation
When you acquire a license from Itoo Software, a generic license code is sent to you. Before using the software, this 
license must be linked to your hardware, this process is called activation. You can activate the license during the 
software installation (only for Stand-alone mode), or from the License Manager once the software is installed.

Can I open scenes which use the plugin in computers that don't have an active license?

Yes. You can open and work with the scenes no problem, but the objects cannot be edited or rendered and 
in RailClone 4 and later will not display in the viewports. 



https://docs.itoosoft.com/display/RAILCLONE/Standalone+Licenses
https://docs.itoosoft.com/pages/viewpage.action?pageId=10092669
http://www.itoosoft.com/railclone/reference/license_ug2.php
http://www.itoosoft.com/railclone/reference/license_ug3
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1.
2.
3.

During the activation of a license, you can choose two different methods, Automatic or Manual. With Automatic 
activation you must be connected to the Internet, the software will connect with our activation server through a 
secure connection, and the activation codes will be sent and installed automatically. No personal information is 
sent during the process.

If you experience difficulties with on-line activation, or the computer where you are using the license does not have 
Internet access, you can use Manual activation instead. In this case, the software gives to you the necessary codes 
and a link to our secure activation page. In this web page, you enter the codes and the activation key is generated. 
Write or print out this code, and provide it when the Activation Wizard runs, then the license will be activated and 
ready to use.

For security reasons, our activation server allows you to activate a license only a certain number of times (5 by 
default). If you exhaust the maximum number of activations, please send us an email at activate@itoosoft.com, we 
will increment the activation counter associated with your license. In the authorization process, the server informs 
you of the number of activations remaining.

In either case, if you have trouble during the activation, please contact us at activate@itoosoft.com.

16.3 Network rendering licenses
Our commercial plugins require a license for each computer, to open or edit the scenes, but NOT for network 
rendering nodes. The installation for slave nodes is much simpler, and does not requiring licenses or activations.

16.4 Floating/Network licenses

16.4.1 Introduction
Network licenses (also known as floating licenses) allow multiple users to share a limited pool of licenses in a local 
network. After installing the License Server on the computer being used as a server, the server will handle requests 
for licenses from users computers. If you have a team of 20 people and 10 licenses for a product, the entire team will 
share access to the 10 licenses, while no more than 10 people can use the software at the same time.

While Stand-alone licenses use a license file installed and activated for each computer, and can be used only in that 
machine, network licenses are installed and activated only one time on your server. When a license request arrives, 
the server determines whether the proper license for a requested product is available. If an appropriate license is 
present and not in use, the server will allow access to the software.

As the licenses are stored on a server, you cannot use the software if you are not connected to the network. 
Although the server software does not require a powerful system, it is mandatory that the computer hosting the 
license server be running and available while there are computers using the licensed software.

In order to deploy Network Licenses you must:

Install the License Server on the server computer.
Install and activate one or more Network Licenses on the server using the License Manager.
Configure each client to retrieve the licenses from the license server.

Can I open scenes which use the plugin in computers that don't have an active license?

Yes. You can open and work with the scenes no problem, but the objects cannot be edited or rendered and 
in RailClone 4 and later will not display in the viewports. 



mailto:activate@itoosoft.com
mailto:activate@itoosoft.com
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16.4.2 License Server Installation
To be able to use network licenses, a computer in the network must be designated as the license server. Once you 
have selected it:

First make sure that your have administrative rights on the target computer.
Download the License Server software from the links you received after purchasing the software (in the 
registration email).
Run the setup program and follow the steps.

The License Server will be installed as a system service named "Itoo Software License Server". A shortcut to the 
License Manager is also created on the start menu.

16.4.3 License Manager
You must use this tool to manage the licenses of all products purchased. It's the same one used to manage the 
Stand-alone licenses.

To use it, select the License Manager in the Itoo Software/ License Server group of the Start menu. There are four 
tabs in this tool, two of them are only available if you have a license server installed:

Licenses: On this page the licenses are listed and managed
Computers (only with License Server installed): Here you can see which computers are connected and 
manage them.
License Server: (only with License Server installed) On this page, the system administrator controls the 
License Server. You can check the status of the service, start and stop it.
About: Here you can find information version and contact information.

Licenses
When opened, the License Manager displays the installed licenses. You can retrieve license details, check its status, 
activate it, or add new licenses as shown below:
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Licenses can appear in different states, depending on the type of license and its activation status:

 Activated Stand-alone licenses: Shown in black text, these licenses are not used by the License Server 
(see Stand-alone license).

 Activated Network Licenses: Shown in blue text, these licenses are activated are ready to be shared on 
the network.

 Un-activated licenses: Red text with an warning icon, theses licenses are valid but have not yet been 
activated. You must activate them before using.

 Broken licenses: Red text with an error icon . These licenses have corrupted data and can't be used in 
any form. They must be reinstalled.

To obtain more information about a license, use the Details... button, here you can see the data stored on it.

Installation of new network licenses

Unlike Stand-alone licenses, that are authorized for use only on a single workstation (the computer on which its 
installed), a network license allows for concurrent usage for a specific number of workstations. This number is 
shown in the license's details as "Licensed for x users". For instance, if you purchase 5 network licenses, you won't 
receive 5 separate license codes, you will only receive one code that once installed creates a license for 5 users in 
the License Manager. Later, if you purchase licenses for 3 additional workstations, you will receive a new license 
code for 3 users, that must be added in the License Manager.

When you acquire licenses from Itoo Software, in the e-mail you get the license code, as a block of letters and 
numbers. To install it, use the "Add.." button on the Licenses tab. Copy and paste the code in the window. Please be 
sure that you do not include any text other than the code itself:

If the entered code is valid, press Ok. The license is installed on your computer and ready to be activated.

License activation

The activation process is identical for Network as for Stand-alone licenses. The difference is that the network 
licenses are activated and linked to the hardware of the License Server.

https://docs.itoosoft.com/display/RAILCLONE/Standalone+Licenses
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After an new license is installed, you'll be asked to start the activation wizard. You can activate manually using the 
"Activate" button as well. Please, see the activation process in Stand-alone licenses for instructions on how to do 
this.

Computers
In the "Computers" panel, you can see all clients that are connected to the server, what licenses are being used and 
how long each computer has been connected.

Each time that a workstation uses a network license, it connects to the License Server and starts a lease of the 
license for a limited time period. Before that period expires (by default ten minutes), the license must be refreshed 
or the lease will be lost and the license can be requested by another user.

Using the "Disconnect" button you can force the server to disconnect a computer before the lease time expires. The 
typical use of this control is when a workstation has locked up, and it's license is locked to that computer. In this 
case, you can unlock the license by manually forcing a disconnection. If a workstation doesn't reply after the lease 
time period, it is disconnected automatically by the server.

License Server
On the "License Server" page, you can check the status of the service, start and stop it. A detailed log of the server 
activity is also available, to diagnose any problems.

https://docs.itoosoft.com/display/RAILCLONE/Standalone+Licenses
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The top panel shows information about the windows service, whether it's installed correctly and if the service is 
started. Using the "Start/Stop Server" button you can stop the service and restart it at any time, please note that if 
you stop the service, all connected clients will lose their leased licenses and will try to reconnect.

The bottom panels gives you more detailed information about the service, such as the server version, TCP ports 
used and the total number of connected users. This data is updated each time you enter this tab, or by clicking the 
"Refresh" button.

16.4.4 Configure Clients
A network license can be used from any computer that can connect to the License Server over the network. The 
license server or network licenses should not be installed on the client computer. To configure your software for 
using network licenses, please follow the procedure below:

From the Start menu, search for the application group and select "Change License Mode". You will get the license 
configuration window:
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In this window, you select with type of license the software will use. The first option uses a locally installed Stand-
alone license. Selecting the second option, the software will use network licenses. You will be asked how to connect 
to the license server in this dialog box:

http://www.itoosoft.com/railclone/reference/license_ug1
http://www.itoosoft.com/railclone/reference/license_ug1
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The first method is the recommended procedure, the client will search for an active server over the local network 
using a broadcast query. The server will be located each time that a license is needed by the software. If the server 
is accessed through a router, and the automatic method doesn't work, you must use the manual configuration and 
enter the IP address used to retrieve the license.

Please note: If you have installed multiple commercial Itoo Software products, each one has its own license 
configuration. You can use one product with a Stand-alone license, and another with a corporate network license. 
Please make sure that each product is configured to use its license correctly.

16.4.5 Accessing the License Server through a Firewall
The License Server installer checks for the Windows Firewall and adds the necessary rules if it is present. If you use 
another firewall software, or a physical firewall between the server and the client computers, the following ports 
must be opened:

TCP Port 16720
UDP Port 16720

16.5 Stand-alone Licenses
The Stand-alone license ties a given software application to a single machine. This method of licensing requires a 
machine's unique identifier (SID) to be incorporated in the license activation process. After buying the product, a 
generic license is sent to you. This license must be installed and activated before you can use the software. In the 
activation process, the license is linked to the hardware.

As soon as your order is authorized, we will send you an e-mail with the license code. On this page, we explain how 
to install and activate a Stand-alone license.
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16.5.1 Downloading the software
Access your User Panel entering you iToo Software account username and password.
Go to My Products and download RailClone Pro/Forest Pack Pro . The user panel also gives you access to the 
latest patches and beta versions.
Make sure all version of 3ds Max are closed

16.5.2 Installation and licensing
 Run the RailClone Pro/Forest Pack Pro setup program 

Read the license agreement and click I agree to continue.

http://userpanel.itoosoft.com
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Select Workstation. (If you are installing RailClone on a render node, please select Render Slave Mode)

From the next screen select the Standalone license type and click Next.

The installer will automatically detect the versions of 3ds Max installed on the system. By default, RailClone/
Forest Pack will be installed on all compatible versions, but you can change this using the Select 
Components to Install options if required. When you are done, click Next

If you would like to change the installation paths, please check the Advanced Installation option.

https://docs.itoosoft.com/display/FORESTPACK/Stand-alone+Licenses
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If you chose advanced installation you'll be prompted to selected a path, otherwise, RailClone/Forest Pack  
will be installed uses the default location at C:\Program Files (x86)\iToo Software\
Add License will open. Past in the long license code (not the serial number found in the email we sent you 
after purchase. Click OK.

Your licenses will attempt to activate online,
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Next update manager will be launched allowing you to install additional content like libraries and Macros.  
Click Install.

Click Finish to complete installation.

 

16.5.3 Offline Activation
If you have trouble with online activation, or the computer where you're are using the license does not have 
Internet access, you can Manual activation.

Select "Activate Manually" as the activation method.
Open a link to our Activation Web page and enter the codes given by the dialog.
Following the steps indicated in the page, you'll be given an Activation Code, enter this code in the dialog 
box when requested to activate your license.

In either case, if you have trouble during the activation, you may contact us at helpdesk@itoosoft.com.

16.5.4 License Manager
When you install any Itoo Software commercial product, the installer also includes the Itoo Software License 
Manager. This tool is used to manage the licenses of your purchased software.

http://activate.itoosoft.com/
mailto:helpdesk@itoosoft.com
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To open the License Manager, select "License Manager" in the "Itoo Software" group of the Start menu. There are 
four tabs in this tool, two of them are only visible if your computer acts as a license server (not applied for Stand-
alone method, see Floating/Network licenses):

When opened, the License Manager displays the installed licenses. You can retrieve license details, check its status, 
add new licenses or activate them as shown below:

Licenses can be in different states, depending of the type of license and its activation status:

 Activated Stand-alone licenses: Shown in black text, these licenses are ready to be used.
 Un activated licenses: Red text with a warning icon, these licenses are valid but have not yet been 

activated. You must activate them before using.
 Broken licenses: Red text with an error icon . These licenses have corrupted data and can't be used in 

any form. You must reinstall them.

For more information about a license, you can click on the "Details..." button, where you can see the data stored in 
the license.

Installation of new licenses

If you have not installed a license with the software installation process, use the "Add.." button in the licenses tab. 
The installation process is the same as the one described above for the installer.

Activation of the selected License 

When a new license is installed, you're asked to activate it. In this process the license is linked to your hardware. 
The activation process is the same as the one described above for the installer.

http://www.itoosoft.com/railclone/reference/license_ug3
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